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Abstract
Sea level rise has the potential to exacerbate coastal flooding around the world, causing
more frequent extreme sea levels, nuisance flooding and permanent inundation.
Projecting diverse physical, environmental and socio-economic impacts to coastal
communities across multi-decadal timeframes is vital for informed adaptation planning.
However, this is increasingly uncertain and challenged by conflicting stakeholder
priorities.
This thesis develops an interdisciplinary approach to advance the planning of long-term
adaptation pathways in the context of coastal flood risk management. Utilising three case
studies in south-east Australia, it combines the strengths of robust decision making
(RDM) and dynamic adaptive policy pathways (DAPP) – both prominent tools to support
decision-making under conditions of uncertainty – together with solicited values-based
information to make three novel advances towards flexible adaptation pathways planning.
First, this thesis combines the strengths of RDM and DAPP for planning adaptation
pathways by using scenario discovery to provide a multi-dimensional description of
adaptation tipping points. The scenario discovery process uses an existing cluster finding
algorithm to identify future conditions where adaptation policies no longer keep flood risk
at tolerable levels. Combining RDM and DAPP is a novel approach in coastal flood risk
management and scenario discovery provides greater visibility on the physical factors
driving adaptation tipping points. Second, values-based information is integrated into the
adaptation planning process in an attempt to consider subjective social and cultural
impacts from coastal flooding. In this regard, the novel combination and explanatory
value of lived and landscape values is investigated. Consideration of these more
intangible effects are often omitted in coastal adaptation planning but can contribute to
more informed adaptation decisions. Third, the combined RDM and DAPP method
developed uses both geographic information system (GIS) software and open source
programming tools to analyse flood impacts. This improves the usability and relevance
of a combined RDM and DAPP approach, enabling the efficient redeployment and
customisation of the method to suit different location-specific needs. Such an approach
also provides a lower cost entry point for local government agencies to begin planning
coastal adaptation pathways.
Each of these advances combine to provide a framework that improves the way coastal
adaptation pathways are planned and developed. The findings elucidated from the case
vii

studies show how a combined RDM and DAPP approach can account for spatial and
temporal interactions between hazard, exposure and vulnerability flood risk factors,
which improves the way robustness is measured for adaptation policy options. Valuesbased approaches can shape the selection of adaptation objectives, improve the design
of options, support the evaluations of adaptation pathways and inform monitoring
systems. The resultant adaptation pathways framework can support local government in
planning sustainable strategies to manage long-term flood impacts. This has global
applications for coastal flood risk management that will become increasingly important
throughout the coming century.
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Chapter 1 Introduction
1.1 Adaptation in a changing world
1.1.1 Changing global sea level and its consequences
The coastal environment is constantly changing with sea levels fluctuating between
glacial and interglacial periods (Church et al. 2008). Sea level has varied by more than
120 m over the past 140,000 years (Lambeck & Chappell 2001) and paleorecords
suggest that the global mean sea level was more than 5 m above current levels during
the last interglacial period (Church et al. 2013). At the last glacial maximum (around
20,000 years ago), the sea level increased rapidly by more than 120 m in 13,000 years
before stabilising (Church et al. 2008). The exchange of water between ice sheets and
the ocean is an important driver behind historic changes in sea level (Lambeck et al.
2014), whilst thermal expansion has had a lesser influence (McKay, Overpeck & OttoBliesner 2011).
In recent centuries global mean sea level has remained relatively stable (Church et al.
2013). A rising trend of 1.7 mm yr-1 was observed across the 20th century (Church &
White 2011) and this trend increased to approximately 3 mm yr-1 between 1993 and 2014
(Watson et al. 2015). Two dominant factors that have contributed to sea level rise across
the 20th century are thermal expansion of the ocean and glacier melting, including recent
contributions from Greenland and Antarctic ice sheets (Church et al. 2013). Both of these
factors are influenced by global warming (Church et al. 2008), with increased
anthropogenic emissions driving changes in the climate (IPCC 2014b). Atmospheric
carbon dioxide levels are now the highest they have been for the past 650,000 years
(Jansen et al. 2007).
The lag time between increasing atmospheric temperature and its influence on ocean
warming means that sea level rise is projected to continue for centuries, even after
greenhouse gas emissions are stabilised (Mengel et al. 2018). The Intergovernmental
Panel on Climate Change (IPCC) – the leading international scientific body on climate
change – projects that 0.2 to 0.8 m of sea level rise is ‘likely’ by 2100 (Church et al. 2013).
An upper estimate of 1.9 m by 2100 was calculated by Jevrejeva, Grinsted and Moore
(2014) based upon an increasing greenhouse emissions scenario (RCP8.5), though the
extent of sea level rise later this century remains an active area of research (e.g.
DeConto & Pollard 2016). Rising sea level will undoubtedly change coastal flood patterns
around the world. With up to 390 million people globally estimated to live below 5 m
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elevation (Lichter et al. 2011), sea level rise will place increasing pressure on
communities to plan for anticipated social, economic and environmental consequences.
In recognition of the threat of global warming, an international treaty known as the United
Nations Framework Convention on Climate Change (UNFCCC) came into effect in 1994
with the aim to “prevent dangerous interference with the climate system” (United Nations
1992). Since the formation of the UNFCCC, significant global developments have
occurred (e.g. the Paris Agreement in 2016), aimed at achieving a reduction in
greenhouse gas emissions. Whilst ‘mitigating’ emissions can help reduce the rate and
extent of climate change, there is now recognition that ‘adaptation’ is needed to prepare
for unavoidable environmental change. Adaptation is an adjustment to the observed or
anticipated climate such that costly consequences are reduced or beneficial
opportunities taken (IPCC 2014a).
Sea level rise has the potential to exacerbate nuisance flooding (Ray & Foster 2016),
extreme sea level events (Hunter 2010) and cause permanent inundation of low-lying
areas. Globally, coastal flooding in the year 2100 is estimated to impact up to 4.6 % of
the population annually, with $210 trillion of assets exposed to a 100 year flood event in
the absence of adaptation (Hinkel et al. 2014). Whilst physical damages can be
quantified, social and cultural losses from climate change and adaptation are not
straightforward to evaluate. This is because they are shaped by ethics, culture,
knowledge, power structures, risk perceptions and life experiences, all of which evolve
over time (Adger et al. 2009; Meze-Hausken 2008; O'Brien & Wolf 2010). Social and
cultural losses are significant to the well-being of communities and their way of life,
meaning that adaptation solutions need to be inclusive of these needs.
Decisions made today about coastal development and land use can shape urbanisation
patterns over the coming decades, influencing what ultimately becomes exposed to
future flood hazards. Coastal infrastructure such as roads, utilities, rail, residential and
commercial buildings often last between 20 to 100 years and influence future
developments within communities (Hallegatte 2009). Long-term coastal adaptation
strategies need to be flexible and anticipatory in the face of uncertainty, so that resilience
to climate change can be developed before consequences are unacceptable.

1.1.2 Decision-making with uncertainty
Local governments are often at the forefront of coastal decision-making and have a key
role in building community resilience to climate change (Mees 2017; Productivity
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Commission 2012). However, adaptation planning in local government is challenged by
unclear roles and responsibilities, capacity constraints, legal liability concerns, financial
and human resource constraints, and no clear policy guidance to manage climate
change risk (Gurran, Norman & Hamin 2013; Productivity Commission 2012). Climate
change adaptation planning is fundamentally a ‘wicked problem’. Such problems are not
well defined (Rittel & Webber 1973) and solutions require iterative adjustments to cater
for the evolving needs of participants (Moser, Jeffress Williams & Boesch 2012).
Solutions to wicked problems can be challenged by knowledge uncertainty, contested
stakeholder goals (Bosomworth et al. 2017), social power inequalities (Few, Brown &
Tompkins 2007), different risk perceptions amongst participants (Productivity
Commission 2012) and decision-makers operating in short-term political cycles (Cooper
& Pile 2014).
The intrinsic irreducible nature of uncertainty in long-term climate change adaptation
problems means that decision support tools and strategies are needed to manage this
reality (Walker, Haasnoot & Kwakkel 2013). Various methods are available to support
decision-makers under conditions of uncertainty, such as dynamic adaptive policy
pathways (DAPP) (Haasnoot et al. 2013), real options analysis (Woodward, Kapelan &
Gouldby 2014), info-gap decision theory (Korteling, Dessai & Kapelan 2013), decision
scaling (Brown et al. 2012), robust decision making (RDM) (Lempert, Popper & Bankes
2003) and many objective robust decision-making (Kasprzyk et al. 2013). Analytical
model-based methods that use exploratory modelling to design adaptive and robust
plans are useful in supporting wicked problems like climate change adaptation.
Exploratory modelling uses a series of computational experiments to analyse the
implication of future assumptions on policies (Bankes 1993).
Model-based tools are limited by the very models they use. They are generally
quantitative in nature and therefore unable to capture nuanced socially-oriented
consequences that climate change and adaptation may have within the community.
Values-based approaches offer an alternative method of elucidating non-measurable
information about those lifestyle attributes considered important to residents. They
recognise how climate change may influence the everyday lives of people and that
legitimate adaptation requires addressing diverse individual needs (O'Brien & Wolf 2010).
There are few examples of such values-based approaches being used in the coastal
climate change adaptation literature. Those examples include a lived values approach,
which considers what aspects of people’s lives are judged to be important (Graham et
al. 2014), and social and cultural mapping (Novaczek et al. 2011), which looks at where
3

certain values are assigned to coastal landscapes (referred to herein as landscape
values mapping).
Iterative risk management is an important framework for climate change adaptation
decision-making when consequences are uncertain (Jones et al. 2014; Jones & Preston
2011). It guides users through the identification, assessment, management and
monitoring of risk. The framework manages uncertainty through a dynamic process of
monitoring and continuous improvement, with such principles evident in many climate
change adaptation frameworks around the world (e.g. European Commission and
European Environmental Agency 2013; Mediation Adaptation Platform 2013; NCCARF
2017; UKCIP 2015). Adaptation pathways are concatenations of short-term and longterm options that provide multiple ways to achieving risk management goals. Both
adaptation pathways and iterative risk management are based upon the principle of
adaptive management (Watkiss et al. 2014), with similarities in scoping, risk identification
and risk treatment (adaptation) activities. Adaptation pathways have been applied in
various locations worldwide to manage coastal flood risk (e.g. Barnett et al. 2014c;
Lawrence et al. 2013; Reeder & Ranger 2011; Rosenzweig & Solecki 2014; Zandvoort
et al. 2017). In Australia, local government have used adaptation pathways as a tool for
engaging with communities and planning long-term strategies (e.g. Barnett et al. 2014c;
Lake Macquarie City Council 2015).
The DAPP framework broadly aligns with principles of iterative risk management and is
used to develop flexible and anticipatory adaptation pathways (Haasnoot et al. 2013).
Adaptation tipping points are a key element of adaptation pathways. These points are
reached when an adaptation policy no longer achieves the decision-makers’ goals
(Kwadijk et al. 2010). The use of analytical techniques from RDM – an evaluation method
used to design policies that perform well over a wide range of future ‘what-if’ scenarios
– provides a possible approach to describing adaptation tipping points (Kwakkel,
Haasnoot & Walker 2016). This arises from the cluster-finding algorithm that RDM uses
to provide descriptions about what future conditions cause a policy to fail (Lempert et al.
2013). In the context of coastal planning, improving the way adaptation tipping points are
described in adaptation pathways can help address questions such as how much stress
can the existing community absorb?, when might impacts become unacceptable? and
how effective are different adaptation options in keeping coastal flood risk at acceptable
levels?
Whilst adaptation pathways can provide a strategic approach to managing long-term
coastal flood risk, for example the Thames Estuary 2100 plan (Bloemen et al. 2017),
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many challenges remain. These include raising awareness and obtaining buy-in from
senior management to test adaptive planning approaches (Lawrence & Haasnoot 2017),
the design of signpost indicators and triggers in monitoring systems (Hermans et al.
2017), the detection of triggers to implement anticipatory actions (Haasnoot et al. 2015)
and managing the transition from incremental short-term measures to transformational
long-term actions (Bloemen et al. 2017).
There are two challenges that have not been explored to the same extent in adaptation
pathways research. The first is how model-based approaches can be used to provide
better visibility on what conditions lead to adaptation tipping points when multiple risk
factors are acting simultaneously. The second is how social values information can be
included in the adaptation pathways planning process. Novel approaches to elucidate
values-based information and design adaptation pathways using model-based
approaches could provide a valuable framework to manage future coastal flood risk. It
could also provide a more meaningful basis upon which anticipatory adaptation planning
is undertaken in low-lying coastal communities that is inclusive of diverse stakeholder
needs.

1.2 Research motivation
This research is motivated by the need to improve long-term coastal flood risk
management, which is currently challenged by uncertain consequences and contested
stakeholder goals. This research focuses on Australia, where about half the population
live within 7 km of the coast (Chen & McAneney 2006) and up to 274,000 residential
buildings would be exposed to a sea level rise of 1.1 m (Commonwealth of Australia
2011).
The first key motivation is to explore how the strengths of RDM and DAPP – two
potentially complementary model-based approaches to plan adaptation pathways
(Kwakkel, Haasnoot & Walker 2016) – could be used in coastal flood risk management
to improve adaptation pathways planning under conditions of uncertainty. In particular,
combining both approaches may provide a more detailed understanding of adaptation
tipping points when multiple risk factors are acting on the system. Furthermore, open
access tools provide increasingly accessible opportunities to develop model-based
decision support techniques, which could provide a lower-cost entry point for resourceconstrained authorities to undertake adaptation pathways planning.
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The second key motivation is that adaptation planning traditionally focusses on physical
rather than social impacts, often overlooking social and cultural factors (O'Brien & Wolf
2010). Whist there is increasing recognition around the importance of values-based
information in adaptation pathways planning (e.g. Barnett et al. 2014c; Gorddard et al.
2016), there has been little research that explores how values-based information might
be used to complement model-based approaches (e.g. RDM and DAPP) to plan coastal
adaptation pathways. This provides an opportunity to plan more socially acceptable
adaptation pathways.

1.3 Research aim and objectives
1.3.1 Research aim
The aim of this research is to improve the way local governments plan adaptation
pathways in low-lying coastal settlements to manage future coastal flood risk. This
includes timely implementation of adaptation actions in anticipation of uncertain
environmental change. The outcome from this research is to contribute to best practice
by providing a framework that is embedded in iterative risk management, for long-term
adaptation planning in low-lying coastal communities that could be replicated globally to
support decision-makers. This has interdisciplinary applications across engineering
planning and design, emergency management, social sciences and spatial planning.

1.3.2 Research objectives
The stated research objectives are as follows:
Objective 1:

Review methodological approaches used in Australia to evaluate longterm coastal adaptation options, benchmarking characteristics with two
state-of-the-art (RDM and DAPP) methods from abroad to inform
research directions.

Objective 2:

With the aid of a hypothetical case study, explore whether the strengths
of RDM and DAPP methods can be integrated to improve the design of
adaptation pathways and description of adaptation tipping points.
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Objective 3:

Integrate GIS software with open source spatial data and programming
tools to support exploratory modelling and the assessment of physical
impacts from coastal flooding on adaptation objectives.

Objective 4:

Assess the merit of values-based approaches (i.e. lived values and
landscape values mapping) to describe non-measurable social and
cultural impacts associated with sea level rise and the distributive
fairness of adaptation policy on residents.

Objective 5:

Implement a combined RDM and DAPP approach (Objectives 2 and 3)
in a second hypothetical case study, including the evaluation of
adaptation policy options and exploration of how values-based
information can complement the adaptation pathway planning process.

Objective 6:

Evaluate lessons learned from the thesis case study examples and
develop an adaptation pathways framework, discussing key barriers
and enabling factors for future real-world applications.

1.4 Outline of research methodology
The research topic focuses on improving coastal flood risk management with adaptation
pathways planning. Hypothetical case study locations (referred to herein as case studies)
are selected from south-eastern Australia to develop model-based and values-based
techniques to advance adaptation pathways planning. The case studies focus on existing
settlements in coastal floodplains that are subjected to both riverine flooding and
inundation from the sea.

1.5 Thesis structure
A brief outline of each thesis chapter is provided in the remaining part of this section and
an overview of the thesis structure is shown in Figure 1.1.
Chapter 2 (Objective 1) reviews current decision support methods being used by local
government in Australia to plan and evaluate long-term coastal adaptation options,
examining six characteristics for each project. These include the decision objective, time
horizon of the assessment, approach used for risk identification, management of
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uncertainty, decision process and decision metrics. Drawing on the characteristics of two
state-of-the-art decision support methods – robust decision making (RDM) and dynamic
adaptive policy pathways (DAPP) – Australian practice is benchmarked to identify
opportunities to improve coastal adaptation planning.
Chapter 3 (Objectives 2 and 3) builds on the review undertaken in Chapter 2 and
investigates how the strengths of RDM and DAPP could be used to improve coastal
adaptation pathway planning under conditions of uncertainty. In particular, it focuses on
using scenario discovery to describe conditions that lead to adaptation tipping points.
This chapter develops a conceptual method to planning adaptation pathways with a
combined RDM and DAPP approach using commercial GIS software, open source data
and programming languages. Key concepts are illustrated using a case study in the
suburb of Kingston Beach, Tasmania.
Planning for sea level rise often focuses on ameliorating physical impacts (e.g. Chapter
3) rather than social impacts. Chapter 4 (Objective 4) addresses this research gap by
comparing the explanatory value of the lived values approach – which explores what
aspects of people’s everyday lives are important – and the landscape values approach
– which investigates where certain values are associated with coastal landscapes – to
assess whether either or both approaches are likely to meet local adaptation planning
needs and achieve more socially-oriented adaptation responses. A case study1 from
Kingston Beach is used to assess how both values-based approaches can support more
socially-oriented adaptation outcomes.
Chapter 5 (Objective 5) further develops the combined RDM and DAPP approach
presented in Chapter 3 to plan adaptation pathways. The combined approach is
developed and tested in Lakes Entrance, Victoria, to design strategic adaptation
pathways that manages coastal flood risk. Lived values information from prior research
(Graham et al. 2014) is considered in the evaluation of adaptation pathways to illuminate
how different adaptation pathways might impact significant lived values in the community.
This study progresses a discussion about how values-based information might be used
in a combined RDM and DAPP approach to plan adaptation pathways.
Chapter 6 (Objective 6) synthesises the main lessons learned and research contributions
from the review material and case studies presented in this thesis. In particular, it
considers the use of model-based and values-based information to support local
Approval for the case study was received from the Tasmanian Social Sciences Human
Research Ethics Committee (reference number H0015609).
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government in coastal adaptation pathways planning. A framework is then proposed that
consolidates the main thesis contributions. Barriers and enabling factors associated with
implementing the framework in a real-world case study are considered based upon
learnings in this thesis.
Chapter 7 presents the general conclusions of this research and provides future research
directions to advance coastal adaptation pathways planning.

Figure 1.1 Structure of the thesis, research objectives and publications.
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Chapter 2 A review of methodologies
applied in Australian practice to
evaluate long-term coastal adaptation
options
This chapter has been published as Ramm, TD, White, CJ, Chan, AHC & Watson, CS
2017, 'A review of methodologies applied in Australian practice to evaluate long-term
coastal adaptation options', Climate Risk Management, vol. 17, pp. 35-51. Minor
changes have been made to the original published article for consistency in this thesis.
This includes general terminology and presentation of Figure 2.2, Figure 2.3 and Figure
2.4.

2.1 Abstract
Rising sea levels have the potential to alter coastal flooding regimes around the world
and local governments are beginning to consider how to manage uncertain coastal
change. In doing so, there is increasing recognition that such change is deeply uncertain
and unable to be reliably described with probabilities or a small number of scenarios.
Characteristics of methodologies applied in Australian practice to evaluate long-term
coastal adaptation options are reviewed and benchmarked against two state-of-the-art
international methods suited for conditions of uncertainty (Robust Decision Making and
Dynamic Adaptive Policy Pathways). Seven out of the ten Australian case studies
assumed the uncertain parameters, such as sea level rise, could be described
deterministically or stochastically when identifying risk and evaluating adaptation options
across multi-decadal periods. This basis is not considered sophisticated enough for longterm decision-making, implying that Australian practice needs to increase the use of
scenarios to explore a much larger uncertainty space when assessing the performance
of adaptation options. Two Australian case studies mapped flexible adaptation pathways
to manage uncertainty, and there remains an opportunity to incorporate quantitative
methodologies to support the identification of risk thresholds. The contextual framing of
risk, including the approach taken to identify risk (top-down or bottom-up) and treatment
of uncertain parameters, were found to be fundamental characteristics that influenced
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the methodology selected to evaluate adaptation options. The small sample of case
studies available suggests that long-term coastal adaptation in Australian is in its infancy
and there is a timely opportunity to guide local government towards robust
methodologies for developing long-term coastal adaptation plans.
Keywords: adaptation, climate change, coastal inundation, evaluation, sea level rise;
uncertainty

2.2 Introduction
Australia is an arid country with approximately 85% of the population settled near the
coast (Australian Bureau of Statistics 2004; McInnes et al. 2016b). During the last few
hundred years there has been a steady rise in the global mean sea level and the rate of
sea level rise appears to have accelerated in recent decades (Church et al. 2013; White
et al. 2014). This trend is consistent in Australia, with regional sea level rise observations
at many locations comparable to the global rate (CSIRO & Bureau of Meteorology 2015).
Sea level rise increases the frequency and severity of natural hazards (e.g. storm surge;
Hunter 2010), whilst over multi-decadal (long-term) time scales can contribute to
permanent loss of land in low-lying areas. It was estimated that a 1.1 m sea level rise
across Australia would threaten over $200 billion of buildings, roads and rail, including
274,000 residential buildings (Commonwealth of Australia 2011). Further impacts of sea
level rise and changing coastal flooding regimes include more frequent impacts to the
built environment, increasing threats to public safety, and disruptions to important
resident lifestyle values (Graham et al. 2014).
Engineered shoreline management controls (e.g. sea walls, groynes) that mitigate the
impact of coastal hazards are often designed with a serviceable life of 50-100 years
(Hallegatte et al. 2012; Stafford-Smith et al. 2011), thereby carrying long-term
commitments. Evaluating the effectiveness of different management controls in
mitigating projected coastal impacts is difficult because of uncertain long-term changes
to biophysical, socioeconomic, technological, institutional and built environment
stressors (Smith et al. 2015). Such uncertainties are unlikely to be reduced in the shortterm due to limitations in scientific knowledge, predictability and multi-decadal climate
variability. For these reasons, new methods of decision support have been called for that
can accommodate irreducible uncertainty (Hallegatte 2009).
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Local government plays an important role in promoting long-term climate change
adaptation in response to the threat of changing coastal hazards. They are responsible
for ‘day-to-day’ decision making in coastal planning and management, often guided by
State policy and legislation (Commonwealth of Australia 2009). Local government works
with communities to raise awareness of climate change risks, manage public assets,
deliver services and support local planning (Council of Australian Governments 2012).
As local government are at the forefront of community decision-making, they are the
target audience of this chapter.
This chapter systematically reviews characteristics of the methodologies used in current
practice by Australian local government to evaluate long-term adaptation options and
manage risks in low-lying coastal settlements. These characteristics include the decision
objectives, approach taken to identify risk, time horizon over which risks and evaluation
activities are assessed, management of uncertainty, choice of decision process and the
decision metrics. Case studies are drawn from across Australia, including selected
literature from the 2011-2012 Australian Government’s coastal adaptation decision
pathways program (CAPPs). The characteristics of the methodologies used to evaluate
adaptation options in Australia are then compared with two state-of-the-art methods for
decision-making under conditions of deep uncertainty – Robust Decision Making (RDM)
(Lempert, Popper & Bankes 2003) and Dynamic Adaptive Policy Pathways (DAPP)
(Haasnoot et al. 2013) – to identify any opportunities for local government to improve
adaptation planning and the evaluation of long-term coastal adaptation options.
Whilst previous studies have reviewed (a) the challenges and successes of Australian
coastal vulnerability and adaptation studies (Kay, Travers & Dalton 2014); (b) general
decision support methods for climate change adaptation (Dittrich, Wreford & Moran 2016;
Watkiss & Hunt 2013); and, (c) decision support methods suited to conditions of deep
uncertainty (Kalra et al. 2014; Walker, Haasnoot & Kwakkel 2013), there has not been a
review of current decision support methodologies being applied by local government at
a local scale (i.e. city or urbanised area) in Australian coastal adaptation practice.
Notwithstanding the complexities and different decision contexts faced at various
locations along the Australian coast, this review seeks to reduce some of the difficulties
associated with long-term decision making by exploring the defining characteristics of
the evaluation process and highlighting fundamental considerations for local government
agencies. Benchmarking the characteristics of current practice with two state-of-the-art
methods for decision-making under conditions of uncertainty allows opportunities to
improve long-term decision-making in Australia to be identified. This review may direct
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local government towards a defensible methodological basis to invest in adaptation
policies under conditions of uncertainty, so that they can make better informed decisions
without the threat of maladaptation and legal liability (Baker and McKenzie 2011;
Productivity Commission 2012).
The remainder of this chapter is structured as follows. Section 2.3 summarises the review
methodology, and a short summary of risk management and components underpinning
evaluation methodologies across long-term planning horizons is provided in Section 2.4.
Section 2.5 presents the results of the reviewed case studies. Section 2.6 summarises
the key characteristics of the case studies, before benchmarking these with attributes of
RDM and DAPP (two approaches that have been demonstrated quantitatively abroad)
which are used to support decision-making under conditions of uncertainty.
Opportunities to advance current practice are then identified and conclusions drawn in
Section 2.7.

2.3 Review methodology
The literature reviewed in this study focuses on characteristics of the methodologies
applied by local government to evaluate the performance of long-term coastal adaptation
options (‘adaptation option’ is used interchangeably with ‘adaptation policy’). Case
studies were derived from published local government and corporate reports, and peerreviewed publications. Given there are more than 200 local government areas in
Australia sharing boundaries with coastal or estuarine water bodies (based on a count
of local government areas; Australian Bureau of Statistics 2014), this review did not
explore publications from each local government agency in Australia. Therefore,
although the literature reviewed in this chapter represents diverse geographical
coverage, it is a representative selection of studies from around the country.
The review was limited to literature published since 2010, allowing the analysis to focus
on recent case studies and include relevant literature produced as part of the 2011-2012
Australian Government funded CAPPs project. Prior to the CAPPs project there were
very few examples of local government case studies published that focus on the
evaluation of long-term coastal adaptation options. In 2008-2010, 39 projects were
completed as part of the Australian local adaptation pathways program (LAPP)
(Productivity Commission 2012), however these were excluded from this review because
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those reports focused on risk assessment activities, rather than the evaluation of
adaptation options (see Pillora 2010 for a short summary of outcomes).

2.4 Summary of evaluation methodology characteristics in risk
management
The formal evaluation of a policy or project requires the use of decision support tools to
assess the efficacy of a risk treatment option. This section provides a short summary of
background fundamentals that characterise the methodology used in identifying risk and
evaluating adaptation options. The section forms a basis from which the systematic
review of case studies is undertaken in Section 2.5.

2.4.1 Risk management as an overarching framework
Risk management is a recognised framework for developing long-term climate change
adaptation strategies under conditions of uncertainty (Jones et al. 2014; Jones & Preston
2011) and is a common feature of leading climate change adaptation frameworks
(European Commission and European Environmental Agency 2013; Mediation
Adaptation Platform 2013; UKCIP 2015). The evaluation of adaptation options is a risk
treatment activity with the benefits often expressed in terms of how well the option
mitigates projected impacts (AS/NZS ISO 31000:2009 2009; Travis & Bates 2014).
Therefore, the framing of future risk scenarios is crucial to the evaluation process.
The approach to risk identification is important as it reflects the decision-makers framing
of risk (Jones & Preston 2011). It influences the selection of climate change scenarios
(risk identification), from which impacts to low-lying coastal settlements are analysed
(risk analysis), risk treatment options developed (adaptation options) and the net benefit
of the adaptation options evaluated. Two common ways that decision-makers frame risk
have been described in the literature as being ‘bottom-up’ or ‘top-down’ (Garcia et al.
2014; IPCC 2012; Jones et al. 2014). Both approaches differ in the order in which the
risk assessment steps are undertaken and more crucially in their treatment of uncertainty,
thereby making it an important characteristic of the chosen methodology to evaluate
adaptation options. In this chapter, reference is made to ‘impact-first’ (i.e. ‘top-down’)
and ‘threshold-first’ (i.e. ‘bottom-up’) as presented by the Intergovernmental Panel on
Climate Change (IPCC 2012) to describe the risk identification characteristics found
within the Australian case studies. The ‘top-down’ approach follows the sequence of first
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projecting future emissions of greenhouse gases, then developing climate scenarios and
studying the impacts and adaptation options; in contrast, a ‘bottom-up’ approach starts
from a given system and then studies vulnerabilities and risk thresholds (i.e. the degree
to which the system is susceptible to, and unable to cope with, adverse impacts of climate
change) (Dessai & Hulme 2004; Kwadijk et al. 2010; Ray & Webb 2015; White et al.
2017).
The time horizon across which adaptation planning occurs influences the degree of
uncertainty about future impacts and adaptation benefits. The extent of knowledge about
the models and parameters used to identify risks and evaluate adaptation options can
be described as being certain (i.e. deterministic), quantifiable probabilistically as risk (i.e.
stochastic), or non-quantifiable (Hall & Solomatine 2008; Knight 1921; Willows & Connell
2003). This conceptualisation can be broadened by using a gradation of uncertainty
levels ranging from certainty to total ignorance (Courtney 2003; Riesch 2013; Walker,
Lempert & Kwakkel 2013) (Table 2.1). Uncertain parameters used in traditional costbenefit analysis (CBA) can include the discount rate, probability of a coastal hazard event
occurring and the damage cost estimates.
Deep uncertainty is a condition where decision-makers are unable to agree on models
that describe the relationships amongst key input parameters and future impacts, nor the
probability distributions used to describe the uncertain parameters in those models
(Lempert, Popper & Bankes 2003). Additionally such uncertainty requires decisions to
be made in a way that responds to system change with time (Kwakkel, Walker &
Haasnoot 2016). Climate change is an example of deep uncertainty. Attributes of this
uncertainty are often encountered when identifying risks and evaluating adaptation
options across multi-decadal time horizons (Kalra et al. 2014; Lempert & Collins 2007;
Reeder & Ranger 2011). There is general agreement that non-probabilistic descriptions
of parameters and modelled impacts are better suited to manage this uncertainty
(Kunreuther et al. 2013; PROVIA 2013).
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Table 2.1 Levels of uncertainty used to describe parameters and model future impacts
(adapted from Kwakkel, Walker & Marchau 2010; Riesch 2013; Walker, Lempert & Kwakkel
2013). The levels of uncertainty are not mutually exclusive.
Uncertainty
level

Attributes / knowledge about future
conditions

Example of complementary
evaluation methodology

Level 1
(certainty)

 Future scenarios: relatively clear
scenario
 Parameters: Known (deterministic)
 Model: Known

Traditional CBA (single
scenario with sensitivity
analysis on uncertain
parameters)

Level 2

 Future scenarios: Multiple
 Parameters: Unknown (described
with multiple probabilistic scenarios
or single estimate with confidence
interval)
 Model: Known

CBA with Monte Carlo
simulation

Level 3

 Future scenarios: Multiple
(selection)
 Parameters: Unknown (nonprobabilistic; use of trends)
 Model: Unknown (able to identify
likely model and rank alternatives)

CBA output (point estimate)
from different models and
scenarios; ranked by likelihood

Level 4

 Future scenarios: Multiple (many)
 Parameters: Unknown (nonprobabilistic; specify bounds)
 Model: Unknown (recognise
sources of model inadequacy and
assumptions; cannot rank
alternatives)

Adaptation pathways; RDM;
DAPP a.

Level 5 (total
ignorance)

 Future scenario: Unknown
 Parameters: Unknown
 Model: Unknown (recognised
ignorance and inadequacies)

DAPP a.

a. Level 4 and 5 are referred to as ‘deep uncertainty’. DAPP is considered to be
suitable under level 4 uncertainty, and in some cases level 5 uncertainty (Walker,
Lempert & Kwakkel 2013).

2.4.2 Components of evaluating adaptation options
Deciding how to evaluate coastal adaptation options requires the analyst to: 1)
understand the decision needs and context, 2) select a ‘decision process’, and 3) identify
appropriate ’decision metrics’ (for more details see Hallegatte et al. 2012; Kalra et al.
2014; PROVIA 2013; Walker, Haasnoot & Kwakkel 2013; Watkiss & Hunt 2013). Once
adaptation options have been evaluated, an adaptation plan can be developed, which
could involve doing nothing and monitoring future changes to risk, selecting a single
adaptation option, implementing a portfolio of options, or designing an adaptation
pathway. An adaptation pathway is a set of sequenced adaptation options that together
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form a long-term plan and can be updated iteratively over time (through adaptive
management) as new information on uncertain parameters becomes available, or when
risk thresholds are reached (Haasnoot et al. 2013; Haasnoot et al. 2012; Stafford-Smith
et al. 2011; Walker, Haasnoot & Kwakkel 2013). Thresholds (also called adaptation
tipping points) are future conditions where the level of risk becomes unacceptable to the
decision-maker, signifying that the adaptation option is no longer effective in managing
the risk (Kwadijk et al. 2010; Reeder & Ranger 2011).

2.4.3 Understanding the decision needs
Identifying the decision needs is addressed during the scoping and context setting
activities in risk management practice (refer ISO 31000 risk management standard;
AS/NZS ISO 31000:2009 (2009); AS5334-2013 (2013); Jones et al. (2014)). This activity
includes defining the decision objectives, data availability and technical capacity for the
analysis, uncertainty characteristics and the time horizon across which the risks are
identified and the benefits of the adaptation option evaluated.
Decision-making objectives often seek either optimal outcomes (i.e. to maximise, or
minimise, the performance of an option) or robust outcomes (i.e. identify an option that
achieves a satisfactory level of performance across a wide range of future scenarios;
Ben-Haim 2012; Lempert & Collins 2007; Walker, Lempert & Kwakkel 2013; Woodward,
Kapelan & Gouldby 2014). Optimal adaptation options can be beneficial when
assumptions about coastal impacts can be estimated with confidence, or when the
adaptation option is flexible and easily reversed. Optimal adaptation options rely on
upfront assumptions about the future being correct, which becomes problematic over
long-term horizons. This makes robust options superior when future impacts are difficult
to model and when adaptation options, such as engineering infrastructure, provide
ongoing benefits across multiple decades.

2.4.4 Selecting a decision process
A decision process is a tool used to appraise adaptation options and produce a metric.
Kalra et al. (2014) categorises the decision process into ‘agree-on-assumption’ or ‘agreeon-decision’ processes, based on the analyst’s assumptions and how they manage
uncertainty. Traditional decision processes such as CBA and multi-criteria decision
analysis (MCDA) are examples of an agree-on-assumption process, as is real options
analysis (ROA). These processes generally align with optimal-seeking decision
objectives and require analysts to agree on the assumptions used in the analysis before
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the evaluation begins. Robust Decision Making (RDM) is an example of an agree-ondecisions process, which does not require stakeholders to agree on input parameter
assumptions prior to the analysis. Such processes seek robust outcomes by evaluating
policies under hundreds or thousands of non-probabilistic scenarios, to explore the
performance of an adaptation option across a large uncertainty space and uncover the
vulnerabilities of that option (i.e. when the option fails to adequately manage risks). Data
mining algorithms, such as the patient rule induction method, are then used in scenario
discovery (e.g. Bryant & Lempert 2010) to identify those uncertain parameters that have
the greatest impact on achieving the objectives of the decisions-maker. Decision
processes such as RDM rely on computational support to explore the performance of
adaptation options across a much larger uncertainty space than is traditionally done
using a limited set of scenarios (see Walker, Haasnoot & Kwakkel 2013 for a review of
computational support tools).
Dynamic Adaptive Policy Pathways (DAPP) is a risk management tool that incorporates
transient scenarios to assess the limits of different adaptation options and define risk
thresholds (Haasnoot et al. 2013). The DAPP framework builds upon the adaptation
tipping point (ATP) concept (Haasnoot et al. 2013; Kwadijk et al. 2010; Watkiss & Hunt
2013), and allows adaptation pathways to be mapped. Pathways are usually designed
following the evaluation of individual adaptation options. The adaptation pathway method
aligns closely with the monitoring and review principals of the globally recognised risk
management framework (AS/NZS ISO 31000:2009 2009) and are examples of adaptive
management.

2.4.5 Selecting decision metrics
Decision metrics are used to compare the performance of different adaptation options.
Metrics can be expressed in qualitative, quantitative or economic (monetary) terms. The
decision process uses decision metrics to evaluate the adaptation options, for example
the net present value (NPV) metric is used to evaluate options with CBA. An important
advantage of the NPV metric over other metrics is that it determines whether an
adaptation strategy is economically feasible and calculates the net monetary benefits.
The use of an MCDA score as a metric can only rank adaptation options in order of
preference, rather than explicitly indicating whether to make the investment or not. The
use of a benefit-cost ratio (BCR) produces a ratio of benefits to cost, however risks
favouring outcomes that may not have the highest monetary net benefit (Boardman et al.
2011, p.34). Evaluating adaptation options based on an MCDA score can be useful when
there are quantitative, qualitative and economic criteria that are to be considered
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(Watkiss & Hunt 2013), however reducing the evaluation of multiple criteria down to a
single score is often criticised as being subjective and easily influenced by stakeholders
(Deb 2001; Dobes & Bennett 2009). Techniques such as multi-objective optimisation
have been developed to overcome the subjectivities in using a single MCDA score, but
require a higher level of technical resource to implement. Multi-objective optimisation
methods can present decision-makers with a larger set of information about the
performance of adaptation options against multiple metrics, from which they can make
informed decisions using their own value judgements about the relative importance of
the objectives and associated trade-offs (for further examples see Kwakkel, Haasnoot &
Walker 2015; Mortazavi Naeini 2013; Woodward, Kapelan & Gouldby 2014).

2.5 Review of long-term coastal adaptation case studies in
Australia
This section systematically reviews characteristics of the methodologies applied to
evaluate adaptation options in a representative sample of long-term coastal adaptation
studies in Australia.

2.5.1 Selected case studies
The geographic location of reviewed case studies is shown in Figure 2.1. Of the
seventeen coastal adaptation studies identified in the review, ten of these projects
contained sufficient information about the characteristics of the risk management
process and evaluation methodology for use in this analysis (Table 2.2). The number of
case studies reviewed is a small sample size, suggesting that the evaluation of long-term
coastal adaptation options is a new area of practice in Australia, with limited progress
being made by local government in recent years as they transition from risk assessment
activities into adaptation planning, evaluation and implementation. A reference list of
case study reports and supporting project documentation has been collated in Appendix
A.
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Figure 2.1 Geographic location of selected coastal adaptation projects reviewed from around Australia. For the projects analysed (see Table 2.2), the
number of case study sites are shown in parenthesis.

Project containing
case study

Coastal inundation
at Narrabeen
Lagoon

A multi-criteria
analysis of coastal
adaptation options
for local government

Marks Point and
Belmont South local
adaptation plan

Coastal hazard
adaptation strategy
for Townsville City
Council

Climate change
decision support
framework and
software for coastal
councils

Regional climate
change adaptation
plan for the Eyre
Peninsula

State

NSW

NSW

NSW

QLD

SA

SA

Robustseeking

Optimalseeking

Optimalseeking

Optimalseeking

Optimalseeking

Optimalseeking

Decision
objective

Thresholdfirst

Impact-first

Impact-first

Impact-first

Impact-first

Impact-first

Dominant
risk
framing

2050+

2100

2100

Level 4

Level 2

Level 2

Not
specified

10,000

1000

Not
specified

Level 4 d.

2100

2

Level 1 c.

2100 c.

1000

Total
number of
scenarios

Level 2

Highest
uncertainty
level

2100

Time
horizon

N/A

Transient

Transient

Endpoint

Endpoint

Transient

Scenario
type a.

MCDA (semiquantitative) e.

ROA

CBA, MCDA

MCDA (semiquantitative),
CBA

MCDA, BBN

CBA, ROA

Decision
process b.

e.

Deliberative

NPV

NPV, BCR,
MCDA
score

d.

BCR,
Deliberative

MCDA
score

NPV

Decision
metrics b.

Siebentritt,
Halsey and
Stafford-Smith
(2014)

Balston et al.
(2012)

GHD (2012)

Lake
Macquarie City
Council (2015)

Preston et al.
(2013)

AECOM and
Department of
Climate
Change and
Energy
Efficiency
(2010)

Reference

Table 2.2 Summary of case studies reviewed with selected characteristics of the methodology used to identify risk and evaluate adaptation options.
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Tasmanian coastal
adaptation pathways
project

Port Phillip Bay
coastal adaptation
pathways project
report

Equitable local
outcomes in
adaptation to sealevel rise

Developing flexible
adaptation pathways
for the PeronNaturaliste coastal
region of Western
Australia

TAS

VIC

VIC

WA

Optimalseeking

Robustseeking

Optimalseeking

Optimalseeking

Decision
objective

Impact-first

Thresholdfirst

Impact-first

Impact-first

Dominant
risk
framing

2100

Not
defined g.

2100

2100

Time
horizon

Level 2

Level 4

Level 1

Level 1

Highest
uncertainty
level

Not
specified

Options not
evaluated g.

1

3

Total
number of
scenarios

Transient

N/A

Endpoint

Endpoint

Scenario
type a.

ROA

Options not
evaluated g.

NPV

Options not
evaluated g.

NPV, BCR

NPV f.

CBA f.

CBA

Decision
metrics b.

Decision
process b.

ACIL Tasman
(2012)

(Barnett et al.
2014c)

AECOM
Australia
(2012)

SGS
Economics and
Planning
(2012)

Reference

a. Transient scenarios (future described as a time-series) or endpoint scenarios (future described at a single point in time).
b. Acronyms: BBN – Bayesian belief network; BCR – benefit-cost ratio; CBA – cost-benefit analysis; MCDA – multi-criteria decision analysis;
NPV – net present value; ROA – real options analysis.
c. Based on the hazard scenarios generated in Stage 2 (place-based evaluation) of the case study.
d. Evaluation of adaptation options through stakeholder workshops. Although the CBA reflected level 1 uncertainty, the development of thresholds
in the adaptation plan recognises level 4 uncertainty.
e. Siebentritt 2016, pers. Comm., 22 Jan.
f. Evaluation of adaptation options not demonstrated explicitly in these case studies. CBA was inferred on basis that an NPV metric was used to
quantify risk and the project being based on a CBA framework (SGS Economics and Planning 2014).
g. Actions implemented based on when risk thresholds were reached (i.e. water elevation levels).
h. Options not evaluated quantitatively in this case study.

Project containing
case study

State

2.5.2 Characteristics of decision support in selected case studies
The reviewed decision support and risk management literature summarised in Section
2.3 finds that six characteristics (Figure 2.2) can be used to provide insights about the
basis and context of a chosen methodology to evaluate adaptation options: (1) decision
objectives; (2) time horizon; (3) approach to risk identification; (4) management of
uncertainty; (5) decision process, and (6) decision metrics. Sections 2.5.2.1 through to
2.5.2.6 summarises the results from Australian case studies based on these
characteristics.

Figure 2.2 Selected characteristics used to review methodologies applied in Australia to
evaluate long-term coastal adaptation options. The characteristics are grouped into the
corresponding steps of the AS/NZS ISO31000:2009 risk management process, aligning with
Sections 2.5.2.1 through to 2.5.2.6.

2.5.2.1

Decision objectives

Six case studies focussed on identifying adaptation options that either maximised the
monetary benefits of coastal adaptation or minimised the projected monetary damage
costs through adaptation (ACIL Tasman 2012; AECOM & Department of Climate Change
and Energy Efficiency 2010; AECOM Australia 2012; Balston et al. 2012; GHD 2012;
SGS Economics and Planning 2012). Two case studies aimed to maximise a weighted
MCDA score based on multiple decision criteria (GHD 2012; Preston et al. 2013). These
were all studies with optimum-seeking decision objectives. Evaluating adaptation options
for an optimal outcome is generally of greater use over short time horizons where
uncertainty can be well characterised by probabilities (Watkiss et al. 2014). The Lake
Macquarie City Council (2015) case study evaluated adaptation options using a semi23

quantitative MCDA approach, however, the decisions were based on community
deliberation rather than a predefined optimisation rule. The cases studies that did not
have optimal-seeking decision objectives tended to display attributes of robustnessseeking objectives (Barnett et al. 2014c; Siebentritt, Halsey & Stafford-Smith 2014).
These studies identified limits of existing coastal risk management measures through
stakeholder workshops, producing a list of adaptation responses mapped as an
adaptation pathway.

2.5.2.2

Time horizon

The majority of case studies adopted a planning horizon up to the year 2100 to identify
risks and evaluate adaptation options (ACIL Tasman 2012; AECOM & Department of
Climate Change and Energy Efficiency 2010; AECOM Australia 2012; Balston et al. 2012;
GHD 2012; Lake Macquarie City Council 2015; Preston et al. 2013; SGS Economics and
Planning 2012). This characteristic is likely to be based upon the time horizons used in
climate change projections published by scientific bodies such as the IPCC and CSIRO.
The case studies that mapped adaptation pathways using risk thresholds generally did
not specify a planning time horizon, rather focusing on the development of triggers to
implement risk mitigation actions and avoid unacceptable risk thresholds being reached
(Barnett et al. 2014c; Siebentritt, Halsey & Stafford-Smith 2014).

2.5.2.3

Approaches to risk identification

A simple classification of the risk identification approach into impact-first or thresholdfirst was not definitive for many of the case studies, however, a dominant approach was
identifiable. The use of impact-first approaches to identify climate risks (scenarios) was
dominant in ACIL Tasman (2012), AECOM Australia (2012), AECOM and Department
of Climate Change and Energy Efficiency (2010), Balston et al. (2012), GHD (2012) and
SGS Economics and Planning (2012). Lake Macquarie City Council (2015) adopted an
impact-first perspective for their economic evaluation, while Preston et al. (2013) used
an impact-first approach in their place-based risk assessment. Fewer case studies
displayed traits of a threshold-first approach to risk identification (Barnett et al. 2014c;
Siebentritt, Halsey & Stafford-Smith 2014). A clear example was provided by Barnett et
al. (2014c) who engaged with the community to identify measurable risk thresholds
based on observable changes to future coastal flooding regimes. These thresholds
reflected the risk tolerance of the community and allowed action plans to be developed
should those risk thresholds be reached.
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2.5.2.4

Management of uncertainty

It was difficult to describe a single level of uncertainty in case studies that definitively
reflected how uncertain parameters were managed in the analysis (Table 2.1). To
illustrate this point, some studies described the sea level rise parameter deterministically
(level 1 uncertainty) and the likelihood of an extreme coastal hazard event stochastically
(level 2 uncertainty). In such instances, the higher uncertainty level was chosen for this
analysis (i.e. level 2 uncertainty in this example). The Lake Macquarie City Council (2015)
case study made deterministic assumptions about the future for their CBA evaluation,
however identified triggers for future action which is indicative of recognising level 4
parameter uncertainty. Seven out of ten case studies described future hazards with
either level 1 or level 2 uncertainty (Table 2.2; Figure 2.3). Notably the studies that made
these assumptions also evaluated the costs and benefits of adaptation options up to the
year 2100, a timeframe over which impacts are highly uncertain. Assuming that
parameters can be described with level 1 or 2 uncertainty does allow analysts to use
familiar appraisal methods (such as CBA) to quantify the risks and benefits of adaptation.
Barnett et al. (2014c) and Siebentritt, Halsey and Stafford-Smith (2014) recognised
limitations in their ability to define the likelihood of future hazards (an attribute of level 4
uncertainty) and adopted a flexible adaptation pathway to support their long-term coastal
adaptation plans.
Sensitivity analysis, or use of a small set of scenarios to evaluate adaptation options,
was used in some case studies that managed uncertain parameters deterministically,
such as an assuming a sea level rise amount by 2100 (e.g. AECOM Australia 2012; SGS
Economics and Planning 2012). Monte Carlo simulation was used in some case studies
to stochastically simulate the probability of future coastal hazards such as extreme
inundation events (ACIL Tasman 2012; AECOM & Department of Climate Change and
Energy Efficiency 2010; Balston et al. 2012; GHD 2012). Based on the assumed
stochastic parameters in the Monte Carlo simulation, the costs and benefits of an
adaptation option could be propagated into CBA (or ROA) and an expected value
calculated (e.g. NPV metric).

25

Figure 2.3 Levels of uncertainty used to describe input parameters and model future impact
scenarios (see Table 2.1), against the time horizon over which the analysis was undertaken
(number of projects = 10).

There were different conceptualisations of the term ‘pathways’ that emerged in this
review. Some studies (e.g. AECOM Australia 2012) grouped individual adaptation
options into discrete pathway sets (e.g. an accommodate or protection pathway); others
(e.g. GHD 2012) analysed adaptation options individually and identified an optimal
investment time for the options (reflecting a future trigger for action contingent on
underlying assumptions being correct); and some (e.g. Barnett et al. 2014c) focussed on
developing risk triggers for adaptation through deliberation with stakeholders. Barnett et
al. (2014c) and Siebentritt, Halsey and Stafford-Smith (2014) were the only two case
studies that mapped an adaptation pathway to manage long-term uncertainty. Neither
study utilised a quantitative method or any modelling to identify the risk thresholds in the
adaptation pathway. The Lake Macquarie City Council (2015) study developed a draft
ten year action plan to manage risk in their community with the plan being reviewed at
regular intervals as more information becomes available. They established triggers to
implement adaptive actions which included the use of governance mechanisms (e.g.
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local government applications for asset maintenance), human processes (e.g. redevelopment applications) and observable increases to flood risk from sea level rise.

2.5.2.5

Decision process

The decision process and decision metrics applied in the reviewed case studies are
summarised in Figure 2.4.

Figure 2.4 Grouping of the decision process with the decision metrics used in the case
studies (number of projects = 9; Barnett et al. (2014c) excluded). All metrics used in each
case study have been counted, therefore the sum of the metrics (15) exceeds the number of
projects (9) as multiple metrics were used in some case studies (Acronyms: NPV – net
present value; BCR – benefit-cost ratio).

An agree-on-assumption decision process was used in the majority of case studies with
CBA being the most common decision process, used in half of the case studies (Table
2.2). ROA extends traditional CBA to handle uncertainty and was used in three case
studies (ACIL Tasman 2012; AECOM & Department of Climate Change and Energy
Efficiency 2010; Balston et al. 2012), whilst MCDA was applied in two of the case studies
27

(GHD 2012; Preston et al. 2013). MCDA is useful in addressing the challenge of
decision-making with stakeholders whom have multiple, conflicting objectives. GHD
(2012) applied MCDA as a screening tool to reduce the number of adaptation options
down to a smaller shortlist, which were then evaluated in further detail with CBA. Preston
et al. (2013) obtained local government stakeholder preferences through a survey and
expressed these as multiple criteria in stage 1 of their analysis, which were then used
with MCDA to evaluate adaptation options. They extended their analysis with a Bayesian
Belief Network (BBN) to understand the variability in individual preferences within, and
between local government stakeholders. Lake Macquarie City Council (2015) and
Siebentritt, Halsey and Stafford-Smith (2014) used MCDA in a deliberative manner, the
former identifying four critical criteria (one of which was to pass a CBA test) that had to
be addressed for the option to be progressed into the adaptation plan.
Barnett et al. (2014c) did not formally evaluate adaptation options in their pathway
approach. They identified a shortlist of adaptation options with community participants
that could be explored once risk thresholds are reached. The first trigger level set by the
community was designed to represent a change to the frequency of the inundation
hazard and prompted the next level of adaptation planning activities to be implemented.

2.5.2.6

Decision metrics

The NPV metric was most commonly used in the case studies (refer Table 2.2; Figure
2.4), which complements the use of CBA and ROA as a decision-process. Siebentritt,
Halsey and Stafford-Smith (2014) did not specify a decision metric to evaluate the
different adaptation options in their study, choosing to undertake the evaluation with
stakeholder participation and discussion. Lake Macquarie City Council (2015) used a
semi-quantitative analysis (MCDA) to evaluate adaptation options, but did not reduce the
assessment against four criteria into a single MCDA score leaving it open for deliberation.

2.6 Discussion
2.6.1 Towards better informed long-term decisions
The small number of case studies available for review suggests that the planning and
evaluation of coastal adaptation options is a relatively new area of practice in Australia.
Although there is guidance material available to local government on risk management
and the selection of suitable evaluation methodologies (Dittrich, Wreford & Moran 2016;
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Mediation Adaptation Platform 2013), there is no nationally recognised standard in
Australia. The different methodological approaches taken in Australia to identify risk and
evaluate adaptation options suggest that further guidance is needed to provide a
consistent basis in local governments. Current research being undertaken by the
National Climate Change Adaptation Research Facility (NCCARF) is contributing to this
knowledge base, aiming to provide risk management information and a decision support
platform through an online portal called CoastAdapt (https://coastadapt.com.au/).
The diversity of methodological approaches used in the Australian case studies made it
difficult in some instances to categorise the approach to risk identification (i.e. impactfirst or threshold-first) and identify what level best describes the treatment of uncertain
parameters. Armstrong, Wilby and Nicholls (2015) experienced similar difficulties
classifying adaptation projects into theoretical frameworks, suggesting that the strengths
of different approaches sometimes compensate for methodological weaknesses in
others, in order to meet decision-maker needs. This conclusion can also be drawn in
current Australian practice.
An emerging theme in the Australian case studies was a reliance on key upfront
assumptions to explore future impact scenarios and to evaluate adaptation options
across multi-decadal periods (to the year 2100). This framing was driven by optimalseeking decision objectives with common assumptions including the extent of sea level
rise, probability of extreme events, discount rates and damage costs. Studies that sought
to optimise the benefits of adaptation took an impact-first perspective to identify risk,
assuming a risk scenario, from which the value of the adaptation response could be
assessed. Impact-first perspectives are subject to the ‘cascade of uncertainty’ (Wilby &
Dessai 2010), whereby assumptions made about future (e.g. emissions) feed into
downscaled climate projections (e.g. sea level rise), which then are carried through to
impact assessments (e.g. monetary impacts) and propagate into the evaluation of
adaptation options. Although impact-first approaches are useful to local government
faced with budget, time and technical resource constraints, they can make it challenging
to formulate a defensible basis for adaptation investment. Furthermore, there is general
acknowledgement in the literature that impact-first approaches are useful when
uncertainty can be well characterised, however under conditions of uncertainty – which
occurs in long-term evaluations – threshold-first approaches are more suitable (Jones et
al. 2014). Many of the Australian case studies overlooked this important principle for
identifying risk and evaluating adaptation benefits over the coming decades. Additionally,
impact-first approaches can overlook social and community-based objectives in
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adaptation planning, which are increasingly becoming recognised (Downing 2012; Hinkel
& Bisaro 2015; Wise et al. 2014) and essential to local government decision-making.
The management of uncertainty was another important characteristic of the evaluation
methodology, reflecting assumptions made by analysts in their ability to describe future
impacts and knowledge of input parameters. The majority of Australian case studies
characterised uncertain parameters as being deterministic (level 1 uncertainty) or
stochastic (level 2 uncertainty). This could be due to the relatively infancy of robust
methods being used in policy analysis (Dittrich, Wreford & Moran 2016) or because such
assumptions simplify the quantitative analysis of adaptation options and make it more
accessible to resource constrained local governments. Case studies that characterised
uncertainty in this way generally tested their assumptions with a sensitivity analysis;
however, there is no guarantee that this explores the full range of uncertainty (Bonzanigo
& Kalra 2014). A few case studies generated many scenarios using Monte Carlo
simulation which allowed a much greater set of assumptions about parameter values to
be explored. These approaches relied on a probabilistic description of uncertain
parameters and the result of the analysis infers a likelihood of attaining the calculated
metric (Bonzanigo & Kalra 2014). The assumption that parameters can be described
probabilistically is often argued to be inadequate for long-term decision-making
(Kunreuther et al. 2013; PROVIA 2013), therefore the basis for managing uncertainty in
the analysis of risks and adaptation options in Australian practice requires rethinking to
avoid a reliance on overly simplistic assumptions. The reliance on upfront assumptions
in Australian practice to evaluate adaptation options (notably underpinning the risk
identification and management of uncertainty) provides empirical evidence to support the
conclusions made by Jones and Preston (2011) that the framing of risk in the scoping
phase is fundamental to the subsequent risk management activities.
The use of CBA to assess the efficacy of capital expenditures is common in practice
(Department of Prime Minister and Cabinet 2016; Dobes & Bennett 2009; HM Treasury
2003; IPCC 2012; Metroeconomica 2004) and was a theme evident in the case studies.
Case studies that recognised the shortcomings of using CBA across longer planning
horizons used ROA to undertake an economic analysis, but ROA requires the direction
of change in the uncertain parameters to be monotonic and adaptation options to be
flexible (Stafford-Smith et al. 2011). ROA can also be challenged by political barriers, for
example having uncertain timeframes for capital investment is less desirable to
governments than committing to inflexible ‘one-off’ investments (Linquiti & Vonortas
2012). ROA also assumes that uncertainty is reduced over time (Hallegatte et al. 2012)
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and like CBA, relies on probabilistic projections for climate related parameters which in
not always appropriate for long-term evaluations.
The complexities of the adaptation challenge faced by local government was evident
across all of the case studies. Whilst it is too early to understand how effective the
appraisal of adaptation options was in the Australian case studies (i.e. the analysis was
done ex ante), two general observations are made about the resultant conclusions.
Firstly, most case studies followed a risk management process (adaptive management)
in the face of uncertainty and concluded that adaptation investments were necessary at
a future time. However, at such points in the future a decision will need to be made
whether to invest and the robustness of such decisions will depend on characteristics
such as the objectives, management of uncertainty and decision process. If investments
are to have multi-decadal consequences, then traditional appraisal methods like CBA
can risk maladaptive outcomes should the future depart from the assumptions. Secondly,
what is identified as being at risk shaped the selection of adaptation options (Hinkel &
Bisaro 2015). For example, many of the case studies focused on mitigating physical
impacts (i.e. losses to assets) which could be monetised for use in CBA or ROA. This
directed adaptation responses towards engineered defences (levees and seawalls) to
manage changing coastal hazards. These plans overlook non-measurable social
impacts from changing coastal hazards and resultant policy recommendations could
underestimate the need for adaptive action.

2.6.2 Benchmarking Australian practice with international methodologies
Two state-of-the-art evaluation methodologies used internationally to support decisionmaking under conditions of uncertainty include RDM and DAPP (Kalra et al. 2014;
Kwakkel, Walker & Haasnoot 2016) (see Section 2.4.4). These methods are most useful
when the future is uncertain, complex and unable to be characterised probabilistically,
which was a decision context shared by most of the Australian cases studies as planning
and evaluation activities occurred across multi-decadal time horizons. In contrast with
many of the case studies reviewed which targeted optimal outcomes using an impactfirst approach (e.g. ACIL Tasman 2012; AECOM & Department of Climate Change and
Energy Efficiency 2010; AECOM Australia 2012; Balston et al. 2012; GHD 2012; SGS
Economics and Planning 2012)), RDM and DAPP seek robust outcomes and take a
threshold-first approach to identify risk. They do not require an evaluation timeframe to
be specified, focusing on observable changes to key parameters. The conclusions drawn
in many of the optimal-seeking case studies rely entirely on initial assumptions being
realised decades from today, which can be contentious amongst stakeholders and
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impede the adaptation planning process. RDM and DAPP can also utilise conventional
metrics such as NPV, which is important for decision-makers who rely on economic
measures as was seen in many of the Australian case studies (e.g. ACIL Tasman 2012;
AECOM & Department of Climate Change and Energy Efficiency 2010; AECOM
Australia 2012; Balston et al. 2012; GHD 2012; Lake Macquarie City Council 2015; SGS
Economics and Planning 2012).
The use of non-probabilistic scenarios to manage uncertainty across multi-decadal time
horizons was a key differentiating factor between those Australian case studies that used
many scenarios and RDM/DAPP methods. Methods such as RDM and DAPP specify
non-probabilistic bounds for uncertain variables and explore how well an adaptation
option performs under many scenarios, which is better suited to managing level 4 or 5
parameter uncertainty. It also allows thresholds for critical variables to be established. In
complex coastal applications where there are many uncertain variables and interactions
amongst stressors, this allows decision-makers to focus on a reduced set of critical
variables that matter most to their risk management objectives. Furthermore, the use of
many scenarios to evaluate adaptation options allows a greater suite of uncertain
parameters to be explored, such as population growth or damage costs, not limited
exclusively to climate related variables like sea level rise which was the case in many of
the Australian case studies. In contrast, some case studies only used a small number of
scenarios to explore a very limited set of future conditions. Those studies that used many
probabilistic scenarios inferred a likelihood of attaining measured outcomes. The
assumption that probability distributions for input parameters can be used to describe
scenarios extending decades into the future is challenged by factors such as nonstationarity (e.g. Milly et al. 2008) and the legitimacy of such plans is likely to reduce as
the planning timeframe increases. Some Australian case studies incorporated basic
ideas from the DAPP method (Barnett et al. 2014c; Lake Macquarie City Council 2015;
Siebentritt, Halsey & Stafford-Smith 2014). Barnett et al. (2014c) acknowledged the
limitations of technical resource in local government to apply quantitative evaluation
methods, and focussed on a non-intensive methodology for constructing their local
adaptation pathway. This approach identified thresholds based on community
participation and resident experience with historic floods, instead of through
computationally intensive scenario modelling. Notwithstanding the constraints faced by
local government, inclusion of a quantitative basis for identifying thresholds would be
valuable information to supplement adaptation planning in Australian communities.
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2.6.3 Opportunities to advance current adaptation practice in Australia
Local government are faced with many challenges that need to be addressed to advance
current adaptation practice. Financial and technical constraints play an important role in
the ability of authorities to undertake planning and evaluation activities. Additionally, local
government are operating in an environment where there is no mandate from higherorder government for adaptation planning, unclear responsibilities amongst government
authorities (Nalau, Preston & Maloney 2015) and the threat of legal liability for
maladaptive decisions. Providing opportunities to increase the uptake of new methods
such as RDM and DAPP for planning and evaluating adaptation options requires the
creation of interest and awareness in local government (Lawrence & Haasnoot 2017),
availability of relevant data (Bhave et al. 2016), leadership from within governments, buyin from senior management and a coordination mechanism (Lawrence & Haasnoot 2017).
Notwithstanding current challenges, the ten representative Australian case studies
reviewed suggest that the approach to identifying risk and managing uncertainty in
evaluation activities can be improved by recognising the time scales across which the
appraisal is occurring and the diminishing ability to predict the future. This is because
uncertainty increasingly propagates as time horizons extend and multiple futures
become possible (Maier et al. 2016). Recognising such uncertainty in evaluation
activities requires a shift towards robust rather than optimal-seeking decision objectives.
Exploring the performance of adaptation options across many scenarios (as used in
RDM and DAPP) can provide an opportunity for local governments to make better
informed decisions in the face of uncertainty, however, the accessibility of these methods
to local government needs to be addressed by future research given the challenges
mentioned earlier. Scenario-based methods can also provide quantitative information to
support the identification of risk thresholds in coastal communities, which can then inform
stakeholder discussions and the design of flexible adaptation pathways. Given the
severity of coastal impacts is projected to increase in the coming decades along with
uncertain change to built and environmental stressors, it is prudent that alternate
evaluation methodologies to those currently used in Australian practice are considered
when long-term coastal adaptation options are being appraised. This can improve the
legitimacy of adaptation planning and avoid maladaptive outcomes that only consider a
narrow range of uncertainties.
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2.7 Conclusions
The selection of a methodology to evaluate long-term coastal adaptation options can be
influenced by the decision objectives, time horizon of analysis, approach to risk
identification, management of uncertainty, decision process, and decision metrics. The
majority of Australian case studies described uncertainty across multi-decadal
timeframes as being deterministic or stochastic, which is not considered sophisticated
enough for long-term risk assessment, evaluation activities and decision-making.
Comparing Australian case studies with two state-of-the-art methods from abroad
reveals that a key difference lies in the use of scenarios to manage uncertainty and seek
adaptation options that are robust to many future scenarios. A greater focus on the use
of scenario-based evaluations is needed in Australia to account for interactions amongst
multiple variables, especially given the potentially high consequences from poor local
government decisions in coastal settlements. The identification of risk thresholds when
formulating adaptation pathways in Australian practice can also benefit from quantitative
scenario-based evaluations to better inform community decision-making.
The reviewed case studies were generally consistent with the overarching ISO31000 risk
management standard but differed in the detailed methods used at each stage of the
process. The framing of risk (i.e. establishing the context) – which includes the risk
identification perspective and management of uncertainty characteristics – was found to
be a fundamental consideration for local governments involved in adaptation activities
as this ultimately influenced the approach taken to evaluate adaptation options. There is
an opportunity for decision-makers in Australia faced with changing coastal hazards to
consider adopting a threshold-first approach to identify risk and seek robust outcomes in
recognition of the uncertainties associated with evaluations across multi-decadal time
frames.
The small number of case studies available for this review suggests that evaluation
activities associated with long-term coastal adaptation in Australia is in its infancy, and
the characteristics discussed in this chapter provide a timely opportunity to guide local
government towards better informed decision-making, which can reduce the threat of
maladaptation and legal liability in the coming decades.
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2.8 Thesis context
This review of current literature and coastal adaptation practice in Australia illustrates
how adaptation pathways are appropriate for planning under conditions of uncertainty
when decisions have multi-decadal consequences. The review highlights that the
approaches to managing uncertainty are critical components of the methodology used
to identify risk and evaluate adaptation options. The review finds that there is an
opportunity for long-term adaptation planning in Australia to increase the use of scenariobased approaches to support decision-making under conditions of uncertainty to better
understand the limits of adaptation policy to future changes. This is particularly relevant
for complex long-term planning problems which require computation support, have
potential for disagreement amongst stakeholders or high consequences from poor
decisions. The next chapter investigates how the strengths of RDM and DAPP can be
combined to improve coastal adaptation pathway planning under conditions of
uncertainty.
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Chapter 3 Describing adaptation
tipping points in coastal flood risk
management
This chapter has been published as Ramm, TD, Watson, CS & White, CJ 2018,
'Describing adaptation tipping points in coastal flood risk management', Computers,
Environment and Urban Systems, vol. 69, pp. 74-86. Minor changes have been made to
the original published article for consistency in this thesis. This includes general
terminology and presentation of Figure 3.6.

3.1 Abstract
Assessing changing coastal flood risk becomes increasingly uncertain across multidecadal timeframes. This uncertainty is a fundamental complexity faced in vulnerability
assessments and adaptation planning. Robust decision making (RDM) and dynamic
adaptive policy pathways (DAPP) are two state-of-the-art decision support methods that
are useful in such situations. In this study we use RDM to identify a small set of conditions
that cause unacceptable impacts from coastal flooding, signifying that an adaptation
tipping point is reached. Flexible adaptation pathways can then be designed using the
DAPP framework. The methodology is illustrated using a case study in Australia and
underpinned by a geographic information system model. The results suggest that
conditions identified in scenario discovery direct the attention of decision-makers
towards a small number of uncertainties most influential on the vulnerability of a
community to changing flood patterns. This can facilitate targeted data collection and
coastal monitoring activities when resources are scarce. Importantly, it can also be
employed to illustrate more broadly how uncontrolled societal development, land use
and historic building regulations might exacerbate flood impacts in low-lying urban areas.
Notwithstanding the challenges that remain around simulation modelling and detection
of environmental change, the results from our study suggest that RDM can be embedded
within a DAPP framework to better plan for changing coastal flood risks.
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3.2 Introduction
Increasing rates of sea level rise have the potential to alter coastal flooding regimes
around the world (Hunter 2010; McInnes et al. 2015; Nicholls & Cazenave 2010), placing
increasing pressure on decision-makers to minimise physical, environmental and social
impacts. However, understanding what changes could lead to unacceptable impacts
within the community and when such changes might occur is challenged by ambiguity
(Dewulf et al. 2005), different risk perceptions (Jones et al. 2014), multi-decadal climate
variability (Hallegatte 2009) and long-term uncertainty associated with varying regional
responses to climate change.
Various decision support tools have been proposed to guide decision-makers through
climate risk assessments and to evaluate adaptation responses under conditions of
uncertainty (e.g. Dittrich, Wreford & Moran 2016; Watkiss & Hunt 2013). When deep
uncertainty exists, dynamic adaptive policy pathways (DAPP) (Haasnoot et al. 2013) and
robust decision making (RDM) (Lempert, Popper & Bankes 2003) have emerged as two
state-of-the-art decision support tools (Kwakkel, Walker & Haasnoot 2016). Deep
uncertainty describes dynamic conditions where there is limited knowledge and
agreement on the use of models, description of parameters in those models and what
impacts are considered (Kwakkel, Walker & Haasnoot 2016; Lempert, Popper & Bankes
2003). Decision-makers are likely to encounter deep uncertainty when assessing the
vulnerability of a community to changing coastal inundation patterns that may be
experienced decades from now, or through coastal development and land use planning
whereby near-term investments will influence urbanisation patterns over the coming
decades.
RDM is a decision support method that evaluates the robustness of new policy options
such as a flood alleviation scheme. DAPP is an adaptive management framework that
begins by considering what future scenarios will cause existing management controls to
fail, before evaluating the suitability and timing of new policy options. Both methods use
hundreds to thousands of non-probabilistic ‘what-if’ scenarios to explore the impact of
the uncertain future on the performance of new (or existing) adaptation policies, allowing
key sensitivities of the policy to be identified. When external changes cause the existing
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system or future adaptation plans to no longer meet decision-maker objectives, an
adaptation tipping point is reached and new actions should be implemented (Kwadijk et
al. 2010). Adaptation tipping points provide a practical way to communicate risks to the
community associated with a changing built and natural environment (Werners et al.
2013). This focuses coastal flood risk management towards understanding the sensitivity
of an urban area to change and assessing when management responses might be
needed to keep impacts at a tolerable level (Kwadijk et al. 2010).
RDM and DAPP aim to design robust policies, and they achieve this in different ways.
RDM identifies adaptation policies that perform satisfactorily under many different future
scenarios, whilst DAPP provides an adaptive management framework within which
flexibility is created, allowing progressive review and update of policy options as more
information becomes available (see Appendix B.1 for a comparison of RDM and DAPP).
Importantly both approaches have the potential to provide complementary information to
decision-makers under conditions of deep uncertainty (Kwakkel, Haasnoot & Walker
2016).
There are few examples from local government that use RDM or DAPP to assess the
vulnerability of low-lying areas to coastal inundation and design adaptation pathways.
This could be due to many factors including unclear adaptation responsibilities in
government (Nalau, Preston & Maloney 2015), limited awareness of new decision
support tools (Lawrence & Haasnoot 2017), limited availability of relevant data to
undertake such an analysis (Bhave et al. 2016) and technological or financial constraints.
Simplified applications of RDM (e.g. Daron 2015) and adaptation pathways (e.g. Barnett
et al. 2014c) have been demonstrated for resource-constrained decision-makers.
However, the growing global repository of spatial data and open source programming
code (e.g. the exploratory modelling workbench; Kwakkel 2017) means that local
governments, business and individuals have an opportunity to use more sophisticated
techniques to analyse climate risks, quantify thresholds and evaluate adaptation
responses (Ramm et al. 2017b).
Many of the adaptation pathway examples to date in coastal flood risk management
describe conditions that lead to an adaptation tipping point with a single parameter like
sea level rise (Reeder & Ranger 2011) or storm surge height (Kwadijk et al. 2010). This
conceptualisation of risk suggests that flood impacts could be treated by controlling the
single hazard with a sea wall or levee (Klijn et al. 2015). However, important factors that
relate to land use or property design are often omitted, which can overlook broader risks
in urbanised areas that may exacerbate coastal inundation impacts.
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We contribute to adaptation pathways planning research by exploring whether RDM and
DAPP methods can be integrated to support coastal adaptation planning under
conditions of uncertainty. We propose that RDM is well suited to describe a set of
conditions where existing or future plans would no longer satisfy adaptation objectives in
low-lying urban areas, signifying that an adaptation tipping point is reached. Knowledge
of conditions that lead to adaptation tipping points can be used to further develop
adaptation pathways using the DAPP framework, whereby each pathway represents a
different set of adaptation options sequenced over time. A more comprehensive
understanding of an area’s sensitivity to coastal inundation allows questions such as
‘what change in the built and natural environmental is important?’ and ‘when might such
change occur?’ to be explored. A similar philosophy was used by Kalra et al. (2015) to
manage water resources in Lima. However, we are not aware of any literature that
proposes the integration of RDM and DAPP for use in coastal flood risk management
and adaptation planning. The methodology presented herein uses open source spatial
datasets and programming languages for the benefit of resource constrained decisionmakers. However, it relies on commonly used commercial software (ArcGIS) and flood
modelling capability. We illustrate the potential for the approach on a case study site in
Kingston Beach, Australia, to identify what future change might lead to unacceptable
coastal flood impacts to people, property and lifestyle objectives.
With over $200 billion of infrastructure in Australia exposed to a 1.1 m sea level rise
(Commonwealth of Australia 2011), strategic investment in coastal adaptation responses
is important to avoid an increasing burden on the nation’s resources. A greater upfront
investment in risk identification and adaptation planning using state-of-the-art decision
support methods could generate sizable budget savings to all levels of government and
the community. Section 3.3 of this chapter presents an overview of the methodology.
The approach is demonstrated with a case study in Section 3.4. The implications and
prospects of the method are discussed in Section 3.5, with conclusions drawn in Section
3.6.

3.3 Methods
We present a methodology that draws on the strengths of RDM to describe conditions
leading to adaptation tipping points that can be used in a DAPP framework to map
adaptation pathways. The basis of the presented methodology overlaps with the XLRM
framework used in RDM to organise exogenous uncertainties (X), policy levers (L),
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relationships and models (R) and metrics (M) (for more details see Lempert et al. 2013).
The key steps in the methodology are summarised in Figure 3.1. Details about each step
are provided in Sections 3.3.1 to 3.3.7.

Figure 3.1 Summary of methodological steps to describe conditions leading to adaptation
tipping points for use in adaptation pathways planning. These steps are expanded on in
Sections 3.3.1 to 3.3.7.

3.3.1 Define adaptation objectives
Adaptation objectives describe what coastal decision-makers are trying to achieve by
managing coastal inundation impacts. The objectives can be guided by organisational
requirements or through stakeholder engagement. An example of an adaptation
objective that accounts for physical impacts might be minimising the length of critical
access roads inundated during a flood, whilst an environmental adaptation objective
might be minimising the loss of beach and dune area (e.g. Ward, Butler & Hill 1998).
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Both of these objectives could also relate to intangible social values held by local
residents, such as ensuring recreational opportunities, aesthetic value and an ongoing
feeling of safety.

3.3.2 Define uncertain factors
Uncertain factors are those that cannot be influenced by decision-makers, are relevant
to the adaptation objectives, and whose future state is unknown. They can be exogenous
(X) to the system and outside the decision-makers control, or influence relationships
inside the system (R) itself. An example of an uncertainty in the context of coastal
adaptation is relative sea level rise. The range of values that uncertain factors might take
in the future is specified a priori and can be based upon stakeholder participation or
guided by scientific evidence.

3.3.3 Generate cases
A case is a future realisation that represents a combination of randomly sampled
uncertain factors (analogous to a single ‘what if’ scenario). Each case captures a single
set of assumptions about the future state of uncertain factors. The generation of
numerous cases allows future realisations to be explored in a process of exploratory
modelling (Bankes 1993). Cases are generated by selecting values for uncertain factors
using Latin Hypercube Sampling (LHS) (‘lhs’ package), which then become inputs to the
computational experiments.

3.3.4 Develop rules of thumb
Rules of thumb are simple principles that relate the value of an uncertain external factor
(X) to a change in the model (R) (Section 3.3.5). For example, sea level rise may affect
the depth and extent of coastal flooding, which is used to assess impacts to the
adaptation objectives for the case being explored. Rules of thumb can be derived from
expert judgement, prior knowledge, or from a set of detailed scientific models.

3.3.5 Impact modelling (simulation)
The ability to simulate many cases to assess coastal inundation impacts in a reasonable
timeframe requires a trade-off with the precision of the model (Bhave et al. 2016; Walker,
Haasnoot & Kwakkel 2013). Proxy models are often useful in such instances (also
referred to as metamodels or surrogate models) (Haasnoot et al. 2012; Teng et al. 2017).
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A simulation model was developed in Python 2.7 using geoprocessing tools from the
ArcPy module (ArcMap 10.4) and incorporating the ‘spatial’ and ‘3D analysis’ ArcMap
extensions. Risk was conceptualised as the product of a hazard, an exposed element
and the associated vulnerability (de Moel et al. 2015; IPCC 2012; Klijn et al. 2015), which
was a useful way to organise various components of the simulation model. For example,
a floodwater elevation map reflects a hazard, property reflects an exposed element, and
the vulnerability of that element is described by monetary damage based upon flood
depth.

3.3.6 Describe conditions that lead to adaptation tipping points
Scenario discovery searches through results in the case database and aims to identify a
small number of ‘candidate scenarios’ (Figure 3.2) that best identify ‘cases of interest’
(Lempert 2013). Cases of interest are those cases that result in acceptable impacts to
adaptation objectives. A candidate scenario describes a cluster of cases and resembles
a subspace of the uncertainty space that is explored in the computational experiments.
It is defined by a small set of factors and intervals (i.e. conditions) that capture a high
concentration of cases of interest. Should the small set of identified conditions occur
simultaneously in the future, an adaptation tipping point is likely to be reached and an
adaptation response would be needed to maintain impacts to the adaptation objectives
at or below the desired tolerance. Identifying a small number of candidate scenarios
through scenario discovery helps to keep the result interpretable for decision-makers.
The ‘sdtoolkit’ R package 2 was used to undertake scenario discovery, applying the
Patient Rule Induction Method (PRIM) algorithm (Friedman & Fisher 1999) to identify
clusters of the cases of interest. Whilst Classification And Regression Trees (CART) offer
an alternate data mining algorithm to PRIM (Breiman et al. 1993), neither algorithm
currently has a strong advantage over the other (Kwakkel & Jaxa-Rozen 2016; Lempert,
Bryant & Bankes 2008).
The quality of the candidate scenario is measured by its ‘coverage’ and ‘density’ (Figure
3.2). Coverage describes the cases of interest captured by the candidate scenario as a
proportion of all cases of interest in the entire results database. Density describes the
percentage of the cases of interest captured by the candidate scenario out of all cases
captured by the candidate scenario (Bryant & Lempert 2010; Lempert et al. 2013). Other
diagnostic measures, such as the quasi p-value and reproducibility statistics, are useful

2

See Bryant (2016) for package details.
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for understanding the significance of the constrained factors in the candidate scenarios
(for more details see Bryant & Lempert 2010).

Figure 3.2 Key concepts used in scenario discovery. Filled circles represent cases of interest.
The candidate scenario is defined as a box (dashed line) that constrains key input factors.
Coverage and density describe the quality of the candidate scenario.

3.3.7 Develop the adaptation pathway
Once conditions under which adaptation objectives are no longer achieved have been
identified through scenario discovery, scientific trends and projections can be considered
to understand: 1) the potential for such conditions to occur in the future based upon
available evidence, and 2) over what timeframe such changes are projected to occur.
This information can then be used to develop adaptation pathways using the DAPP
framework (for more details see Haasnoot et al. 2013).

3.4 Case study: Kingston Beach
The method presented in Section 3.3 is illustrated for the case of the coastal suburb of
Kingston Beach, Tasmania (Australia). The study area is located approximately 13 km
south of the capital city of Hobart (Figure 3.3). A unique aspect of the study area is that
approximately 86 % of the housing stock located in low-lying areas was built before 1980
(Dunford, Power & Cook 2014). Thus, they were built prior to the introduction of higher
building standards. The suburb is predominantly residential, with approximately 20-40
small businesses in low-lying areas and many natural landscapes including beaches,
grassland, saltmarshes and forests. Whilst new dwellings will be subject to more
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stringent building regulations and land use planning controls, the characteristics (e.g.
floor level, building materials) of many existing houses in the study area could remain
unchanged for decades. Therefore these houses may have increasing exposure and
vulnerability to changing flood hazards in the future. Extreme sea levels from storm tides
are considered to be a lower threat to people and property in the study area compared
to the inundation threat of riverine flooding from Browns River. However, sea level rise
will threaten low-lying coastal landscapes of significant social and cultural value, such as
the Kingston Main Beach (Ramm et al. 2017a).

Figure 3.3 Study location in the suburb of Kingston Beach, Tasmania. The topographical
terrain is shown with 10 m contours relative to Australian Height Datum (AHD), to highlight
low-lying areas. The existing sea-wall is identified (white dashed line) from which beach width
is estimated.
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3.4.1 Define adaptation objectives
Three adaptation objectives were chosen to manage impacts to people, property and
lifestyle, and these were grouped into key results areas (KRA) as might be done in a
strategic coastal management plan (Table 3.1). This number of objectives is consistent
with other RDM applications (e.g. Bonzanigo & Kalra 2014; Lempert et al. 2013). The
average beach width objective was selected on the basis that: 1) the beach is a highly
valued coastal landscape by residents, and 2) there are many social values associated
with the beach, including recreational use, being free of access restrictions, and
providing residents with a sense of identity (Ramm et al. 2017a). The tolerable impacts
signify whether an adaptation tipping point is reached.

Table 3.1 Adaptation objectives selected for illustrating the methodology, grouped into key
result areas (KRA). Acceptable (tolerable) impacts to people (AAPE) and property (AAD)
reflect an increase of 10 % from the current-day baseline risk. Arriving at the tolerable impact
threshold signifies that an adaptation tipping point is reached. Baseline risk is determined by
modelling impacts with current-day best estimates for the uncertain factors (see Table 3.2).
ID

KRA

Adaptation objective

Metric

Tolerable impact

1

People:
Minimise
exposure

Maintain people
exposed to within 10 %
of current baseline

AAPE

AAPE < 23.5 people /
year

2

Property:
Minimise
damage

Maintain dwelling
damage to within 10 %
of current baseline

AAD

AAD < $650,000 / year

3

Lifestyle:

Maintain a minimum
average beach width of 5
m from sea wall to MHWS
level a.

Average
width of
Kingston
Main Beach

Average beach width >
5m

Preserve
social values

a. Mean high spring water level (MHWS) is 0.623 m above the Australian Height
Datum (Kingborough Council 2017) and reflects the average of spring tide high water
observations over a 19 year period (Woodroffe 2003).

45

3.4.2 Define uncertain factors
A total of seven exogenous uncertainties (X) were identified in our case study illustration
(Table 3.2). Three of the uncertainties related to the hazard component of risk and four
characterised the vulnerability. The Bruun factor in Table 3.2 represents a simplified
relationship between coastal recession and increasing sea levels.
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Vulnerability

Hazard

Risk
dimension

9

9

9

9

Sea level rise
(increase from 2010
levels)

Changing 9 hour
rainfall intensity
(relative to present)

$4,000/4 m2

$500/4 m2

9

Maximum contents
damage (per 4 m2)

10

-10 %

0m

Min

9

9

9

(3)
Beach
width

Maximum structural
damage (per 4 m2) c.

Bruun Factor

b.

(2)
AAD

(1)
AAPE

Uncertain factor

Adaptation objective

$1058/4 m2

$5757/4 m2

N/A

0%

0m

Baseline
(currentday best
estimate)

$2,500/4 m2

$10,000/4 m2

100

+30 %

+1 m

Max

Range a.

Table 3.2 Uncertain factors used for the study site, showing their range and the adaptation objective(s) to which they apply.
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Dunford, Power and
Cook (2014) c.

Dunford, Power and
Cook (2014) c.

Carley et al. (2008);
Mariani et al. (2012)

White et al. (2010);
White et al. (2013)

User defined, guided
by McInnes et al.
(2016a)

Basis for selected
range
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Average people per
house

Damage index at 10
cm inundation

Uncertain factor

9

(1)
AAPE

9

(2)
AAD

(3)
Beach
width

2

-0.1

Min

2.2

N/A

Baseline
(currentday best
estimate)

3

+0.1

Max

Range a.

Value is 2.15 for lowlying statistical area,
2.3 for Kingston Beach
and 2.6 for Australia
(Australian Bureau of
Statistics 2013)

Approximate deviation
from the vulnerability
curve (Geosciences
Australia 2012)

Basis for selected
range

a. The range is not limited to scientific consensus (e.g. IPCC) and can be inclusive of resident perceptions.
b. 9 hour rainfall intensity is the critical duration for the study area (Kingborough Council 2017).
c. The raster cell size is 4 m2 in the impact model. The damage in real dollars for 2016 was obtained from the NEXIS building exposure database
(Dunford, Power & Cook 2014) by dividing the ‘resident structural value’ by the ‘residential building footprint’ for low-lying houses. House
reconstruction cost estimates could alternatively be obtained from insurance providers using representative dwelling details (e.g. 3-bedroom;
pre-1980’s; slab on ground; weatherboard) or industry publications such as Rawlinsons (2017).

Risk
dimension

Adaptation objective

3.4.3 Generate cases
A total of 1,000 cases were generated using Latin Hypercube Sampling (LHS). The
results were stored in a simple flat file database (ASCII csv).

3.4.4 Develop rules of thumb
Three ‘rules of thumb’ were determined for this study to incorporate the effect of
uncertain factors on the simulation model: 1) the change in floodwater elevation for each
meter of sea level rise, 2) the change in the floodwater elevation for each percentage
increase in the 9 hour critical rainfall intensity, and 3) the horizontal beach recession for
each meter of sea level rise.
Peak floodwater elevation maps were developed by Kingborough Council using SWMM
2D hydrodynamic modelling software for 11 different scenarios (see Appendix B.2 for
details). This allowed the current-day baseline risk to people and property in Table 3.1
to be established. The 11 scenarios also allowed the relationship between sea level rise
and peak floodwater elevation to be investigated, revealing that a 1 m rise in sea level
only increases the peak floodwater elevation by 1 cm. The relationship between rainfall
intensity and floodwater elevation was based upon prior flood study work by Kingborough
Council, which suggested that the peak floodwater elevation of Browns River changed
by about 0.1 m per 10 % increase in the 9 hour rainfall intensity (Kingborough Council
2017). The baseline scenarios from the hydrodynamic modelling were converted into
peak floodwater elevation raster grids. These grids could then be adjusted using the rule
of thumb relationships in the simulation model, depending on the change to sea level
and 9 hour rainfall intensity.
The relationship between horizontal beach recession and sea level rise was underpinned
by the Bruun rule (Bruun 1962). Notwithstanding the dynamic nature of sandy beaches
and the difficulty in modelling coastal processes, Kingston Main Beach is understood to
be threatened by inundation from long-term sea level rise (Sharples 2016), regardless of
its historic ability to recover from erosion events (CoastAdapt 2016). Although there are
many simplifications of the Bruun rule (e.g. Cooper & Pilkey 2004), there are currently
few scientifically recognised alternatives for policy design (Mariani et al. 2012). Prior
studies of nearby beaches in the Derwent Estuary suggest that the Bruun factor could
be in the range of 15-37 (Carley et al. 2008), whilst Mariani et al. (2012) suggest that a
Bruun factor of 50 be used for Tasmania (and a factor of 100 for a conservative estimate).
The presence of a sea wall in the study area makes application of the Bruun rule further
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problematic. We therefore only apply it to generate indicative beach loss seaward of the
existing sea-wall at Kingston Main Beach.

3.4.5 Impact modelling (simulation)
A schematic diagram of the model used to simulate impacts against the three adaptation
objectives is shown in Figure 3.4. Spatial datasets were sourced online from the
Tasmanian State mapping authority (DPIPWE 2015). Low-lying houses were digitised
into polygon shapefiles using georectified aerial imagery, and a 2 m x 2 m raster grid
was specified for all geoprocessing analysis. This provided adequate model resolution
whilst improving the processing speed, which was important when raster grids were
converted into NumPy arrays to evaluate coastal flood impacts. Looping through each
row in the case database and applying the rules of thumb allowed different proxy flood
depth rasters to be generated (peak floodwater levels). These rasters could then be
overlayed above the land use raster to identify exposed dwellings and to determine the
vulnerability of those dwelling in terms of damage costs (see Appendix B.3 for details on
the data and geoprocessing tools used in the simulation model).
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Figure 3.4 Schematic diagram of the main activities undertaken to assess impacts to AAPE,
AAD and average beach width. The case database was generated using the R programming
language, before being imported into Python. Impacts on the adaptation objectives for each
case were assessed in Python using geoprocessing tools (ArcPy module).

3.4.5.1

Calculating AAPE

The number of people exposed to hazards was estimated for 1 %, 2 %, 5 % and 20 %
AEP events by multiplying the average number of people per dwelling by the number of
houses inundated. AAPE was then determined by applying the trapezoidal rule to
calculate the area under a plot of AEP against the number of people exposed. A similar
measure to AAPE was used by Lempert et al. (2013).
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3.4.5.2

Calculating AAD

Calculation of the AAD to dwellings was based upon established practice used to assess
monetary flood impacts (de Moel et al. 2015; Egorova, van Noortwijk & Holterman 2008).
The proxy peak floodwater surface was used to determine an inundation depth at each
2 m x 2 m raster cell, from which vulnerability curves were applied to exposed dwellings
to determine a damage index. The damage index reflects the percentage of damage
relative to the full replacement cost. A separate vulnerability curve was used to assess
damages to the house structure (i.e. fixed elements) and contents (i.e. movable assets),
and vulnerability curves were guided by empirical data from Geosciences Australia (2012)
(see Appendix B.4 for details). The monetary impact to all dwellings in each case was
calculated by summing the damage across all raster cells for the 1 %, 2 %, 5 % and 20 %
AEP events, allowing the AAD to be determined using the trapezoidal rule (Ramm, White
& Franks 2015).

3.4.5.3

Calculating average beach width

The average beach width was determined by creating a transect line at five
distinguishable locations along Kingston Main Beach, corresponding to beach access
points. A buffer distance based on the Bruun factor was created around the sea level
rise polygon (at MHWS) based upon the amount of sea level rise in the case being
considered. The transect length was then calculated as the horizontal distance from the
fixed sea wall to the adjusted sea level polygon. The average width across the five
locations was then calculated.

3.4.5.4

Simulation results

The impact model took 85 hours to analyse 1,000 cases on a standard 16GB RAM
machine with a 3.4 GHz Intel processor. Plotting the cases against the adaptation
objectives (Figure 3.5) suggests that although the majority of case realisations resulted
in unacceptable impacts to the adaptation objectives (i.e. Q3 in Figure 3.5a and Q2 in
Figure 3.5b), there are cases that lead to reduced impacts on adaptation objectives (i.e.
Q1 in Figure 3.5 and Q4 in Figure 3.5b). Scatter plots were used as an initial diagnostic
tool to visualise the sensitivity of the individual input factors on the adaptation objectives
(Pianosi et al. 2016).
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Figure 3.5 Plot of impacts to (a) AAPE and AAD objectives and (b) average beach width and
AAD objectives, for the 1,000 cases. The upper bound of tolerable impacts to the objectives
(see Table 3.1) are defined by red dashed lines. The percentage of cases in each quadrant
of the plot is also shown (denoted Q1-Q4).

3.4.6 Describe conditions that lead to adaptation tipping points
Scenario discovery validated observations made from the scatter plots that rainfall
intensity and maximum structural damage costs were the most important uncertainties
in defining the candidate scenario for the AAD adaptation objective. The significance of
these variables was confirmed by the reproducibility statistics and p-values at the 0.05
level. Coverage and density trade-offs were further investigated for a range of candidate
scenarios (see Appendix B.5 for further details). The strongest candidate scenarios for
the three adaptation objectives are summarised in Table 3.3. These candidate scenarios
describe the conditions beyond which coastal inundation impacts related to the
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adaptation objectives are unacceptable (i.e. signify adaptation tipping points are
reached).

Table 3.3 Scenario discovery results showing candidate scenarios for which impacts related
to the adaptation objectives are acceptable.
Candidate scenario
Adaptation
objective

Conditions (factor and values) a.

Cases of
interest

Coverage /
Density

1: AAPE

9 hour rainfall intensity < 4.8 %,

194 / 1000

73 % / 88 %

167 / 1000

75 % / 76 %

320 / 1000

70 % / 97 %

and
Average people per house < 2.4
2: AAD

9 hour rainfall intensity < 6.3 %
and
Maximum structural damage <
$1,536/m2

3: Beach
width

Sea level rise < 0.3 m
and
Bruun factor < 83

a. Rainfall intensities are relative to the present and sea level rise is relative to 2010
levels.

Key factors in the selected candidate scenarios are shown in Table 3.4, along with
projected trends and associated timeframes. The timing is not intended to be exact.
Rather it focuses on identifying an indicative time period at which conditions describing
adaptation tipping points could be reached, thereby indicating a use-by year (Haasnoot
et al. 2013). For the environmental factors, projections for lower (RCP4.5) and higher
(RCP8.5) emissions scenarios are useful to understand timeframes for a range of
potential changes (Bates et al. 2016). Time-series were available for projected mean sea
level rise in coastal council areas (McInnes et al. 2016a), providing an indication of when
the conditions associated with this uncertain factor might be exceeded. Additionally,
guidance was sought from the Australian Rainfall and Runoff guide for projecting
changes to rainfall intensity. This relates future rainfall intensity changes to temperature
change using a scaling estimate of 5 % per °C of warming, based on the ClausiusClapeyron vapour pressure relationship (Bates et al. 2016). However, uncertainty
remains with this approach, with research suggesting that extreme rainfall intensities
could increase by more than 15 % per °C in Tasmania by the end of the century
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(Mantegna et al. 2017). Projected temperature change was obtained from the Climate
Change in Australia web portal (CSIRO & Bureau of Meteorology 2015), which guided
the indicative timeframes for changes to rainfall intensity based on the relationship used
by Bates et al. (2016).
The projections suggest that changing rainfall intensity is likely to cause unacceptable
impacts to AAPE between the years 2040-2060, if the average people per house
exceeds 2.4. The impacts to AAD are projected to remain acceptable for a longer
timeframe, until years 2050-2070, if the maximum replacement cost of dwellings exceeds
$1,536/m2 in real dollars. The impacts to average beach width may become
unacceptable between the years 2060-2070, which is conditional on the Bruun factor
exceeding 83 (a conservative value for the study area). Ongoing monitoring of each key
factor at local, regional and national scales is necessary to confirm the adequacy of the
presently projected trends and to update the projected time periods at which adaptation
tipping points may be reached.
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2040 (RCP4.5) – 2060 (RCP8.5)
2050 (RCP4.5) – 2070 (RCP8.5)

4.8 %

6.3 %

Changing 9 hour rainfall
intensity (relative to present)

Australian Bureau of
Statistics (2010)

-

Minimal change c.

$1,536/m2

2.4

Max. structural damage per
m2 (real dollars in 2016)

Average people per house

9

9

(1)
AAPE

9

9

(2)
AAD

9

9

(3)
Beach
width

Adaptation objective

a. No data is available on the Bruun factor for Kingston Beach. Estimates from nearby areas are lower than the value shown.
b. No projections available. Periodic updates to the structural value are necessary (e.g. NEXIS building exposure database; Dunford, Power &
Cook 2014), which are then adjusted from nominal to real dollars using the ‘average weekly earnings’ figures (Department of Environment and
Climate Change 2007) that are tracked by the Australian Bureau of Statistics (e.g. Australian Bureau of Statistics 2017).
c. The average household size is estimated to fall to between 2.2-2.3 by 2031 in Tasmania (Australian Bureau of Statistics 2010).

Dunford, Power and Cook
(2014) b.

-

83

Nil a.

Bates et al. (2016); CSRIO &
Bureau of Meteorology (2015)

McInnes et al. (2016a)

Scientific basis

Bruun factor

2060 (RCP4.5) – 2070 (RCP8.5)

0.3 m

Sea level rise increase
(relative to 2010 levels)

Indicative timeframe

Value

Projected change

Factor

Condition

Table 3.4 Projected timeframe for changing factors. The selected factors are those identified in the candidate scenarios.
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3.4.7 Develop the adaptation pathway
The key conditions that lead to adaptation tipping points and time projections identified
in Section 3.4.6 can be brought together within a DAPP framework to begin developing
an adaptation pathway. The steps in the DAPP framework require identifying possible
adaptation responses, evaluating the responses, assembling the pathways, identifying
preferred pathways, contingency planning, and creating a dynamic adaptive plan
(Haasnoot et al. 2013). The key factors identified through scenario discovery can also
support the definition of technical signposts in the DAPP process. The first part of the
adaptation pathways mapping process for the study area is shown in Figure 3.6, which
indicates when an adaptation response would be needed to manage the different
adaptation objectives in the case where no adaptation measures are taken. Planning
and implementation timeframes for each adaptation response needs to consider the lead
time as the option progresses through project/policy governance systems. Each
subsequent adaptation option identified in the pathway can be assessed for robustness
by repeating the steps in Section 3.3.2 through to Section 3.3.6, or evaluated using other
decision support tools (e.g. Dittrich, Wreford & Moran 2016). Furthermore, some options
may impact on multiple adaptation objectives (e.g. a levee could provide benefits to both
the AAD and AAPE objectives). Therefore the evaluation of the costs and benefits of
each adaptation option would need to consider the implications to multiple objectives.
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Figure 3.6 Development of the adaptation pathway using adaptation tipping points and the
projected timeframe of change. Conditions that lead to adaptation tipping points are shown
for the ‘Do nothing’ option. Timeframes are indicative and require ongoing monitoring and
reassessment as part of iterative risk management.

3.5 Discussion
3.5.1 Greater insights for coastal flood risk management
The ability to simulate coastal flood impacts across many future scenarios better equips
decision-makers to address questions such as ‘what change leads to unacceptable
impacts?’ and ‘when are adaptation responses needed?’. The case study illustrates that
open source spatial data and programming, combined with commercial GIS software,
can be used to address these questions by uncovering key risk management
considerations in communities that face uncertain long-term change. There is an
opportunity for local government and other coastal authorities to replicate the illustrated
method whilst customising it for their local needs.
The use of scenario discovery to identify conditions whereby existing plans no longer
meet the adaptation objectives can simplify complex changes to the built and natural
environment in a meaningful format for stakeholders to understand. As demonstrated in
the case study, RDM offers the potential to explore the interaction between a broad set
of uncertain hazard, exposure, and vulnerability factors and how they influence coastal
inundation impacts. This recognises that societal development, building codes, and other
land use policies can exacerbate flood impacts in low-lying communities, especially when
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coupled with changing flood patterns. This approach is an improvement on seminal
adaptation pathway methods that focus on changes to a single hazard parameter
(Kwadijk et al. 2010; Reeder & Ranger 2011). However, using multiple uncertain factors
to describe conditions leading to adaptation tipping points adds further complexity to the
risk monitoring process. Each variable may change in different directions and with
varying rates. Therefore a vulnerability assessment to coastal inundation, including
periodic monitoring, needs to be done routinely as part of the managing authorities’
iterative risk management process.
The key factors uncovered with scenario discovery can support the selection of signposts
that are identified in the later stages of the DAPP process. They can also allow causal
factors to be further explored to better understand leading indicators that signify changing
risk (Bonzanigo & Kalra 2014). For example, population growth and housing density is
driven by land use and development decisions, which influences the average number of
people per dwelling exposed and therefore achievement of the AAPE objective.
Techniques like root cause analysis, systems thinking, or hazard chains (Downing 2012)
can be undertaken at this stage of the assessment to identify (and treat) causal risk
factors that are interconnected but less apparent. These insights can build a case for
targeted data collection and monitoring activities in urbanised coastal areas, which is
important when financial resources are limited. In further developing adaptation
pathways, technical signposts such as those noted above would need to be considered
alongside political signposts to be inclusive of different stakeholder needs (Hermans et
al. 2017).
The methodology illustrated in the case study takes a subtly different approach to
traditional risk management methods, such as the ISO31000 process that is recognised
worldwide. Our methodology requires tolerable risks to be defined at the outset and
baseline impacts to be assessed, before the sensitivities of the site to coastal inundation
are uncovered. Conversely, the ISO31000 process begins with a risk assessment, then
prioritises risks based on likelihood and consequence matrices before evaluating
whether risks are acceptable, tolerable, or intolerable. Identification of a baseline risk
acknowledges that there is already a certain coastal inundation threat that the community
has accepted, knowingly or not. This allows analysts to focus their efforts on searching
for what changes to the current built and natural environment will cause unacceptable
inundation impacts. This makes the process of communicating risks more straightforward
and salient to concerned parties, since they can consider how environmental change
might affect them relative to what they are experiencing today. An important strength of
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the ISO31000 process over our method is that it considers a much broader set of impacts.
For example the National Emergency Risk Assessment Guidelines used in Australian
emergency management considers consequences to people, environment, economy,
public

administration,

social

setting

and

infrastructure

(National

Emergency

Management Committee 2010). Our approach was limited to a quantitative assessment
of impacts to people, property, and lifestyle objectives. Therefore there is scope for the
presented method to increase the number of adaptation objectives and include a
qualitative assessment of intangible consequences.

3.5.2 Making change salient in the community
A characteristic of the key factors identified by scenario discovery in the case study was
that they change slowly over time. However, detecting such environmental changes can
be problematic due to natural variability, sparse data records, and non-stationarity (Milly
et al. 2008). Detecting a modest 4-7 % increase to 9 hour rainfall intensity – as identified
in our case study – is difficult in practice, and a coastal authority asserting that such
change has occurred is likely to be challenged by residents with different views.
Translating changes to key variables into observable impacts can provide an evidencebased approach to substantiate claims within the community that they may be
approaching a threshold or adaptation tipping point. For example, a 4.8 % increase in
rainfall intensity in the study area suggests that inundation of the Windsor Street /
Balmoral Road intersection may occur once every 7 years, instead of 9 years (Figure
3.7). Consequently, flooding of this intersection twice in a 7 year timeframe could signal
that the rainfall intensity is approaching its adaptation tipping point limit. Although this
does not account for changing catchment characteristics (e.g. upstream development)
and changing extreme rainfall frequencies that can affect the recurrence interval of peak
floodwaters, it does serve to convert an otherwise meaningless number into
demonstrable evidence that change may be occurring.
A similar philosophy was used by Barnett et al. (2014c) in their case study at Lakes
Entrance, whereby an adaptation response was planned in the event that the esplanade
flooded for 5 or more days in a year. Importantly, observed changes to rainfall intensity
and/or flood frequency at a local scale requires robust assessment against expected
variability. In this regard, local agencies require input from national agencies (e.g. CSIRO,
Bureau of Meteorology and Geosciences Australia) who are concerned with the scientific
assessment of changes across various spatial and temporal scales. This ensures
decisions are based on robust scientific understanding of changes that are occurring,
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reducing the chance of reactive decisions being made by coastal authorities in the face
of chance events or natural variability.

Figure 3.7 Selected location at the intersection of Windsor Street and Balmoral Road (circled
– left panel) that could be used to observe changing coastal flood risk. The average change
to peak flood water elevations (above AHD) for a 20 % AEP flood event with increased rainfall
intensity of 4.8 % is shown in the right panel.

The case study presented here made an important assumption that measurable
adaptation objectives and tolerable impacts could be defined and agreed upon in the
community. The study was also limited to a small subset of the possible values that may
exist in the community. In practice, public collective decision-making processes are likely
to face contested adaptation goals and conflicting knowledge among stakeholders
(Bosomworth et al. 2017), whilst social power inequalities and varying short-term
interests can hamper long-term planning efforts (Few, Brown & Tompkins 2007).
Although there are increasing calls for social impacts to be better accounted for in climate
change impact assessments and to evaluate adaptation responses (Adger et al. 2009;
Downing 2012), such considerations are not straightforward due to complex and
subjective interactions among values, ethics, priorities, culture, knowledge, and power
structures, all of which change with time (Adger et al. 2009). Engagement with
community stakeholders may be a useful starting point to identify contested values in the
scoping phase of adaptation planning and to define key issues (e.g. Barnett et al. 2014c).
This can then form a basis for identifying the adaptation objectives, metrics and tolerable
impacts upon which subsequent analysis is based. The use of decision relevant
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information produced by activities such as scenario discovery can better inform
participants at various stages of the planning process and can also strengthen the
credibility of the resultant strategy. Although deliberation with analysis is increasingly
being recognised in complex environmental policy problems (National Research Council
2009), further research is needed to explore how this can be most effectively utilised in
a combined RDM and DAPP approach.

3.5.3 The prospects and limitations: Towards better informed planning
The case study highlights that there is a need to improve the accuracy of simulation
modelling, in particular the generation of rules of thumb and proxy floodwater rasters.
Simplifications in the model meant parameters such as flood duration, contamination,
debris, rate of rise, and flood velocity were omitted, which can cause overall damage
estimates to be underestimated (Merz et al. 2010; Middelmann-Fernandes 2010).
Similarly, the use of the Bruun rule is likely to be overly simplistic given (among other
things) it does not consider coastal storms that can exacerbate beach erosion nor other
coastal processes that may affect the shoreline response. Notwithstanding these
limitations, changing beach widths can be easily monitored by coastal authorities,
community groups, or residents to confirm trends in the face of uncertainty (e.g.
ACECRC n.d.; UNESCO 2005), and the beach management authority could develop
contingency plans to address unexpected near-term beach loss.
The timing at which adaptation tipping points were projected in this study was relatively
simple by focussing on a small set of projected changes to key variables. The use of
transient scenarios to identify a range of use-by years (e.g. Haasnoot et al. 2015) is a
potential improvement to the methodology presented in Section 3.4.6, as it would allow
different rates of change (positive and negative) for the key conditions describing
adaptation tipping points to be combined across many cases. This could better inform
the timing of adaptation tipping points to support the development of long-term master
plans and future resource requirements.
Implementation of the presented methodology requires data availability, technical
capability, and financial resources to perform the analysis, collect data, and monitor
change over time. Given that technical knowledge and financial constraints are likely to
remain a barrier for local government in the near-term, such resources could be
centralised in a nationally coordinated authority. This authority could work with local
government to apply a nationally consistent approach to describe conditions leading to
adaptation tipping points and develop adaptation pathways. The presented method could
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also be applied at a municipal, state or national scale to identify coastal settlements that
are most vulnerable to changing coastal flood hazards, using the timing at which their
adaptation tipping points would be exceeded as an indicator. For resource-constrained
authorities, the ability to prioritise adaptation investment towards those communities that
yield the greatest risk mitigation benefits would improve the allocation of scarce financial
resources.
It is too early to fully understand the effectiveness of the illustrated methodology in this
study given that it reflects ex ante planning, yet such conditions are faced in all risk
identification activities. What the methodology offers is a new way of integrating two
state-of-the-art decision support tools so that decision-makers can explore and identify
future vulnerabilities to coastal inundation and design adaptation pathways.

3.6 Conclusions
This research has examined whether RDM can be embedded within a DAPP framework
to improve planning for changing coastal flooding risks. Our method was underpinned
by GIS software, open source data, and programming languages, making it pragmatic
and possible to replicate in other coastal communities.
The use of RDM to uncover sensitivities in the existing system to changing coastal flood
patterns focuses the attention of decision-makers towards those uncertainties that are
most relevant for achieving their adaptation objectives. This is useful not only for
understanding what change leads to intolerable risk and when such change might occur,
but considers more broadly how societal development, land use, and existing building
regulations might exacerbate impacts from changing coastal flood patterns.
A better understanding of the key conditions that lead to adaptation tipping points in flood
risk management can support targeted data collection, monitoring activities, and
adaptation responses. It can also help identify signposts in the adaptation pathway.
However, detecting changes in multiple factors can be difficult given natural variability,
and challenges are enhanced by sparse long-term data records and little financial
resources allocated to coastal monitoring activities. Furthermore, reaching agreement
on the adaptation objectives, a clear definition of what the community deems as tolerable
impacts and exploring how deliberation with analysis is most effectively used in a
combined RDM and DAPP approach remains a question for further research.
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The use of scenario discovery to describe conditions leading to adaptation tipping points
offers an alternative conceptualisation for the DAPP approach, which uses transient
scenarios to focus on the timeframe at which an adaptation tipping point is reached. In a
combined RDM and DAPP approach, transient scenarios could be used after scenario
discovery to project the timing of adaptation tipping points based upon changes to a
reduced set of key factors. This sequence of steps would improve the description of
adaptation tipping points and the basis for projecting the use-by year of existing and
future adaptation policies.
Our study illustrates that RDM can be a powerful method to uncover a small set of
conditions that together can characterise adaptation tipping points in the face of
uncertain environmental change and the simulation results are well suited for use within
a DAPP framework. Notwithstanding the challenges that remain around simulation
modelling and detection of environmental change, the ability to make sense of complex
environmental dynamics for use in vulnerability assessments and adaptation planning
can provide much needed support to coastal authorities who are facing increasing
pressure to minimise costly impacts and ensure the sustainability of their communities.

3.7 Thesis context
Combining the strengths of RDM and DAPP is novel in coastal flood risk management.
The inclusion of scenario discovery provides multi-dimensional descriptions of physical
adaptation tipping points which can be used in adaptation pathways planning. This
directs the attention of decision-makers towards a small set of key uncertainties that
contribute most to unacceptable flood risk and can inform the design of technical
signpost indicators to monitor change. GIS software and open source programming tools
enables the combined RDM and DAPP approach to be customised for location-specific
needs and constraints. The next chapter considers how values-based approaches might
support more socially-oriented outcomes in adaptation planning.
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Chapter 4 Advancing values-based
approaches to climate change
adaptation: A case study from Australia
This chapter has been published as Ramm, TD, Graham, S, White, CJ & Watson, CS
2017, 'Advancing values-based approaches to climate change adaptation: a case study
from Australia', Environmental Science & Policy, vol. 76, pp. 113-123. Minor changes
have been made to the original published article for consistency in this thesis. This
includes general terminology and presentation of Figure 4.2.

4.1 Abstract
Coastal flooding affects physical and social place attachments. Values-based
approaches to climate change adaptation examine how risks to place attachments are
distributed within and among communities, with a view to informing equitable adaptation
policies. In this nascent body of research, divergent theoretical frameworks and empirical
approaches to measuring social values are evolving. While some studies explore the
things people value about their everyday lives generally—the lived values approach,
others locate specific social and cultural values in geographic space—the landscape
values mapping approach. This study aims to compare the explanatory value of these
two approaches for understanding the social risks of sea level rise and appraise whether
either or both approaches are likely to meet local adaptation planning needs. It does this
by examining the potential social impacts of sea level rise in Kingston Beach, Australia,
informed by a mail-out survey of the community. The lived values approach identified
that the natural environment, scenery, relaxed lifestyle and safety are highly important to
local residents, while the landscape values mapping approach revealed that Kingston
Main Beach is the most highly valued of eight coastal landscape units. Incorporating the
landscape values mapping into the lived values cluster analysis revealed that while
Kingston Main Beach is highly important for its recreational value to some members of
the community, for others manmade features such as community halls or sports ovals
may be of higher importance because they facilitate social interactions. There is potential
to further integrate these two approaches to better inform adaptation policy about how
lived and landscape values are distributed among communities, where they are located
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in space and whether they change over time. A deeper understanding of such assigned
values can lead to improved engagement with coastal residents to inform adaptation
policy now and into the future.
Keywords: coastal inundation, local communities, place values, policy, public
participation GIS, vulnerability

4.2 Introduction
Planning for sea level rise is well underway at local, regional and national scales
worldwide, yet planning focuses on ameliorating the physical rather than social impacts
of sea level rise (Karlsson, van Oort & Romstad 2015; O'Brien & Wolf 2010). For example,
government adaptation plans typically focus on the need to protect communities,
accommodate sea level rise, or retreat manmade infrastructure, and many local
government adaptation policies in Australia require new developments be built above a
specified future sea level (e.g. McInnes et al. 2016a). Beyond infrastructure, there is an
emphasis on understanding and minimising impacts on the natural environment, such
as ensuring that biodiversity and ecosystem resilience are maintained (Baker et al. 2012).
A notable absence from many plans is consideration of how to reduce the impacts of sea
level rise and coastal flooding on non-material social values (Adger et al. 2012; Adger et
al. 2009).
To address this gap, non-material ‘values-based’ approaches to climate adaptation have
been developed to explore what people value most about their everyday lives, and how
these social values are likely to be affected by environmental changes and the policies
developed to respond to such changes (Persson, Sahlin & Wallin 2015). Values-based
approaches seek to redress the emphasis of adaptation planning on physical impacts by
putting the lifestyle and well-being attributes that matter most to communities at the
centre of adaptation analyses (O'Brien & Wolf 2010). While values-based approaches
are receiving increased attention by scholars, it is unclear to what extent they are being
adopted by decision-makers. The aim of this study is to further evaluate the potential
utility of two values-based approaches for informing more socially-oriented adaptation
policies.
Early values-based studies on climate adaptation involved qualitative research into the
social and cultural values, or ‘held’ values (Brown 1984), that determine ‘how’ people
interpret and respond to environmental changes and adaptation policies (e.g. Kuruppu
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2009; Nielsen & Reenberg 2010; Wolf, Allice & Bell 2013). Kuruppu (2009) found that
religion potentially impedes climate adaptation in Kiribati because it shapes the goals
that individuals pursue. Nielsen and Reenberg (2010) identified that cultural values of
the Fulbe ethnic group of Burkina Faso prevent them from embracing particular
adaptation strategies. Wolf, Allice and Bell (2013) showed how diverse values within two
Canadian communities may act as barriers to adaptation. While such studies are useful
for understanding constraints to climate adaptation, they offer few practical suggestions
for how decision-makers can “address values explicitly” (Wolf, Allice & Bell 2013: p.560).
Graham et al. (2014) argues that values-based approaches to adaptation can explicitly
address values by focusing on ‘what’ people value about their everyday lives, i.e.
‘assigned’ values (Brown 1984). They proposed that values-based approaches should
investigate the diversity of ‘lived values’—“valuations that individuals make… about what
is important in their lives and the places they live” (Graham et al. 2013: 49, emphasis
added)—that exist within communities and how these lived values are impacted by
environmental change. This is consistent with Brown (1984), who argued that values
assigned to objects—physical things, persons, emotions, and forms of physical activity—
need to inform public resource allocation decisions. In collaboration with two local
governments, they developed a quantitative method for measuring lived values and
evaluating differences that exist within (Graham et al. 2014) and across (Barnett et al.
2014a) communities. This method was published in ‘A Guide for Local Government’
(Barnett et al. 2014b) to facilitate uptake of the lived values approach by planners in
Australia and internationally.
There have been two applications of the lived values approach in Australia that focus on
the impacts of sea level rise and distributional effects of adaptation planning within
communities (Graham et al. 2014; Kreller 2016). These studies concluded that the lived
values approach is useful in shifting the focus of adaptation towards non-material values
and enables policies to be tailored to meet the needs of diverse segments of the
population. Although the values elicited through the lived values approach can direct
policy-makers towards the general impacts from sea level rise and groups of people at
risk, there is scope to provide further definition on what individual’s value about the
coastal landscape and natural environment.
A third values-based approach to climate adaptation focuses on the social and cultural
landscape values that people assign to particular physical places, i.e. the ‘where’. The
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landscape values mapping approach3 was originally developed to associate assigned
social values with landscapes and include local or marginalised populations in natural
resource planning and decision processes. For example, in NSW, Australia the method
has been used to include indigenous attachments to landscape in the management of
National Parks (Brown 2008).
More recently, Novaczek et al. (2011) sought to adapt the landscape values mapping
approach to a climate adaptation context. They explicitly sought to evaluate whether
landscape values mapping can be used as a decision-support tool for climate adaptation,
working closely with a provincial Canadian government department to create maps of
the study area and adapted the typology of values (following Brown 2004) to be more
specific to coastal environments and activities. They concluded that landscape values
mapping was a useful tool for enabling coastal communities to explore and recognise
their assigned values and raise awareness of the non-material losses that are likely to
occur in a changing climate. They also argued that the approach is useful for policymakers because it is affordable, inclusive and collaborative and enables decisions to be
made that consider diverse values and priorities. There is considerable scope for this
approach to be applied elsewhere, yet we know of no applications of this approach to
sea level rise adaptation in Australia nor how it may compare with the lived values
approach.
This chapter evaluates the usefulness of the lived values and landscape values mapping
approaches for identifying the preferences attached to diverse assigned values relevant
to climate adaptation planning. A case study in the coastal suburb of Kingston Beach in
Tasmania, Australia, is used to elucidate the lived and landscape values that exist within
the community and to understand risks from sea level rise. Section 4.3 introduces the
case study, the methodology is outlined in section 4.4 and results presented in section
4.5. The discussion in section 4.6 compares the utility of both approaches for measuring
and comparing assigned values and outlines more broadly how policy-makers can utilise
both methods in coastal adaptation planning. Conclusions are drawn in section 4.7.

There are a range of terms used in the literature to describe the process of mapping social and
cultural values. These include ‘participatory mapping’ (Plieninger et al. 2013), ‘mapping social
values’ (Tyrväinen, Mäkinen & Schipperijn 2007) and ‘landscape values methodology’ (Raymond
& Brown 2011). Here we use the term landscape values mapping (Brown 2006) to encapsulate
these overlapping methods and indicate that we are interested in the values assigned to
landscape features.
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4.3 Case study: Kingston Beach
The suburb of Kingston Beach is located in southern Tasmania, Australia and is 13 km
from Hobart, Tasmania’s capital city (Figure 4.1). It has approximately 2,000 residents
with one-quarter of the 965 dwellings situated less than 3 m above mean sea level. The
local municipality, Kingborough Council, has undertaken traditional coastal risk
assessments to inform its adaptation planning (e.g. Climate Planning 2016), however to
date little work has been undertaken to understand the social values at risk.
The case study site is a useful location to examine values-based impact assessments
as the suburb is predominantly residential, with iconic landscapes (e.g. beaches) and
low-lying infrastructure. The study area is faced with a unique flood risk that could
threaten social values because of the interaction between Browns River (Photo C, Figure
4.1) and the Derwent Estuary (Photo F, Figure 4.1). Historically, there have been riverine
floods from Browns River that have caused damage to adjacent houses and
infrastructure (Climate Planning 2016). Anecdotal evidence suggests that storms
throughout the mid 1900’s caused waves from the Derwent Estuary to break over
Kingston Main Beach onto the esplanade, dragging boats from their moorings and
destroying jetty infrastructure (Gardam 1988, p.65).
A modest sea level rise in the order of 0.5 m by the end of the century (McInnes et al.
2016a) has the potential to change and/or inundate parts of Kingston Main Beach (Photo
E, Figure 4.1), including Tyndall Beach, which is reserved for dog exercise and referred
to as the ‘dog beach’ (Photo D, Figure 4.1). Both beaches have little ability to recede
landward with sea level rise; Kingston Main Beach is backed by an aging concrete sea
wall (Gardam 1988; p.66) and the dog beach is backed by rising hard bedrock (Sharples
& Donaldson 2014). Sea level rise would have other consequences to natural
landscapes in the area, potentially raising the local groundwater table, which could
impact flora and fauna in the saltmarsh (Photo B, Figure 4.1), saline grassland (Photo A,
Figure 4.1) and bordering forest (Gardam 1988; Knight 2016). Additionally, sea level rise
could lead to increased flooding impacts from Browns River, in particular through a
combined storm tide and riverine flooding event, damaging physical infrastructure. A
modelled 1 in 100-year coincident flood event with 1 m of sea level rise was estimated
to expose $217 million of assets (Climate Planning 2016).
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Figure 4.1 Geographic location of Kingston Beach (study area) with photographs of natural
low-lying coastal landscapes (i.e. landscape units). Contours at 10 m intervals highlight lowlying areas in the suburb near the beaches and Browns River.
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4.4 Methods
The lived values and landscape values mapping approaches primarily rely on surveys
(e.g. interviews, mail-outs or online) for data collection. Eight place-based observations
and ten semi-structured interviews were undertaken to finalise the survey questions prior
to distribution (as per Graham et al. 2014). Place-based observations were used to
provide insights about the use of coastal areas and enacted lived values. They involved
a series of site visits at different times to observe activities occurring in built and natural
coastal areas (see Appendix C.1 for a template of the place-based observations sheet).
Qualitative analysis of the place-based observations revealed lived and landscape
values enacted by residents and the semi-structured interviews captured lived and
landscape values voiced by residents. A summary of the method is shown in Figure 4.2.

Figure 4.2 Overview of the data collection and analysis method.

4.4.1 Survey of the suburb
4.4.1.1

Survey design

The survey contained the following sections: 1) connection to the area; 2) household
characteristics; 3) lived values and frustrations; 4) everyday activities; 5) social networks;
and 6) landscape values mapping (see Appendix C.5 for full survey). The questions in
sections 1 to 5 were developed from Barnett et al. (2014b) and adapted to the context of
this study location. Given that the landscape values mapping section required
72

participants to interact with a spatial map of the region, a hardcopy (mail-out) survey and
online options were made available in this study.
The 16 lived values most frequently mentioned in the semi-structured interviews
(Appendix C.3) were included in the mail-out survey, ensuring that lived values from each
of the five categories identified in Graham et al. (2013) were included. Given young
families were under represented in the semi-structured interviews, ‘a unique place for
children to grow up’ was added as a lived value. The lived values were presented in the
survey as a predefined list from which participants could state the importance of those
values. Open-ended questions were included to capture additional lived values and other
closed questions captured the frequency with which participants enacted their lived
values through daily activities and social interactions.
The landscape values mapping section in the survey was guided by Brown (2006),
Tyrväinen, Mäkinen and Schipperijn (2007) and Plieninger et al. (2013). A shortlisted
typology of nine social values was identified through the semi-structured interviews
(Appendix C.4). An aerial map of the study area was provided with the survey showing
photographs of eight predefined coastal areas (landscape units). Respondents were
asked to rank up to three of the coastal landscapes in order of importance for each of
the nine values. This forced respondents to prioritise landscapes.

4.4.1.2

Survey response

During October 2016, 961 surveys were hand-delivered to dwellings in the suburb.
Follow-up postcards (recommended by Dillman 2007) were hand delivered 10 days after
the survey. It was specified that surveys were to be completed by the householder.
In total, 322 survey responses were received (284 hard copy; 38 online) which
represented a 34 % response rate. The response rate was comparable to other valuesbased surveys (e.g. 47 % in Brown (2006); 28 % in Graham et al. (2014); 29 % in
Novaczek et al. (2011)). The socio-economic characteristics of the sample was
consistent with the census data for gender, household composition and median income,
however differed in terms of employment and educational attributes (Table 4.1).
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Table 4.1 Socio-economic characteristics for the survey sample, compared to the suburb,
State and nation.
Characteristic

Australia
(2011)

Tasmania
(2011)

Suburb of
Kingston Beach
(2011)
965
53
53:47
2.3
$1,097

Survey
(Nov 2016)

Private dwellings
9.1 million
232,380
322
a.
Median age
45
50
55-64
Female:male ratio a.
51:49
52:48
59:41
Average people/house
2.6
2.4
2.3
Median weekly
$1,234
$948
$1000-$1999
household income
Full time employment
58 %
54.5 %
55 %
25 %
University of higher
14.3 %
11.8 %
17.7 %
58 %
a. Median ages and gender ratios have been calculated for the adult (18 years and
older) population of Australia, Tasmania and the suburb of Kingston Beach to directly
compare with survey respondents.

4.4.2 Analysis methods
4.4.2.1

Lived values analysis

Identification of lived values from the survey involved collating responses from openended questions (Question 5 and 7, see survey in Appendix C.5) and those rated in
terms of importance from a predefined list (Question 6 in the survey). Coding the lived
values from open-ended responses was guided by the typology of values in Graham et
al. (2013).

4.4.2.2

Landscape values analysis

To assess the significance of association between values and landscapes, a chi-squared
test for independence was used. The level of significance in the association was
observed using standardised residuals as done in Strickland-Munro et al. (2016).

4.4.2.3

Lived and landscape values cluster analysis

Following the method used by Graham et al. (2014), cluster analysis was used to
segment the community into groups based upon life characteristics. The variables
selected for inclusion were: gender, employment status, community group membership,
social network and previous location of residence. All variables were categorical and
were standardised prior to analysis. Correlations were run to ensure that there were no
redundant variables. The correlation coefficient for all variables was below 0.62. The
study used hierarchical followed by k-means clustering with pairwise deletion of variables.
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Once the final cluster solution was found, chi-square tests of independence (p < 0.05)
were used to evaluate whether there were significant differences between the groups
with respect to their lived and landscape values. This provided one mechanism for
comparing the explanatory value of the lived and landscape values mapping approaches.

4.5 Results
4.5.1 Community lived values
Respondents identified 45 distinct values that were important to them about living in the
suburb of Kingston Beach (Appendix C.7). The top ten lived values mentioned in
response to open-ended questions and rated as being very important from a
predetermined list in the survey are shown in Table 4.2 (total number of survey
responses was 322).

Table 4.2 List of the top 10 lived values considered most important from open-ended survey
questions compared to those rated as ‘very important’ from the predefined list in the survey.
An asterisk indicates values in both lists.
Rank
1
2
3
4
5
6
7
8
9
10

Lived value
(open-ended)
The beach
Easy to get places*
Scenery and views*
Natural environment
Relaxed (beach)
lifestyle*
Friendly people /
community feel*
Location (close to
water)*
Ambience /
atmosphere*
Peacefulness *
Recreation
opportunities

Number of
respondents
118
112
83
46
45
37
33
32
31
30

Lived value
(predetermined list)
Scenery and views*
A safe place to live
Relaxed lifestyle*
Peacefulness*
Natural environment*
Location (close to
water)*
Easy access to the
beach
Ambience /
atmosphere*
Friendly people /
community feel*
Easy to get places*

Number of
respondents
248
230
230
228
222
220
214
207
156
144

Recreational activities that respondents most frequently undertook each day in the area
were walking (n = 182), accessing the beach (n = 105) and dog walking (n = 80). The
emphasis on the beach, scenery and environment in these articulated and enacted
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valuations demonstrate the importance of natural landscapes to the everyday lives of
residents. Temporal (relaxed and convenience) and safety aspects were also important.

4.5.2 Values mapped to coastal landscapes
A summary of values and their association to landscapes are provided in Table 4.3 (also
refer to Appendix C.8 for more details). A significant statistical correlation was observed
between the landscape units identified by respondents and the values that they
associated with the landscape (X2 = 846.15; d.f. = 56; p < 0.01; Table 4.3). This suggests
that coastal landscapes are valued for specific purposes by residents – for example the
saltmarsh is highly valued as having minimal intrusion on the natural environment (i.e.
natural value) and for the variety and abundance of flora and fauna (i.e. biodiversity
value), while the Derwent Estuary is highly valued for providing enjoyable scenery, sights,
sounds and smells (i.e. aesthetic value) and for enabling future generations to
experience healthy, productive and sustainable ecosystems (i.e. future value).
The open-ended survey responses (Table 4.2) and ranking (Table 4.3) suggest that
Kingston Main Beach is the most important coastal landscape of the eight considered,
though this landscape is part of a much broader natural environment that residents
valued in their everyday lives (i.e. lived values).
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Recreation

Identity

Historic

Future

Biodiversity

Aesthetic

Access

Value

Score
% of total
Residuals
Score
% of total
Residuals
Score
% of total
Residuals
Score
% of total
Residuals
Score
% of total
Residuals
Score
% of total
Residuals
Score
% of total
Residuals

2
1
-2.84
0
0
-3.41
24
9
3.86
17
6
1.78
10
4
0.06
0
0
-3.27
2
1
-2.78

A
Saltmarsh
7
2
-1.22
6
2
-1.49
29
11
5.73
7
3
-1.06
12
5
0.91
5
2
-1.60
14
5
1.01

B
Grass / golf
course
7
2
-4.46
17
6
-2.66
72
27
7.45
34
13
0.61
66 a.
28
7.48
13
5
-3.05
23
8
-1.50

C
Browns
River
41
14
4.59
14
5
-1.36
3
1
-3.70
9
3
-2.32
3
1
-3.39
30
11
2.66
35
13
3.45

D
Dog
Beach
172
60
3.94
138
49
1.05
39
14
-7.45
110
41
-0.95
93
39
-1.32
187
72
6.54
167
60
3.91

E
Kingston
Beach

Coastal landscape unit

31
11
-1.35
63
22
3.83
44
16
1.08
66
24
4.71
20
8
-2.26
15
6
-3.50
24
9
-2.30

F
Sea /
Derwent
3
1
-2.44
15
5
1.19
11
4
0.13
2
1
-2.63
13
5
1.20
2
1
-2.56
4
1
-2.07

G
Rocky
shore

23
8
-1.64
30
11
-0.35
49
18
3.32
25
9
-0.99
22
9
-0.96
9
3
-3.77
8
3
-4.16

H
Boronia
Beach

277
100

261
100

239
100

270
100

271
100

283
100

286
100

Total

Table 4.3 Association of values with landscapes. Score refers to the number of times the shortlisted values were most strongly associated (rank = 1)
with each of the eight landscapes. Standardised residuals greater than +2.0 (bold) and -2.0 (underline) reflect significantly greater or fewer observed
frequencies respectively.
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Score
% of total
Residuals
Score
% of total
Residuals
Sum of
score

1
0
-3.08
44
16
9.85
100

A
Saltmarsh
7
3
-1.13
7
3
-1.07
94

B
Grass / golf
course
16
6
-2.75
28
10
-0.49
276

C
Browns
River
29
10
2.10
9
3
-2.34
173

D
Dog
Beach
126
45
0.22
54
20
-6.08
1086

E
Kingston
Beach
44
16
0.93
29
11
-1.37
336

F
Sea /
Derwent
16
6
1.58
29
11
5.67
95

G
Rocky
shore
38
14
1.20
71
26
7.30
275

H
Boronia
Beach

2435

271
100

277
100

Total

area.

due to factors such as past family connections to the landscape, or even historic use by indigenous people and early European settlers in the

a. Whilst further investigation would be needed to explore the reasons why residents associated historic value to Browns River, this could be

Natural

Therapeutic

Value

Coastal landscape unit

4.5.3 Lived and landscape values
Cluster analysis revealed that there are six clearly distinguishable groups of residents
who had unique sets of lived and landscape values. Table 4.4 presents variables
included in the cluster analysis and Table 4.5 shows the lived and landscape values that
were statistically significantly different across the clusters (p < 0.05). The descriptions
that follow of the six groups in Section 4.5.3.1 through to 4.5.3.6 are drawn from the
results presented in these two tables and are intended to provide a rounded description
of the people in each cluster.
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Table 4.4 Variables included in the cluster analysis and resulting cluster characteristics.
Unless otherwise stated, numbers represent the percentage of people in each cluster
characterised by each variable. The clusters with the highest (bold) and lowest (underline)
percentage of each variable are indicated.
Selected variables

Cluster 1:
Work-life
balancing
families

Cluster 2:
Physicallyactive, fulltime
workers

Cluster 3:
Teamsports
oriented
residents

Cluster 4:
Community
minded
retirees

Cluster 5:
Independent
retirees

Cluster 6:
Reclusive
retirees

48

59

43

76

46

50

Cluster (% of
respondents)

14.9

18.3

13.4

23.6

14.3

15.5

Children (%)

79.2

48.3

30.2

2.7

2.2

4.0

Female (%)

93.8

54.2

18.6

60.0

73.3

44.9

Full-time work (%)

2.1

98.3

48.8

0.0

2.2

0.0

Part-time work (%)

87.5

0.0

4.7

8.0

8.7

6.1

Retired or semiretired (%)

0.0

0.0

39.5

92.0

78.3

87.8

None or one close
friend (%)

45.8

57.6

33.3

24.3

36.4

42.0

Member of no
community
organisations (%)

33.3

59.3

0.0

0.0

0.0

100.0

Member of one
community
organisation (%)

27.1

0.0

100.0

0.0

100.0

0.0

Member of two or
more community
organisations (%)

39.6

40.7

0.0

100.0

0.0

0.0

Moved from Hobart
(%)

71.1

53.6

92.1

42.1

31.1

67.4

Moved from
Tasmania but not
Hobart (%)

17.8

21.4

5.3

25.0

26.7

21.7

Moved from outside
Tasmania (%)

11.1

25.0

2.6

32.9

42.2

10.9

N
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Interactions and
networks

Activities

Lived values

Demographics

Age (over 65)
Age (35-64)
Age (18-34)
Education (university qualification)
Home ownership (owned outright)
Household (one/two person)
Income (less than $1000/week)
Recreational opportunities (very important)
Safety (very important)
Unique for children (very important)
Flat landscape (very important)
Volunteer (daily or weekly)
Go for a jog (daily or weekly)
Go for a bike ride (daily or weekly)
Go to the gym (daily or weekly)
Visit to parks (daily or weekly)
Access the beach (daily or weekly)
Family (daily or weekly)
Friends (daily or weekly)
Neighbours (daily or weekly)
Community group members (daily or weekly)

Variables
Cluster 2:
Physicallyactive, fulltime workers

8.6
62.1
29.3
67.2
35.6
43.1
5.1
40.4
84.7
47.4
18.6
6.8
27.6
27.1
29.3
28.8
83.1
83.1
70.7
30.5
36.2

Cluster 1:
Work-life
balancing,
families

2.1
58.3
39.6
75
52.1
31.3
18.8
54.2
87.5
59.6
2.1
16.7
20.8
14.6
18.8
43.8
85.4
93.8
87.5
34
48.9

34.9
37.2
27.9
48.8
51.2
71.4
23.3
44.2
81.4
48.8
20
16.7
23.3
14
16.3
23.3
76.2
86
90.7
51.2
55.8

Cluster 3:
Team-sports
oriented
residents

83.6
15.1
1.4
64
91.9
95.9
45.9
32.4
67.6
24.7
28.6
39.2
1.3
9.3
17.1
16
74.7
71.6
92
54.7
79.2

Cluster 4:
Community
minded
retirees

62.2
31.1
6.7
52.3
82.2
97.8
40
35.6
64.4
33.3
22
18.2
0
4.5
9.1
20
67.4
69
83.7
45.2
56.8

Cluster 5:
Independent
retirees

74
24
2
42.9
77.6
94
40.8
15.2
50
20
20
6.4
4.2
14.6
4.2
10.6
60.4
72.9
59.6
36.7
13.3

Cluster 6:
Reclusive
retirees

Table 4.5 Variables that are statistically significantly different (p<0.05) across the clusters. Numbers represent the percentage of people in each cluster
characterised by each variable. The clusters with the highest (bold) and lowest (underline) percentage of each variable are indicated.
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Landscape
values

Kingston Main Beach – recreation (most important)
Kingston Main Beach – therapeutic (most
important)
Sea/Derwent – therapeutic (most important)
Browns River – historic (most important)

Variables
Cluster 2:
Physicallyactive, fulltime workers

73.2
55.4
10.7
16.1

Cluster 1:
Work-life
balancing,
families

48.9
40.4
14.9
27.7

7.1
9.5

57.1
54.4

Cluster 3:
Team-sports
oriented
residents

13.7
31.9

45.2
39.7

Cluster 4:
Community
minded
retirees

14.3
24.4

71.4
33.3

Cluster 5:
Independent
retirees

30.6
14.3

42.9
26.5

Cluster 6:
Reclusive
retirees

4.5.3.1

Cluster 1: Work-life balancing families

This group largely comprised highly-educated women with children who work part-time
and are members of least one community organisation. The importance of family and
providing a particular lifestyle for children is reflected in the diverse lived and landscape
values that members of this group ranked as being very important to them. This group
was the most likely to rate ‘recreational opportunities’, Kingston Beach being ‘a safe
place to live’ and ‘unique for children’ as being very important. They were also the most
likely to spend time with family, visit parks and the beach on at least a weekly basis.

4.5.3.2

Cluster 2: Physically-active, full-time workers

Almost all of the members of this group worked full-time and almost half had children.
Although this group had the highest incomes (94.9 % had incomes greater than $1,000
per week), only one-third owned their home outright. The importance of individual
physical activity to this group is reflected in their values. Members of this group were the
most likely to go to the gym, go for a bike ride or a jog on at least a weekly basis and the
most likely to rate the recreational and therapeutic value of Kingston Main Beach as
being most important. Almost all members of this group had moved to Kingston Beach
from Hobart.

4.5.3.3

Cluster 3: Team sport oriented resident

Most of the members of this group comprised men spanning a range of ages, with and
without children, including full-time workers and retirees. All group members are only
members of one community organisation, of which half are involved in sports and
recreational organisations (the most of all of the groups). Members of this group were
the second most likely to see their family, friends and neighbours on a daily or weekly
basis and rate recreational opportunities as being very important. This group was the
least likely to identify the therapeutic value of the sea and the historic value of the Browns
River as being very important to them.

4.5.3.4

Cluster 4: Community-minded retirees

Almost all members of this group are retired or semi-retired, highly active members of
the community. All members of the group belonged to at least two community
organisations and they were the most likely to be engaged in educational, religious,
cultural and local community action groups. The importance of being active in the
community is reflected in this group’s values. They were the most likely to volunteer at
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least weekly and the majority of the group spend time with other members of their
community groups at least weekly as well as their friends and neighbours. This group
was most likely to rank the historic value of Browns River as being most important to
them.

4.5.3.5

Cluster 5: Independent retirees

The majority of this group were retired or semi-retired. This group is considered to be
independent because it had the highest number of members who lived alone and were
the least likely to spend time with family. Members of this group were most likely to have
moved to Kingston Beach from other parts of Tasmania or beyond. All members only
belonged to one community organisation. While this group was not as active in the
community as the community-minded retirees, they were the second most likely to
volunteer and see community group members on at least a weekly basis. This group was
the least likely to engage in a range of physical activities, such as jogging, bike riding,
and going to the gym. However, they were the second most likely to rate the recreational
value of Kingston Beach as being very important to them.

4.5.3.6

Cluster 6: Reclusive retirees

This group mostly comprised retirees. This group is considered reclusive because they
were not involved in any community organisations and they were the least likely to
volunteer, spend time with members of community groups or see friends on a daily or
weekly basis. The landscape values of this group indicate that they do not value the
beach and they were least likely to rate the recreational or therapeutic value of Kingston
Main Beach as being most important. However, they were the most likely to value the
therapeutic value of the Derwent River. The group also did not place as much value on
recreational opportunities, Kingston Beach being a safe place to live and being unique
for children as the other groups.

4.6 Discussion
The natural environment and relaxed lifestyle are important lived values to Kingston
Beach residents, whilst the landscape values mapping reveals that the Kingston Main
Beach is of primary importance. The cluster analysis shows the lived and landscape
values that are more salient to particular groups within the community. It reveals that
community engagement and social interactions are highly valued by some members of
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the community, yet little is generally known about where such interactions take place.
The bias observed between the sample and the population (Table 4.1) means that the
results placed a stronger weighting on the views of residents that are not employed full
time and those who have attained university or higher education. However, this does not
influence the key conclusions of the analysis in comparing the explanatory value of lived
and landscape value approaches. The discussion that follows considers: 1) the extent to
which the lived and landscape values considered important in Kingston Beach are
consistent with past studies; 2) how integrating both values-based approaches may
overcome limitations of each method, but further work is required; and 3) the implications
of these results for future adaptation planning in comparable coastal communities that
are threatened by sea level rise.

4.6.1 Lived and landscape values in Kingston Beach
The lived values approach shows that residents of Kingston Beach place high
importance on the natural environment, lifestyle and scenery – reflecting the unique
combination of water bodies, cliffs, bushland and wildlife. Comparing the lived values of
Kingston Beach with other studies in Australia reveals a number of similarities. Four of
the five lived values rated as most important in Kingston Beach—scenery, natural
environment, relaxed lifestyle and feeling safe—were ranked most important in Lakes
Entrance, Victoria (Graham et al. 2014) and two of the values—scenery and natural
environment—were ranked most important in Botany Bay, New South Wales, with safety
ranked sixth (Kreller 2016). Thus, across south-eastern Australia coastal residents
consistently value the physical landscape, relaxed lifestyle and a perceived sense of
safety. However, there are also clear place-based differences, with access to services
being more important in regional coastal areas (Graham et al. 2014) and access to
transport and the city being more important in larger urban localities (Kreller 2016).
Understanding regional similarities and differences amongst lived values can be a useful
baseline for policy-makers to compare risks and learn about adaptation responses
across communities.
Landscape values mapping revealed that Kingston Main Beach is most strongly
associated with recreational use, being free of access restrictions and providing a sense
of identity. Adaptation responses that aim to preserve this significant landscape (and the
way associated values are experienced) for as long as practical with projected sea level
rise are likely to be a focus for policy-makers in adaptation planning. The landscape
values mapping also revealed that the sea was associated with aesthetic value,
suggesting a possible connection between this landscape and the ‘scenery’ lived value
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that was considered to be very important by survey respondents. Although the
importance of the coastline to recreation and aesthetics has been found in previous
empirical research, Novaczek et al. (2011) and Havas et al. (2016) found water itself to
be as important, if not more important, than the shoreline for recreation and aesthetic
values. This difference between Kingston Beach and other coastal landscapes
internationally may reflect place-based differences in the way residents interact with, and
thus value, their coastal environment. This reiterates that adaptation planning is different
across coastal communities and that adaptation policy tailored to each location is
necessary to avoid resistance from residents.
The cluster analysis helped to understand differences in lived and landscape values
across the Kingston Beach community. Of particular note is that for some residents, such
as the community-minded retirees and reclusive retirees, recreational opportunity was a
lived value of lesser importance, also reflected in the lower landscape value they
attributed to Kingston Main Beach (Table 4.5). For the community-minded retirees, social
interactions were important lived values and they also appreciated the historic value of
the Browns River. For reclusive retirees, there were few lived values of importance to
them, but they did attach therapeutic value to the sea. Thus, the cluster analysis showed
that it is important to not only identify the lived and landscape values that are rated as
most important across the whole community, but also those that are specific to particular
groups. As per Graham et al. (2014) and Kreller (2016), the lived values that differ most
across the community are those that relate to being physically active, family-focused,
engaged in community organisations and maintaining social interactions. The landscape
mapping approach also revealed that groups of residents assigned different values to
particular places. Rising sea levels and impacts to natural landscapes could change how
residents assign values to landscapes (Brown 1984). Policy-makers need to consider
what community groups will be disadvantaged by sea level rise and how benefits from
adaptation responses will be distributed among the community. Additional policies may
need to be considered to incentivise groups that receive little benefit from planned
adaptation responses to ensure the response is as fair as possible.
Overall, the survey results reveal that there is utility in asking residents to identify their
lived and landscape values. Together these two approaches provide a more
comprehensive picture of what residents’ value and how those values are enacted in
space. The cluster analysis showed the value of seeking to understand within-community
differences in lived and landscape values, i.e. that consideration of who is also important.
While the results are largely consistent with other coastal values-based research, the
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differences that exist reveal the importance of understanding local place attachments in
adaptation planning. Understanding differences in local place attachment is important as
this affects the perceptions and framing of climate risk within communities, which can
influence the scoping of risk management activities (Jones & Preston 2011). This shapes
what values are counted during impact assessments, what options are shortlisted to
manage projected impacts and how those options are evaluated (Ramm et al. 2017b).

4.6.2 Advancing the lived and landscape values mapping approaches
Both values-based approaches provide complementary information about the
overarching social values at risk from sea level rise. The lived values approach provides
broader information about the values people assigned to a place, whilst the landscape
values mapping provides tangible associations with specific places. Yet, there are likely
considerable benefits that could accrue from further integration of both approaches.
At a general level, the results of the landscape values mapping add detail to our
understanding of the lived values of Kingston Beach, particularly with respect to the way
in which the natural environment is valued. Graham et al. (2013) proposed that the
natural environment can be considered to represent human “health” value, yet the
landscape values mapping reveals that the natural environment is primarily valued for its
recreation, access and identity values, which Graham et al. (2013) classify as “belonging”
and “self-actualisation” values. While there may be some health and well-being benefits
of recreating on the beach or being close to the water, this is not what is explicitly valued
by residents and suggests that the lived values typology requires further theorisation.
Thus, at a minimum, the lived values approach could be more specific in seeking to
understand why particular lived values are important. This could be achieved by
exploring the relationship between held and assigned values, as well as considering the
context in which valuations occur (Brown 1984).
On the other hand, the lived values approach highlights missing values in the landscape
values mapping approach. One of the key lived values of Kingston Beach residents, as
well as residents in other Australian coastal communities, was feeling that it was a ‘safe
place to live’ yet none of the nine values included in the typology here, nor the longer list
of sixteen landscape values covered in other studies (Cole, Holland & Donohoe 2015)
consider safety as a social value. The other lived value that is often missing from
landscape values mapping approaches is ‘social interactions’. While lived values
pertaining to social interactions were not ranked highly by residents in Kingston Beach
in open or closed-questions, they were instrumental to understanding within-community
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differences in Kingston Beach and Lakes Entrance (Graham et al. 2014). Membership in
community groups as well as interacting with family, friends and neighbours were
defining features of clusters in both studies. Although ‘social interactions and memories’
were identified as important by Strickland-Munro et al. (2016) and included in their study
of the landscape value of coastal waters in the Kimberley, social interactions were not
explicitly included as a landscape value covered in other studies (Cole, Holland &
Donohoe 2015). While Strickland-Munro et al. (2016) acknowledge the importance of
family and friends, they do not explicitly consider the value of community groups. Thus
the landscape values mapping approach could be expanded to include social
interactions and concerns about safety to improve our understanding of how these social
values are located in geographic space and how they may be affected by climate change.
Beyond simply expanding the landscape values typology or being more specific in
identification of how particular physical landscape features are valued in the lived values
approach, we argue that there is potential to further integrate the two approaches to
maximise their utility. At present, the lived values approach begins through the use of
place-based observations and interviews to identify the most important place-specific
health, safety, belonging, esteem and self-actualisation lived values. There is no explicit
consideration in this phase of the approach on identifying important landscape features.
The results of this study indicate that it is not only natural landscape features that need
to be identified, but also man-made infrastructure that may be where important social
interactions take place, such as community halls, churches and sports fields. Thus the
first stage of an integrated approach would be to identify the most important lived values
for the whole community, groups within the community who are more family-focused,
physically active, socially active, and reclusive, as well as important natural landscapes
and man-made infrastructure.
The second phase of an integrated approach would involve a survey with a more specific
list of lived values and a more comprehensive list of ‘landscape’ values. The survey also
needs to go beyond targeting residents to include other people, such as tourists, who
value the area and further explore why places are valued, with a view to understanding
what environmental change might affect the way lived and landscape values are
assigned. The results of such a survey could help understand whether there is one site
that is considered most important to the whole community. The results could also be
analysed using a form of cluster analysis, like the one used here, to understand
differences in lived and landscape values within and beyond the community. This would
provide policy makers with a much more comprehensive understanding of what aspects
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of people’s everyday lives would be affected by climate change (as per Graham et al.
2014), why those values are important, where those values are located and who is most
at risk.

4.6.3 People and places at risk from sea level rise: Informing adaptation policy
To illustrate how lived and landscape values data might be used to identify what lifestyle
aspects could be impacted, where those values are located and who is most at risk, we
consider a sea level rise scenario of 0.5 m (comparable to a medium greenhouse gas
emissions scenario) in the study region that amongst other things has the potential to
inundate Kingston Main Beach. Overall impacts to the community would include loss of
scenic amenity, loss of natural environment and beach access for recreational amenity.
Across community groups the perceived impacts of sea level rise differ disproportionately
depending on lived and landscape values (Table 4.6). These perceptions are subject to
the respondent’s knowledge and framing of long-term environmental changes (Kreller
2016).

Table 4.6 Impact of sea level rise on the six clusters and perceived values at risk. Clusters
with a higher percentage of the variable impacted will be affected most (most affected cluster
= -6; least affected cluster = -1).

Lived
values

Activities

Landscape
values

Variables
impacted by
sea level
rise
Recreational
opportunities
Safe place to
live
Unique place
to raise
children
Jogging
opportunities
Access the
beach
Beach –
recreation
Beach –
therapeutic

Total

Cluster 1:
Work-life
balancing,
families

Cluster 2:
Physicallyactive, fulltime
workers

Cluster
3: Teamsports
oriented
residents

Cluster 4:
Community
minded
retirees

Cluster 5:
Independent
retirees

Cluster 6:
Reclusive
retirees

-6

-4

-5

-2

-3

-1

-6

-5

-4

-3

-2

-1

-6

-4

-5

-2

-3

-1

-4

-6

-5

-2

-1

-3

-6

-5

-4

-3

-2

-1

-3

-6

-4

-2

-5

-1

-4

-6

-5

-3

-2

-1

-35

-36

-32

-17

-18

-9

The illustration in Table 4.6 suggests that clusters made up of younger residents (e.g.
clusters 1 through to 3) may have higher impacts to their lived values from rising sea
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levels than retiree clusters. We believe that the comparison presented in Table 4.6
provides a reasonable starting point from which the council can begin incorporating
social impacts from sea level rise into adaptation planning. Yet given the potential to
further develop an integrated lived and landscape values approach, we would
recommend that further engagement occurs with the three groups of retirees to
understand if there are other lived and landscape values that may be at risk for these
groups and not identified through the survey (such as manmade infrastructure supporting
social interactions).
Understanding what people within the community value about their everyday lives and
landscapes can help policy-makers engage with residents on non-quantifiable coastal
risks, which are often not well accounted for by governments who use economic
measures of value as a primary mechanism to evaluate the impacts of climate change.
A better understanding of distributional impacts to lived and landscape values from sea
level rise can help overcome a disconnect between current government and social
valuations of climate risk, thereby steering policy-makers towards the design of fairer
adaptation policies.

4.7 Conclusions
The methodology applied in this chapter broadens the conceptualisation of coastal risk
beyond simply the physical impacts of inundation. The values-based impact assessment
aligns to the risk identification step in risk management practice (ISO 31000) and can
support deliberation with stakeholders on climate risks and sensitive adaptation
decisions (National Research Council 2009).
Assisted by a detailed case study of a small coastal suburb in Tasmania, Australia, we
find that the information provided in the lived values and landscape values mapping
approaches are complementary in supporting climate change risk assessment and
adaptation planning in coastal areas. While the lived values approach is able to elicit a
much larger set of assigned values relating broadly to the everyday lives of residents,
the landscape values mapping provided a greater level of precision on the type and
significance of assigned values associated with coastal areas. Both approaches offer the
potential to improve the way social risks from sea level rise can be understood for use in
adaptation planning. The high importance placed on values relating to natural
landscapes (e.g. scenery and natural environment), which is becoming increasingly
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apparent in other studies around Australia, makes a strong case for considering
landscape values mapping information in adaptation planning.
The integration of lived values and landscape values mapping can advance valuesbased approaches to climate change adaptation and highlight how groups of residents
may be impacted differently. Bringing these two approaches together means policymakers are equipped with information about what communities’ value in their everyday
coastal lives, where values are attributed to natural landscapes and man-made
infrastructure, and for whom sea level rise and other climate change impacts is likely to
cause the greatest disruption. Combined, this information can better inform community
risk assessments and adaptation responses in complex coastal environments.
Further scholarly research is needed to: 1) understand more about where social
interactions take place in geographic space and to clarify what makes many residents
associate feelings of safety with the suburb; 2) explore why places vulnerable to coastal
inundation are valued and what environmental change would cause key lived and
landscape values to be experienced differently; and 3) further understand a disconnect
between the way governments and residents value climate risk. Economic valuations are
usually a primary driver for government, however householders – who are invested in
the area through home ownership or rent – often consider not only economic issues but
other subjective values to be of significant importance to their way of life. This has
implications to adaptation policy as economic and social framings of climate risk can lead
to different conclusions about adaptation responses.

4.8 Thesis context
Consideration of non-measurable values-based information is often limited in coastal
adaptation planning. The novel combination and explanatory value of solicited lived and
landscape values was investigated to evaluate the utility for more socially-oriented
adaptation policies. This returned knowledge about what residents’ values, where values
are attributed to natural and built objects and to whom sea level rise causes the greatest
disruption. This framing shifts the emphasis of adaptation towards outcomes that are
more likely to cater for social and cultural needs. Additionally, fairer adaptation polices
can be designed by considering how values differ between groups of people in the
community. The next chapter explores how values-based information might be used as
part of a combined RDM and DAPP approach to plan adaptation pathways.
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Chapter 5 Strategic adaptation
pathway planning to manage sea level
rise and changing coastal flood risk
This chapter has been published as Ramm, TD, Watson, CS & White, CJ 2018, 'Strategic
adaptation pathway planning to manage sea-level rise and changing coastal flood risk',
Environmental Science & Policy, vol. 87, pp. 92-101. Minor changes have been made to
the original published article for consistency in this thesis. This includes minor changes
to Figure 5.3.

5.1 Abstract
Communities around the world are already committed to future sea level rise. Long-term
adaptation planning to manage associated coastal flood impacts is, however, challenged
by uncertainty and contested stakeholder priorities. This study provides a proof of
concept for a combined robust decision making (RDM) and dynamic adaptive policy
pathways (DAPP) approach in coastal flood risk management. The concept uses modelbased support and largely open source tools to help local government plan coastal
adaptation pathways. Key steps in the method are illustrated using a hypothetical case
study in Australia. The study shows how scenario discovery can provide multidimensional descriptions of adaptation tipping points which may inform the development
of technical signpost indicators. Transient scenarios uncovered limitations in seemingly
robust adaptation policies, where historical path dependencies may constrain the rate of
adaptation and the extent to which future coastal flood impacts can be successfully
managed. Lived values have the potential to offer insights about non-material social
trade-offs that residents may need to accept for the benefit of reduced flood risk and
could form a basis for defining socially-oriented signpost indicators. However, the
nuances and subjectivity of lived values means that ongoing engagement with residents
is essential as part of a combined RDM and DAPP approach to preserve the
communities’ way of life. The learnings from this hypothetical case study suggest that
testing in a real-world participatory setting could be valuable in further developing a
combined RDM and DAPP approach to plan adaptation pathways and manage future
coastal flood risk.
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5.2 Introduction
Sea levels are expected to continue rising for centuries regardless of whether
greenhouse gas emissions are stabilised (Church et al. 2013). Globally, this will
exacerbate coastal flood patterns, causing more frequent extreme sea level events
(Hunter 2010), nuisance flooding (Ray & Foster 2016) and permanent inundation of lowlying areas. However, projecting the effect of such environmental change and planning
long-term adaptation options is fundamentally a ‘wicked problem’ that challenges clear
definition (Rittel & Webber 1973). In the context of climate change adaptation this is due
to factors such as deep uncertainty (Lempert, Popper & Bankes 2003), natural climate
variability (Hallegatte 2009), contested stakeholder values (Bosomworth et al. 2017),
short-term interests and social power inequalities (Few, Brown & Tompkins 2007).
Local government are at the forefront of community decision-making. They have an
important role in communicating climate change risk and supporting local adaptation
planning. However, local government typically have unclear responsibilities, limited
financial capacity and technical expertise, governance constraints and face liability
concerns about adaptation policies (Productivity Commission 2012). Notwithstanding
these existing barriers, adaptation pathways are noted by users in Australian local
government as being a useful planning tool (Lin et al. 2017) and experiences abroad
suggests adaptation pathways have utility in supporting strategic decision-making
(Bloemen et al. 2017).
Adaptation pathways represent sequences of promising options that provide alternate
ways for decision-makers to achieve objectives through time. An adaptation tipping point
is reached when a policy no longer achieves the decision-makers objectives, signifying
that a new option needs to be implemented (Kwadijk et al. 2010). The year at which the
adaptation tipping point is projected to occur is called the ‘use-by year’ (Haasnoot et al.
2015). Flexibility is a key attribute of adaptation pathways as multiple options are kept
open to decision-makers in the future. Notably adaptation pathways have utility in coastal
flood risk management where change in stressors that influence flood impacts, such as
sea level rise, are characterised by slow moving trends (Bloemen et al. 2017).
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Faced with an uncertain future, exploratory modelling can help decision-makers reason
with system behaviour and the interaction amongst models and variables. Exploratory
modelling performs a series of computational experiments to analyse the implications of
future assumptions on policies (Bankes 1993). It does this by using models and
simulations to systematically explore a large set of future scenarios (Kwakkel 2017),
providing insights to decision-makers about potential shortcomings in the policy (Walker,
Haasnoot & Kwakkel 2013). The use of exploratory modelling across many scenarios
enables a wide set of futures to be considered (Gong et al. 2017), helping to overcome
limitations in human cognition (Lempert 2013) and biases that individuals tend to exhibit
when forming judgements about an uncertain future (Tversky & Kahneman 1974). Two
prominent decision support methods that utilise exploratory modelling concepts to
support decision-making under conditions of uncertainty are robust decision making
(RDM) (Lempert, Popper & Bankes 2003) and dynamic adaptive policy pathways (DAPP)
(Haasnoot et al. 2013). Although each method has its own strengths, both are
complementary in nature (Kwakkel, Haasnoot & Walker 2016). A combined RDM and
DAPP approach was demonstrated by Ramm, Watson and White (2018) using scenario
discovery to describe adaptation tipping points, which can be used to begin planning
adaptation pathways. Scenario discovery provides visibility around what key
uncertainties cause policies to no longer manage flood impacts successfully (i.e. an
adaptation tipping point reached), adding value to traditional pathway methods. The use
of exploratory modelling and analysis techniques in coastal flood risk management is
becoming increasingly accessible to resource constrained authorities through open
source spatial data, programming languages, tools (e.g. Kwakkel 2017) and geographic
information system (GIS) software.
Exploratory modelling is appropriate for assessing the implications of adaptation policy
in measurable terms, however, evaluating the implications of adaptation policy on nonmaterial social values is not straightforward as values are shaped by ethics, risk,
priorities, culture, knowledge and power structures (Adger et al. 2009). They also change
over time and space (Meze-Hausken 2008). Values-based approaches to climate
change adaptation contribute knowledge about what people value in their everyday lives,
where values are assigned to natural or manmade areas and whom increasing coastal
flooding is likely to cause the greatest disruption (Ramm et al. 2017a). Considering
values-based research acknowledges that “something greater than money is at stake”
(O'Brien & Wolf 2010, p.233) and that individuals may face difficult trade-offs decisions
between what values are worth preserving and what climate change impacts are
acceptable (Tschakert et al. 2017). Examples of values-based approaches include social
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and cultural values mapping (Novaczek et al. 2011) and the lived values approach
(Graham et al. 2014), where a lived value is a “valuation made by individuals about what
is important to their lives and the places they live” (Graham et al. 2013, p.49).
This study makes two contributions to the planning of coastal adaptation pathways.
Firstly, it builds on the combined RDM and DAPP methodology developed in Ramm,
Watson and White (2018) by including transient scenarios (i.e. time-series of future
realisations considering relevant uncertainties) to evaluate policy use-by years after
adaptation tipping points have been described through scenario discovery. Secondly,
prior knowledge of lived values is introduced into the adaptation pathways planning
process to qualitatively evaluate alternate adaptation pathways. Future opportunities to
utilise lived values information in a combined RDM and DAPP approach are also
considered. These contributions are illustrated using a hypothetical case study in the
coastal town of Lakes Entrance, Australia (referred to herein as the case study). Whilst
the study is hypothetical, it seeks to provide a proof of concept of the keys steps in a
combined RDM and DAPP approach, illustrating how local government might begin
developing long-term strategic adaptation pathways to manage future impacts from
coastal flooding.
Section 5.3 of this chapter provides an overview of the case study area and the
methodology is outlined in Section 5.4. Results are summarised in Section 5.5 along with
a baseline adaptation pathway map. The results are discussed in Section 5.6 and
conclusions are drawn in Section 5.7.

5.3 Case study: Lakes Entrance
Lakes Entrance is a regional town located on the Gippsland Lakes in south-east Victoria,
320 km east of Melbourne (Figure 5.1). It has a permanent population of 4,810
(Australian Bureau of Statistics 2016). Access to the ocean from the Gippsland Lakes is
provided through an artificial channel. A significant part of the town is less than 3 m above
mean sea level, including the esplanade which is located on the Princes Highway and is
a key precinct for tourism and business. Major flooding in Lakes Entrance occurred in
1952 (1 % AEP4 flood), 1998 (20 % AEP flood) and 2007 (20 % AEP flood) – the latter
isolating over 150 properties and inundating houses, businesses, roads and public
Annual exceedance probability (AEP). The flood water elevation of a 1% AEP flood event at
Lakes Entrance is 1.8 m AHD.
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amenities (SES 2014). Important lived values identified by residents in Lakes Entrance
include the natural environment, climate, proximity to the water, scenery, relaxed lifestyle
and feeling of safety (Graham et al. 2014).
Extreme flood water levels at Lakes Entrance are influenced by catchment stream flows
into the Gippsland Lakes, low frequency ocean water level fluctuations and wind setup
from prevailing south-westerly winds (Grayson et al. 2004). Prior studies suggest that
whilst changing catchment rainfall patterns from climate change could affect lake levels,
increasing mean sea level is likely to have an important contribution to extreme flood
water levels experienced in Lakes Entrance (McInnes & Hubbert 2006; Water
Technology 2014). Notwithstanding the complex interaction between environmental
forcings that contribute to extreme flood water levels in the Gippsland Lakes, this study
focuses on flood hazards exacerbated by mean sea level rise. This approach was
undertaken as prior modelling was available for Lakes Entrance, showing the relationship
between mean sea level rise and extreme lake levels (Water Technology 2014). A model
that captures the combined effect of multiple environmental forcings (e.g. catchment
stream flows, storm surge and wind setup) on extreme lake levels was not available in
this study.
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Figure 5.1 Aerial image of Lakes Entrance (top panel) and the GIS model (bottom panel)
showing digitised properties (n = 1864) and vertical land elevation relative to the Australian
Height Datum (AHD).

5.4 Methods
Ramm, Watson and White (2018) combined elements of RDM and DAPP to show how
multi-dimensional descriptions of adaptation tipping points can be illuminated using
scenario discovery, before projecting the timing of adaptation tipping points using a small
set of climate change scenarios. This study further develops the combined RDM and
DAPP approach in two main ways. First, it incorporates transient scenarios – a key
feature of DAPP – to project policy use-by years for a range of adaptation policy options.
This enables temporal changes in coastal flood risk to be accounted for using different
rates of change in the built and natural environment. Second, the study considers the
extent to which lived values information might be used in the evaluation of adaptation
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pathways. The methodological steps followed in this case study are shown in Figure 5.2.
and are outlined in sections 5.4.1 to 5.4.3.

Figure 5.2 Overview of the methodology used in the Lakes Entrance case study which has
been organised within the ISO31000 risk management framework. These steps are
expanded in sections 5.4.1 to 5.4.3.

The international ISO31000 standard for iterative risk management guides users through
the identification, assessment, management and monitoring of risk. Figure 5.2 has been
aligned to the key stages of ISO31000 because such principles are evident in both
emergency management and contemporary climate change adaptation frameworks.
Additionally, risk management is recognised as an appropriate framework to support
climate change adaptation (Jones & Preston 2011). Risk is described in this case study
as the consequence to objectives, caused by a combination of hazard, exposure and
vulnerability factors (Oppenheimer et al. 2014).

5.4.1 Establish the context
5.4.1.1

Define adaptation objectives

The adaptation objectives selected for this study are shown in Table 5.1. The metrics
chosen are consistent with other flood risk studies (e.g. Lempert et al. 2013; Scussolini
et al. 2017) and reflect traditional Australian emergency management objectives that
relate to the protection of life and property. The average annual damages (AAD) metric
represents the average damage each year to property that would occur from flooding
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over a long period of time. Similarly, the average annual people exposed (AAPE) is the
average number of people exposed to flooding per year over a long period of time, where
a person is considered exposed if flood water levels reach their property. The baseline
AAPE from flooding in Lakes Entrance was estimated in this study to be 47 people/year,
whilst the baseline AAD to property from flooding was $1.8 million/year. The tolerable
impact was arbitrarily set at twice the baseline levels since stakeholder engagement was
unable to be undertaken in this study. This was a key limitation since engagement with
the community would be necessary in a real-world application to build consensus on the
adaptation objectives and level of tolerable flood impacts (e.g. Barnett et al. 2014c;
Zandvoort et al. 2017).

Table 5.1 Selected adaptation objectives, metrics and tolerable impacts.
ID

Criteria

Adaptation objective

1

Safety

Maintain number of people exposed
to extreme flooding to below twice
the current baseline

2

Property
damage

Maintain property damage costs
(commercial and residential) to
below twice the current baseline

5.4.1.2

Metric
(measure
of risk)
AAPE

Tolerable impact

AAD

< $3.7 million / year

< 94 people / year

Define uncertain factors

Six uncertainties (Table 5.2) were identified for stress-testing the adaptation policies and
describing adaptation tipping points with scenario discovery (section 5.4.2.3). The
uncertainties used to generate transient scenarios and assess policy use-by years
(section 5.4.2.4) incorporated rates of change for different uncertain hazard, exposure
and vulnerability factors to reflect changing flood risk over time.
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Objective
AAPE AAD

Uncertain factor

9
9
9
9

9

9

9

9

Sea level rise (relative to 2010
level)
Sea level response factor
Max. structural damage (real $) b
Max. contents damage (real $)
Damage index uncertainty c
Average people per dwelling

Exposure

Hazard

9

9

9

9

9
9
9
9

9

9

9

9

9
9
9
9

Option 1: Rate of retreat (zone 4)
Option 2: Rate of redevelopment
Option 3: Rate of retreat
Option 4: Rate of all retreat

Timing of abrupt sea level rise

Rate of abrupt sea level rise

Sea level acceleration

Rate of sea level rise

Impact modelling (transient scenarios)

Vulnerability

Hazard

Impact modelling (for use in scenario discovery)

Risk
dimension

5 houses yr-1
5 buildings yr-1
5 houses yr-1
5 buildings yr-1

40 years

0 mm yr-1

-0.006 mm yr-2

+0.09 mm yr-1

0.8
-10 %
-10 %
-10 %
-50 %

0m

Range
Minimum

0.9
0%
0%
0%
0%

0m

Baseline

10 houses yr-1
10 buildings yr-1
19 houses yr-1
19 buildings yr-1

90 years

+20 mm yr-1

+0.07 mm yr-2

+5.3 mm yr-1

1.0
+10 %
+10 %
+10 %
+50 %

+2.0 m

Maximum

Min: guided by DeConto and Pollard (2016)
Max: user defined
User defined
User defined
User defined
User defined

Min: Church and White (2011)
Max: RCP2.6 upper curve (Church et al.
2013)
Min: RCP2.6 lower curve (Church et al.
2013)
Max: RCP8.5 upper curve (Church et al.
2013)
Min: user defined
Max: guided by DeConto and Pollard (2016)

User defined, guided by Church et al.
(2013)
Water Technology (2014)
User defined
User defined
Wehner et al. (2017)
User defined (relative to 2016 census
data).

Basis for range a

Table 5.2 Summary of the uncertainties used in the case study. The uncertainties have been grouped into: 1) those used to stress-test adaptation
policies and describe adaptation tipping points with scenario discovery, and 2) those used to generate time-varying transient scenarios to assess useby years.
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c.

b.

a.

Annual rate of change for
structural damage
Annual rate of change for
contents damage
Annual rate of change for
average people per dwelling

Uncertain factor

-0.05 % yr-1

-0.01% yr-1

-0.01 % yr-1

Range
Minimum
Baseline

+ 0.05 % yr-1

+0.01 % yr-1

+0.01 % yr-1

Maximum

User defined

User defined

User defined

Basis for range a

Refer Table D.2.2 of Appendix D for more details.
Property replacement costs estimated using Rawlinsons (2017). Real dollars relative to 2010 used to account for annual growth / decline in
the absence of inflation.
Difference between the analytical stage-damage curves applied and the actual surveyed data for the case study area.

9

9

Vulnerability

9

Objective
AAPE AAD

Risk
dimension

5.4.2 Risk assessment: No policy
5.4.2.1

Generate cases

A case is a ‘what-if’ scenario used to assess impacts to adaptation objectives for different
future realisations. Each case resembles a combination of uncertain hazard, exposure
and vulnerability risk factors. A total of 5,000 cases were generated with Latin Hypercube
Sampling (LHS) incorporating the uncertainties defined in Table 5.2. The cases
generated were stored in a simple flat file database (csv file).

5.4.2.2

Impact modelling (simulations)

Impacts to the AAPE and AAD metrics (Table 5.1) were assessed for each case in the
database. A simple ‘rule of thumb’ was established between mean sea level rise and
extreme lake flood water level based upon prior hydrodynamic modelling (Water
Technology, 2014). This was important in the impact assessments to model flood
hazards for 0.1 %, 0.2 %, 0.5 %, 1 %, 2 %, 5 %, 20 %, 40 %, 60 % and 90 % AEP events
using a bathtub approach. Commercial ArcGIS software was used to evaluate the
impacts to people from different flood events, using LiDAR data and digitised property
footprints. A database of low-lying properties, their approximated floor levels and building
characteristics was developed using aerial imagery, LiDAR data and Google Street View.
Structural damage to properties in this database was then assessed using flood depth,
with damage expressed as a percentage of the total replacement cost (i.e. damage index)
(Geosciences Australia 2017). Contents damage was only considered for residential
properties. Further details on the data and model set-up is provided in Appendix D.2.
Impact modelling was undertaken to stress-test the policy options and describe
adaptation tipping points using scenario discovery. It took 12 hours to assess impacts
across 5,000 cases (9 seconds per case) (3.4 GHz Intel processor, 16GB RAM).

5.4.2.3

Scenario discovery to describe adaptation tipping points

Scenario discovery is a data mining algorithm used to search the results of the impact
assessment for all cases and identify decision-relevant clusters (Bryant & Lempert 2010).
These clusters are a subspace of the total input uncertainty space and are achieved by
constraining one or more of the input uncertainties. The clusters contain a high proportion
of ‘interesting cases’, which get flagged when impacts to the AAPE and AAD metrics are
assessed as tolerable. The constrained uncertainties defining the clusters provide a
simple description to predict interesting cases (Bryant & Lempert 2010), which are used
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as the basis for defining adaptation tipping points (Ramm, Watson & White 2018).
Scenario discovery was implemented using the PRIM (patient rule induction method)
package in Python (Hadka 2016)5.

5.4.2.4

Transient scenarios to model time-varying impacts and assess policy use-by
years

Scenario discovery enabled conditions to be identified (described by a small set of
uncertain factors) for which policies no longer keep flood impacts below tolerable levels.
The (uncertain) rates of change for factors describing these conditions were used to
generate transient scenarios that modelled changing impacts over time and enabled the
policy use-by year to be assessed. The transient scenarios also included a rate of
implementation for the policy options (e.g. rate of retreat). This was done to capture how
the exposure of people and property changes, which influences the resultant flood
impacts over time (refer Box 2 in Appendix D.2.3). An arbitrary assessment horizon of
90 years was adopted for all policies (2010-2100) and a time-step of 5-years was used
to improve the computational simulation time. The distribution of use-by years across all
transient scenarios was summarised in a box plot and the median year used to give an
indicative timeframe for mapping adaptation pathways (Haasnoot et al. 2012; Haasnoot
et al. 2015; Kwakkel, Haasnoot & Walker 2016). The impact modelling using transient
scenarios took much longer than those simulations done in section 5.4.2.2, taking 34
hours to analyse 1,000 cases (2 minutes per case).
Sea level rise was a key uncertainty considered in this case study. A second-order
polynomial was used to project changing sea level over time in the transient scenarios,
accounting for the rate of sea level rise, acceleration and rate of abrupt sea level rise
(based upon Lempert, Sriver and Keller (2012) and Oddo et al. (2017)). Since the
historical mean sea level rise at Lakes Entrance was observed to be consistent with the
global trend, the coefficient values used in the polynomial were guided by global
projections from the Intergovernmental Panel on Climate Change fifth assessment report
(Church et al. 2013) as shown in Table 5.2. The maximum rate of abrupt sea level rise
used for exploratory modelling was based upon DeConto and Pollard (2016) to define a
scenario which incorporated potential instability of the Antarctic ice sheet (refer Figure
D.2.2 in Appendix D). However, worse-case upper limits may be possible.

Scenario discovery can also be implemented in R with the sdtoolkit (Bryant 2016), or in Python
using the open source exploratory modelling workbench (Kwakkel 2017), noting that the Python
implementation can handle heterogenous uncertain factors (Kwakkel & Jaxa-Rozen 2016).
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5.4.3 Risk treatment: Adaptation policy options
The activities in sections 5.4.2.2 to 5.4.2.4 were repeated on each policy option (Table
5.3) to assess adaptation tipping points and use-by years. The options considered were
non-exhaustive. Further details of the options are provided in Appendix D.4.

5.4.3.1

Develop the adaptation pathway

Adaptation pathways were developed and mapped using the adaptation tipping points
and use-by years for assessed policies. Subsequent DAPP activities not undertaken as
part of this case study illustration – but necessary as part of a complete RDM and DAPP
approach – include selecting a preferred pathway, determining contingency actions
(including signposts and triggers), specifying a dynamic plan, implementing the plan and
monitoring (Haasnoot et al. 2013).

5.4.3.2

Evaluate adaptation pathways (including lived values)

Lived values information for Lakes entrance was obtained from prior research using
semi-structured scoping interviews and survey (Graham et al. 2014). A simple qualitative
assessment of the potential implications of different adaptation pathways on the top five
lived values in Lakes Entrance was undertaken based upon judgement and knowledge
of the study area. Other criteria used to qualitatively evaluate the adaptation pathways
were cost, political risk and rate of implementation. Further opportunities to use lived
values in a combined RDM and DAPP approach are discussed in section 5.6.2.
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No policy

Barrier
protection

Changed
building
requirements

Land use
change

Planned retreat

N1

P1

A1

A2

R1

Do nothing

Protect

Accommodate

Retreat

Option

ID

Progressive voluntary acquisition of property/land in low-lying areas. Repurposing land use (e.g. natural wetland, parks and recreational areas). Realign the Princes Highway. Retreat mechanisms may include voluntary land
swap, voluntary acquisition and physical relocation of existing houses.

Changed land use in low-lying areas to commercial only, retreating residential
properties. Retreat might be achieved through voluntary land swap, voluntary
acquisition and physical relocation of existing houses.

Revise building development requirements. In low-lying areas, infill land to 2.3
m, raise minimum residential floor level to 2.6 m and change property
foundation requirements (e.g. piled foundations) which permits future raising of
floor levels or relocation of properties. Option likely to be slow given existing
property stock in the floodplain.

Protect properties from floods up to 2.5 m. Changed land use to commercial
only in unprotected low-lying areas, retreating residential properties. Barrier
protection could be achieved by levees and/or raising roads. Further information
is needed about the implication of rising groundwater tables on property/road
foundations, and the effectiveness of sheet pile and pumping measures to
control seepage under barriers.

Do nothing option (business as usual)

Description

?

9

9

9

9

9

9

8

8
?

Mitigate
permanent
inundation

Mitigate
lake
flooding

Table 5.3 Overview of selected adaptation policy options for this study showing their potential to mitigate extreme lake flooding and permanent inundation
from the sea.
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5.5 Results
5.5.1 Risk assessment: No policy
Scenario discovery results for the no policy option are shown in Table 5.4, along with the
median use-by year determined from transient scenarios. Further details from the
analysis is provided in Appendix D.6.
Table 5.4 Results from scenario discovery (describing adaptation tipping points) and
transient scenarios (median use-by year) for the no policy option.
Metric

Conditions describing
adaptation tipping point a.

Coverage /
density

Cases of
interest /
total cases

Median
timing of
use-by year
b.

AAPE

Mean sea level > 0.17 m
or
Average people per dwelling >
32 %

72 % / 88 %

449 / 5000

2050
(2045-2060)

AAD

Mean sea level > 0.33 m
or
Damage index uncertainty >
-1.5 %

74 % / 94 %

436 / 5000

2050
(2045-2060)

a. The mean sea level is relative to 2010 level and average people per dwelling is
relative to the 2016 census data.
b. The 25th and 75th percentiles are shown with italics in parentheses, based upon
the distribution of results modelled. Whilst this gives an indication about the spread
of timeframes in the modelled scenarios, the range should not be used to infer formal
probabilities.

A change in frequency of a 1.1 m flood event was used as an analogue to describe flood
risk and improve the salience of adaptation tipping points to residents. Residents are
familiar with impacts from a 1.1 m flood as such events have been experienced in the
recent past. Flood events of this magnitude cause disruption to the functioning of the
town by closing the Princes Highway, esplanade precinct and triggering additional flood
mitigation actions. Flood frequency analysis suggests that the current annual chance of
a 1.1 m flood event is 15 %, which corresponds to an average recurrence interval (ARI)
of one in seven years (Grayson et al. 2004, p.25).
Mean sea level rise was a dominant factor driving flood impacts and a rise in mean sea
level of approximately 0.2–0.3 m may cause flood impacts to people and property to
become intolerable without adaptation action (Table 5.4). This amount of sea level rise
could reduce the ARI of a 1.1 m flood event from seven years down to two years, raising
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the annual chance of occurrence from 15 % to 40 %. Flood impacts were projected to
become unacceptable at around 2050, as determined from the transient scenario
analysis which considered uncertain factors like the rate of sea level rise, acceleration,
rate of abrupt sea level rise and annual rate of change in average people per dwelling.

5.5.2 Risk treatment: Adaptation policy options
The adaptation tipping points and use-by years for all policy options were analysed
individually (Table 5.5). The map in Figure 5.3a. reflects the early stages of developing
and evaluating adaptation pathways for Lakes Entrance using a combined RDM and
DAPP approach. The relative implications of the adaptation pathways on the top five
lived values in Lakes Entrance are also shown in Figure 5.3b, along with a qualitative
evaluation of cost, political risk and rate of implementation for the adaptation pathways.
Table 5.5 Results from scenario discovery (describing adaptation tipping points) and
transient scenarios (median use-by year) for future policy options.
Option
(ID)

Metric

1
(P1)

AAPE

Median useby year b.

92 % / 96 %

Cases of
interest /
total cases
2503 / 5000

79 % / 91 %

1445 / 5000

2095
(2080-2100+)

AAPE

Mean sea level > 0.64 m
or
Damage index
uncertainty > 5.0 %
Mean sea level > 0.86 m

89 % / 98 %

2388 / 5000

2060
(2050-2075)

AAD

Mean sea level > 0.81 m

88 % / 91 %

2100 / 5000

AAPE

Mean sea level > 0.76 m

91 % / 97 %

2052 / 5000

2065
(2055-2080)
2100+
(2090-2100+)

AAD

72 % / 93 %

609 / 5000

2065
(2055-2075)

AAPE

Mean sea level > 0.40m
or
Damage index
uncertainty > -0.5 %
Mean sea level > 0.76 m

91 % / 97 %

2052 / 5000

2090
(2060-2100+)

AAD

Mean sea level > 0.86 m

87 % / 94 %

2320 / 5000

2100+
(2055-2100+)

AAD

2
(A1)

3
(A2)

4
(R1)

Conditions describing
adaptation tipping
point a.
Mean sea level > 0.96 m

Coverage /
density

2100+
(2100+)

a. The mean sea level is relative to 2010 level.
b. The 25th and 75th percentiles are shown with italics in parentheses, based upon
the distribution of results modelled. Whilst this gives an indication about the spread
of timeframes in the modelled scenarios, the range should not be used to infer formal
probabilities.
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Figure 5.3 Possible adaptation pathways for Lakes Entrance (a). Conditions the lead to
adaptation tipping points for policy options (assessed individually) are shown along with the
median use-by year for individual policies across the top axis. A simple qualitative scorecard
showing possible trade-offs to lived values from adaptation pathways are shown in the
bottom panel (b).
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A key feature of Figure 5.3a. is that conditions leading to adaptation tipping points can
be presented alongside policy options in the pathways map to communicate the
conditions at which individual policies no longer manage coastal flood impacts
acceptably (denoted by letters A to G). The adaptation pathways map would need to be
further developed to consider short-term low regret and/or win-win options that could
enhance – or keep open – the policy options mapped. Such actions might include
reviewing spatial planning rules (e.g. set-back lines or land use zones) or researching
new financial instruments to enable policies like retreat. Short-term flood mitigation
options like wet proofing, dry proofing or installing flood barriers (Maqsood, Wehner &
Dale 2017) could also be considered, with due consideration needed about potential
intergenerational implications of delaying transformational options like retreat.
Additionally, further effort is needed to identify technical, social and political signpost
indicators which might precede the decision nodes. This is particularly important for
options A1, A2 and R1 as implementation can take many years and decisions will need
to be triggered well in advance of the anticipated use-by year to manage flood impacts
successfully.

5.6 Discussion
5.6.1 A customisable model-based approach combining RDM and DAPP
The case study used a combined RDM and DAPP approach to illustrate keys steps that
local government might undertake in the early stages of long-term strategic adaptation
pathway planning to manage future coastal flood impacts. The model-based approach
provided insights about the sensitivity of the community to change without adaptation,
the anticipated timing at which adaptation policies are needed and the robustness of
those policies.
A strength of using scenario discovery from RDM is that it can provide multi-dimensional
descriptions of adaptation tipping points. This is potentially a useful basis upon which
technically-oriented signpost indicators and trigger levels might be specified as part of
the monitoring system (Hermans et al. 2017). For example, AAPE impacts were
modelled to double without any adaptation policy in a future scenario characterised by
sea level rise greater than 0.17 m and household occupancy levels 32 % higher than
present (Table 5.4). Such signpost indicators might be useful to monitor as their change
is slow and detectable. However, further development of early-warning triggers is needed
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to anticipate upcoming adaptation decisions ahead of adaptation tipping points,
especially when the implementation lead time is significant.
Sea level rise was a dominant uncertainty in the case study which was unsurprising given
sea level rise was the key hazard factor modelled that influenced change to extreme lake
flood levels. Translating sea level rise into a changed flood frequency can be a useful
analogue for communicating to residents about how impacts to local people, their lives
and experiences might be affected by future change (e.g. Barnett et al. 2014c). The flood
frequency of a 1.1 m event was considered in the case study and this could be a useful
signpost indictor that is salient to the everyday lives of residents. A difficulty that remains
with using flood frequency is that it can take decades for local and national scientific
agencies to detect and confirm the signal, which can cause difficulties reaching
consensus about whether change has occurred. Consequently, multiple signposts are
likely to be needed to cater for different stakeholder needs. Monitoring a variety of
indicators could provide a robust basis to detect changed coastal flood risk and trigger
adaptation decisions.
The inclusion of transient scenarios in a combined RDM and DAPP approach highlighted
how future flood impacts experienced in the community depend upon the rate of climate
change and the speed at which policies can be implemented. For example, scenario
discovery suggested that the A1 option (changed building regulations) was robust to 0.8
m of sea level rise (Table 5.5). However, the median use-by year was much earlier than
expected because the rate at which existing properties can infill land, raise floor levels
and change building types is likely to be constrained by characteristics of the existing
built environment (this rate was assumed to be in the range of 5-10 properties per year
based upon that rate of recent redevelopments in the study area). Therefore, this option
could be improved if: (1) it is implemented earlier, (2) the rate of implementation is faster,
or (3) the community accepts higher annual risk of damages. Similar findings also applied
to options A2 (changed land use) and R1 (planned retreat) where long lead times are
needed in existing settlements. Therefore, transient scenarios can draw the attention of
decision-makers to limitations of policy options in managing flood impacts over time,
which enables iterative improvements to be made to the policies and pathways.
The use of open source data, programming tools and commercial GIS software in the
combined RDM and DAPP approach enabled the impact assessments to be customised
to cater for location-specific data constraints and coastal flood characteristics. The
programming requirements for the case study became complex when accounting for
different objectives, data sets, models and policy options (refer Figure D.5.1 and Figure
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D.5.2. in Appendix D). This can become a barrier for resource constrained authorities
undertaking a combined RDM and DAPP approach. Whilst technical capability could be
procured in the short-term, further research is needed to improve the efficiency and
usability of the overall programming steps. Conversely, the growing repository of open
source data, programming packages and access to national datasets to support impact
assessments (e.g. the census data and the NEXIS database in Australia) are enabling
factors for a combined RDM and DAPP approach. Further research into the feasibility of
software like QGIS could make all steps in the combined RDM and DAPP approach open
source.

5.6.2 The use of lived values in adaptation pathways planning
Increasing coastal flood events will undoubtedly have different impacts on the way
residents experience lived values in Lakes Entrance. Whilst this study was constrained
insofar as it was unable to engage with participants to use lived values in the identification
of adaptation objectives, metrics and risk tolerances, knowledge of lived values was used
to qualitatively evaluate alternate adaptation pathways. The assessment (Figure 5.3b.)
provides a simple entry point for considering how adaptation pathways might affect key
lived values in Lakes Entrance, along with what non-material trade-offs could be
acceptable for the benefit of reduced coastal flood risk. This could further enable
conversations about how to improve adaptation pathways so that they preserve – or
enhance – important lived values for residents. For example, whilst those adaptation
pathways that include levees may trade-off impacts to the natural environment for
improved safety, they could enhance recreational opportunities by including new
walkways and cycle paths. Retreat pathways could include repurposing low-lying land
with parks, wetlands, marinas or recreational facilities and enhance scenery, natural
environment and recreational opportunity values over the coming decades. It would do
so at the trade-off of monetary cost and may cause discontent from property owners in
the floodplain whose tradable property value may be affected (Gibbs 2016).
The adequacy of claims about how the everyday lives of residents might be affected by
adaptation pathways needs further validation through community engagement as lived
values are nuanced and highly subjective. Whilst an initial assessment can provide a
simple entry point for decision-makers to contemplate the effect of adaptation pathways
on lived values early in the planning processes, it has limited use without being able to
engage with participants to reach consensus about adaptation decisions. There is further
potential for lived values information to be used in developing socially-oriented signpost
indicators as part of the monitoring system, but more research would be needed to
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operationalise key lived values (e.g. natural environment, scenery and safety) for use as
signpost indicators.

5.6.3 Closing remarks
Communities around the world are already committed to future sea level rise (Mengel et
al. 2018). The complexity of wicked problems such as coastal adaptation means that a
clear solution will not present itself and decisions will need to be made iteratively over
time to reflect the complexity and dynamics amongst actors (Moser, Jeffress Williams &
Boesch 2012). Adaptation pathway planning can help anticipate the timing of multiple
options to achieve long-term coastal flood risk management objectives. The adaptation
strategy requires periodic updates to incorporate the latest data, knowledge,
uncertainties and lived values to support ongoing monitoring of the objectives,
uncertainties, options, pathways, signposts and triggers. It will also require awareness
of path dependencies that extend beyond the assessment timeframes as some options
might constrain what future adaptation options are available. Creation of appropriate
regulatory instruments, governance arrangements and a willingness to adapt from
residents (Productivity Commission 2012) will also be necessary to enable the
implementation of timely adaptation policies by local government.
Informed decision-making at all levels of government is important as choices made today
about coastal development and land use will shape the pattern of urbanization over the
coming century, influencing what gets exposed to future coastal flooding. This is
particularly important for coastal towns whose long-term sustainability relies upon their
natural environment and proximity to the coast to attract residents, tourists and support
industry (Cooper & Lemckert 2012). A combined RDM and DAPP approach can account
for interactions between hazard, exposure and vulnerability factors which can then inform
flood impact assessments and an evaluation of policy robustness. Future opportunities
to engage with participants and consider lived values in a combined RDM and DAPP
approach include: 1) defining adaptation objectives, metrics and risk tolerance, 2)
identifying policies and evaluating adaptation pathways, and 3) identifying signposts and
triggers. Achieving consensus on these factors through community engagement is
critical because the adaptation tipping points, use-by years and hence resultant
adaptation pathways are fundamentally dependent on the specified adaptation
objectives and the communities level of tolerance for coastal flood impacts.
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5.7 Conclusions
This study provides a proof of concept of the key steps in a combined RDM and DAPP
approach in coastal flood risk management, illustrating how local government might
begin planning strategic adaptation pathways using model-based support and largely
open source tools. A combined RDM and DAPP approach can account for spatial and
temporal interactions between hazard, exposure and vulnerability flood risk factors,
which improves the way policy robustness is assessed for wicked problems like longterm coastal adaptation. Open source data and programming tools, along with
commercial GIS software, provide a customisable process for local government to cater
for location-specific constraints. However, programming can be complex for resource
constrained authorities which can limit uptake of the method.
The inclusion of scenario discovery in a combined RDM and DAPP approach allows
multi-dimensional descriptions of adaptation tipping points to be generated for policy
options. This can form a basis for developing technically-oriented signposts indicators
and triggers. Transient scenarios can uncover limitations in seemingly robust adaptation
policies, where historical path dependencies constrain the rate of adaptation and the
extent to which coastal flood impacts can be kept below accepted levels. This helps
decision-makers direct further efforts towards improving the efficacy of those policies,
such as considering earlier or faster rates of implementation, or accepting an increased
level of annual flood risk.
Lived values have the potential to offer insights about non-material trade-offs that
residents may need to accept for the benefit of reduced flood risk. They also have
potential use in designing more socially-oriented signpost indicators as part of a broader
adaptation pathway monitoring system. However, the subjectivities behind how residents
experience lived values mean that ongoing engagement is essential throughout the
adaptation planning process to provide a forum for learning and debating losses and
gains to residents’ way of life. Engaging residents is important in small coastal
communities to reach consensus on adaptation objectives, metrics and tolerable flood
impacts, which are critical inputs in the adaptation pathways planning process. The
learnings from this hypothetical case study suggest that testing in a real-world
participatory setting could be valuable to further develop a combined RDM and DAPP
approach to plan adaptation pathways and manage future coastal flood risk.
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5.8 Thesis context
This chapter further develops the method in Chapter 3 and provides a proof of concept
of the key steps in a combined RDM and DAPP model-based approach, using largely
open source tools. Whilst lived values information were used as part of a simple
evaluation of adaptation pathways, there are opportunities to use such knowledge in a
participatory process to define adaptation objectives and risk tolerances. Values-based
information might also be useful in establishing socially-oriented signpost indictors for
monitoring systems. The next chapter synthesises the main lessons learned and
research contributions from case studies presented in Chapters 2, 3, 4 and 5.
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Chapter 6 Using model-based and
values-based information in coastal
adaptation planning: Lessons learned
from south-eastern Australia
The aim of this thesis was to advance the planning of long-term adaptation pathways to
manage future coastal flood risk. Utilising three case studies in south-east Australia, this
thesis combined the strengths of robust decision making (RDM) and dynamic adaptive
policy pathways (DAPP), together with solicited values-based information to make three
novel advances towards flexible adaptation pathways planning. The section that follows
expands on each of these contributions before proposing a framework that advances
adaptation pathways planning. The discussion concludes by addressing barriers and
enabling factors that might be faced by authorities implementing the framework in real
case study locations.

6.1 Combining the strengths of RDM and DAPP to plan
adaptation pathways
A review of methodologies applied in Australian practice to evaluate long-term coastal
adaptation options (Chapter 2) found that many projects focussed on physical impacts,
which could be monetised for an economic appraisal. This was generally consistent with
observations made by Lin et al. (2017) who did an ex ante review on the nationally funded
Australian coastal adaptation pathways project. They found that many authorities took a
narrow technical (quantitative) view of risk with little consultation in the community to
consider a diversity of coastal values. Additionally, those Australian coastal adaptation
case studies that utilised a quantitative method to identify risks and evaluate adaptation
options tended to use deterministic or stochastic techniques to manage uncertainty
(Chapter 2). Such approaches have limitations over multi-decadal time frames, because
uncertainty propagates as time horizons extend and multiple future realisations are
possible. Scenario-based methods like RDM and DAPP offer the potential to provide
technical credibility around the treatment of uncertainty in complex long-term planning
problems.
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Scenario discovery is an important characteristic of RDM. The Kingston Beach (Chapter
3) and Lakes Entrance (Chapter 5) case studies demonstrated how in principle scenario
discovery can provide multi-dimensional descriptions of adaptation tipping points when
various hazard, exposure and vulnerability risk factors are acting on the system. This
improves the visibility around what uncertainties are influential on whether or not a policy
can manage flood risk adequately. It also adds value to seminal adaptation pathways,
which focus on single factors like sea level rise (e.g. Reeder & Ranger 2011) to explore
the robustness of policy options. Adaptation tipping points help to understand what future
changes in the built and natural environment might cause unacceptable impacts, relative
to the present. This can make communication of risks more straightforward and does not
rely on making probabilistic projections about the future. Whilst simple descriptions of
adaptation tipping points caused by changing hazards are easier to communicate to
decision-makers, they can overlook other exposure and vulnerability risk factors that
drive broader flood impacts. The resultant uncertainties uncovered in scenario discovery
can be useful candidates for technical signpost indicators in monitoring systems
(Hermans et al. 2017). Causal risk factors can be further analysed using techniques such
as root cause analysis or systems thinking to address more systemic underlying drivers.
A disadvantage of monitoring multiple risk factors is that it can create additional costs for
public authorities (Yohe & Leichenko 2010). However, scenario discovery reduces the
uncertainties considered down to a smaller set which can assist resource constrained
authorities in data collection and monitoring.
The use of scenario discovery to describe adaptation tipping points is helpful when
computational support is needed to model consequences across long timeframes. This
extra computational effort may not be justified for simple impact assessments. For
example, assessing the amount of sea level rise which causes a road to become
inaccessible could be done simply with knowledge of the road design levels and relative
sea level projections. The use of scenario discovery in a combined RDM and DAPP
approach is also limited insofar as it relies upon ‘measurable’ risk factors and clearly
defined objectives (Werners et al. 2015). The modelling and computational analysis is
not able to identify clear social adaptation tipping points, where individual tolerances for
risk are shaped by unique responses to the environment, their experiences and
knowledge (Meze-Hausken 2008). Therefore, alternate methods such as values-based
approaches (e.g. Chapter 4) are needed to capture and include non-material social
values in adaptation planning.
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Transient scenarios are a key characteristic of DAPP and were used in the Lakes
Entrance case study (Chapter 5) to identify the policy use-by year. This was useful in the
combined RDM and DAPP approach by accounting for different rates of environmental
change and policy implementation to model time-varying flood impacts. However,
presenting a range of use-by years can be a challenge for decision-makers planning
budgets in short-term political cycles (e.g. Linquiti & Vonortas 2012) because the timing
of implementation is less definitive. This emphasises the need for well-designed
monitoring systems that can detect changes in advance of adaptation tipping points
being reached, allowing sufficient time to refine budgets for anticipatory action. Designing
early warning triggers is important if actions have long lead times (Bloemen et al. 2017;
Haasnoot et al. 2015) and this was evident in the Lakes Entrance case study where the
policies considered took decades to fully implement.
The combined RDM and DAPP concept illustrated in both Kingston Beach (Chapter 3)
and Lakes Entrance (Chapter 5) demonstrated the feasibility of incorporating commercial
geographic information system (GIS) software with largely open source programming
tools and data. This is significant because the combined RDM and DAPP process can
be customised to the local needs of decision-makers, using existing spatial datasets and
models that are available to local government. In both studies (Chapter 3 and Chapter
5), the programming code was configured to cater for limitations faced by local
government. For example, the Kingston Beach case study (Chapter 3) used in-house
hydrodynamic flood modelling capability to establish simple relationships between
uncertain hazard factors and their effect on flood water level. This capability was not
available in the Lakes Entrance case study, which instead used a previously
commissioned study to develop the relationship between sea level rise and extreme lake
flood levels. The code reported in this thesis for the Kingston Beach and Lakes Entrance
case studies are available through GitHub (https://github.com/tdr2015/thesis).
The Lakes Entrance case study (Chapter 5) demonstrated how open source spatial data
can be used in creative ways to support impact assessments. For example, detailed
information about the property stock was not available for assessing average annual
damage impacts from flooding. This challenge was overcome by using an innovative
combination of Google Street View, high resolution aerial imagery (provided by the
council) and LiDAR data (provided by the State government) to create a property
database. Open source data can empower local governments to find reasonable
solutions to meet their data needs when resources are limited. Importantly, open source
data and tools – along with GIS analysis to assess spatial impacts of coastal flooding –
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can be used to support more advanced decisions support methodologies such as RDM
and DAPP. Further research is needed to explore where open source GIS software (e.g.
QGIS) could be used in a combined RDM and DAPP approach to make the entire
modelling process freely accessible.
The combined RDM and DAPP model-based approach developed in this thesis was
fundamentally reliant on the models themselves, which were critical in describing
adaptation tipping points and use-by years. The hazard modelling was simple in the
thesis case study examples and omitted more complex variables (e.g. velocity in flood
modelling). The studies also used basic relationships to model changes in hazards (e.g.
sea level rise and extreme flood water levels) which undoubtedly is a limitation. Whilst
there is scope to improve the models used in the thesis case studies, the mechanics of
a combined RDM and DAPP approach remains amenable to more complex modelling.

6.2 Elucidating non-measurable social values and possible
uses in adaptation pathways planning
Model-based decision support is useful in evaluating measurable flood impacts under
conditions of uncertainty. However, it overlooks intangible dimensions of coastal flooding
that can affect social and cultural factors important to the everyday lives of residents.
The case study undertaken in Kingston Beach showed that a lived and landscape values
approach provides complementary information about the social impacts of sea level rise.
The lived values approach provided broader information about what values residents
assign to a place, such as the natural environment, lifestyle and scenery. The landscape
values mapping approach revealed what values are associated with low-lying
landscapes, which helps understand how residents interact with, and thus value, their
coastal environment.
Categorising residents into groups based upon life characteristics (e.g. gender,
employment status and community group membership) and significant differences
between lived and landscape values in the Kingston Beach case study (Chapter 4)
provided information about who in the community might be more disrupted by sea level
rise. For example in that case study, the local beach was observed to be highly important
for recreational value to families and active younger residents, whilst for others (e.g.
community-minded volunteers or retirees), manmade features such as community halls
and ovals were likely to be of greater importance as they facilitate important social
119

interactions. This means that loss of the beach or manmade structures from sea level
rise has different implications to groups of people in the community. Adaptation planning
needs to consider a diversity of different needs so that the resultant strategies can be
improved to achieve fairer outcomes.
Together a combined lived and landscape values approach can provide information
about what residents value, where values are attributed to natural and built objects and
to whom sea level rise causes the greatest disruption. The inclusion of values-based
information in adaptation planning has important implications to policy as the definition
of coastal flood risk management objectives (e.g. physical, environmental, and socioeconomic) can lead to different conclusions about what adaptation responses should be
implemented. A more socially-oriented framing of long-term coastal adaptation is more
likely to preserve important values to their everyday way of life and therefore be
perceived as salient and legitimate by residents. The importance of values-based
information and community goals has also been recognised recently in New Zealand
with their national coastal adaptation planning guidance material (Lawrence et al. 2018).
Residents in Lakes Entrance place high value on the natural environment, climate,
proximity to the water, scenery, relaxed lifestyle and feeling of safety (Graham et al.
2014). The combined RDM and DAPP approach used in Lakes Entrance (Chapter 5)
incorporated lived values information with a simple evaluation of adaptation pathways.
This evaluation elucidated trade-offs between lived values and flood risk reduction. The
case study illustrated a simple entry point for how adaptation pathways might affect key
lived values, which could enable additional conversations in the community about how
best to preserve or enhance important social values. To illustrate with a simple example,
levees that mitigate flood damage could be beautified with public grassed areas or
walking tracks to enhance scenic and recreational amenity.
Values-based information has other potential uses. It provides a basis for formulating
adaptation objectives (e.g. Ministry for the Environment 2017) and may be used to
support the design of signpost indicators to monitor change (e.g. the impacts to the
natural environment – a highly valued attribute of many coastal communities in southeastern Australia). Whilst many opportunities exist to incorporate values-based
information in adaptation pathways planning, the nuances of how values are experienced
mean that ongoing engagement is essential to operationalise social values for use in a
combined RDM and DAPP approach. Although ongoing community engagement can be
a time consuming endeavour, further research is needed to test how values-based
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information can be used more effectively as part of a combined RDM and DAPP
approach.

6.3 Integrating model-based and value-based approaches in
adaptation pathways planning
Planning long-term coastal adaptation requires making decisions that yield costs and
benefits over multi-decadal timeframes. Decisions such as land use zoning,
development and building control standards create a path dependence that can enhance
or constrain the adaptation options available to future generations with changing coastal
flood risk. The key advances to adaptation pathways planning in Sections 6.1 and 6.2
are combined to provide a framework for coastal flood risk management (Figure 6.1).
This interdisciplinary framework builds upon the DAPP framework (Haasnoot et al. 2013)
and aligns with the well-established ISO31000 iterative risk management framework.
The framework is intended for long-term planning under conditions of uncertainty with
multiple

stakeholders,

potentially

contested

adaptation

objectives

and

large

consequences from poor decisions. It seeks to be inclusive of societal values and
community participation through using values-based approaches, whilst informing
stakeholders about the implications of alternate policies using model-based support. The
combination of model-based and values-based information within a deliberative
environment can be useful to support complex climate-related decision-making and
achieving a level of consensus about resultant adaptation pathways. Whilst outside the
scope of this thesis, institutional and governance analysis (i.e. rules) is a further
consideration in the broader decision context (Gorddard et al. 2016).
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Figure 6.1 A framework for planning long-term coastal adaptation that aligns to the
ISO31000 iterative risk management process. The case studies in this thesis provide
learnings that contribute to different parts of the framework. The outer circular band shows
activities in a combined RDM and DAPP approach; the middle band shows key activities in
the DAPP framework (incorporating key steps from Haasnoot et al. 2013); and the inner band
shows how values-based information might be incorporated.

6.4 Key barriers and enabling factors for implementation
Key barriers and enabling factors for planning long-term adaptation pathways using the
proposed general framework (Figure 6.1) are discussed in this section. The barriers and
enabling factors are non-exhaustive and reflect key experiences from the case studies
in this thesis. They include technical capability, data and modelling, and reaching
consensus amongst diverse participants.
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Technical expertise is often cited as a barrier to adaptation (e.g. Productivity Commission
2012), especially when more sophisticated decision support methods are used.
Implementation of the framework requires human resources capable of developing
programming code and integrating geoprocessing activities from ArcGIS into Python for
spatial impact assessments. Technical capability is also needed to undertake
hydrodynamic flood modelling (to derive model relationships), analyse social science
data (e.g. cluster analysis and interpreting values-based data) and to perform scenario
discovery. Local governments are likely to have varying degrees of technical capability
and financial outlays may be necessary to procure the appropriate resources. Grants or
funding from higher level government could overcome some of the financial barriers, but
this remains unlikely due to finite financial resources and competing demands of society.
Open source tools and data can help to lower costs for data acquisition and modelling in
local government. Online programming packages (e.g. Kwakkel 2017) and online
tutorials6 can provide increasing opportunities for individuals to develop programming
capability and implement more sophisticated decision-support methods.
The extent to which a combined RDM and DAPP approach can be implemented in
coastal flood risk management depends on the availability of data. It also requires access
to spatial datasets for impact modelling (e.g. LiDAR digital elevation models) and reliable
input data sources (e.g. consistent data on replacement value of properties). The lack of
reliable, consistent and comparable damage data has been reported by others as being
a major challenge for sound flood risk assessment (Merz et al. 2010). However,
necessary data inputs for analysing flood impacts can be limited in developing areas or
rural communities. Lack of historic data on hazards can become a barrier when
attempting to substantiate climate change and defend adaptation decisions. This is
particularly pertinent given short data records make it difficult to confirm trends in the
presence of natural variability.
Accessible national datasets enable the development of model-based approaches for
impact assessments. Datasets such as census data (demographic and socio-economic
information) and the National Exposure Information System (NEXIS) database (national
level exposure information relating to assets) in Australia seek to achieve a consistent
and regularly updated dataset. The use of nationally consistent datasets in coastal
adaptation planning would enable all levels of government to assess and compare
coastal flood risk across jurisdictions to prioritise preventative adaptation investments.

An example from the Jupiter nbviewer is available at this link:
http://nbviewer.jupyter.org/github/julierozenberg/prim/blob/master/Daiju%20example.ipynb

6
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New technologies may provide lower cost opportunities to acquire spatial data and aerial
imagery (e.g. remote sensing technology), whilst online data (e.g. Google Maps or
OpenStreetMap) is becoming increasingly available to support impact assessments.
Future research may also find novel opportunities to incorporate near real time data on
hazard, exposure and vulnerability flood risk factors, from which up-to-date flood risk
assessments can be provided to inform decision-makers.
Reaching consensus amongst participants is necessary for public coastal adaptation
decisions. Engaging with the community can be a time-consuming process that is
challenged by contested adaptation goals (Bosomworth et al. 2017), short-term interests
or social power inequalities (Few, Brown & Tompkins 2007). In the context of the
presented framework, engagement is needed at all stages of the process. This is on the
basis that deliberation, informed with analysis, has been shown to be an effective
learning mode for wicked problems like climate change adaptation (National Research
Council 2009). Barnett et al. (2014c) also showed how consensus around adaptation
pathways can be improved for rural towns with community workshops and focus groups.
Model-based analytical support from interdisciplinary technical experts has the potential
to add further credibility to the community engagement activities and inform participants
about the consequences of different policy options. An iterative and ongoing process of
stakeholder engagement can support learning amongst participants and allow them to
debate measurable and non-measurable impacts. Many local governments are already
experienced with community engagement which makes them well placed to implement
such activities in the context of climate change adaptation.

6.5 Concluding remarks
Key components of a values-based (i.e. lived and landscape values) and model-based
(i.e. a combined RDM and DAPP approach) framework were discussed using the
findings from three case study examples in south-eastern Australia (Chapters 3, 4 and
5). The proposed framework is participatory at all stages and provides a mechanism to
incorporate values-based information. Model-based approaches add value when
managing conditions of uncertainty over multi-decadal time scales by evaluating
complex impacts over many future realisations.
Testing of the framework is required in a real-world setting to critically evaluate the extent
to which the community engages with, and reach consensus on, resultant adaptation
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pathways. There remain strong opportunities for adaptation pathways research to
consider more socially-oriented strategies in coastal flood risk management. Risk
management decisions that draw upon both model-based and values-based information
can guide the adaptation planning process towards outcomes that are salient to the wellbeing of residents, whilst being informed by models about the implication of uncertain
changes in the built and natural environment.
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Chapter 7 Conclusions and future
research
7.1 General conclusions
This thesis sets out to advance the planning of long-term adaptation pathways in the
context of coastal flood risk management. The thesis objectives are achieved
progressively per chapter, each making methodological improvements against different
elements of the adaptation pathways planning process. Three case studies from southeastern Australia were used to illustrate individual research contributions. Together the
research objectives in this thesis combine to provide three novel advances towards longterm adaptation pathways planning.
Firstly, this thesis overcomes traditional limitations of adaptation pathway planning in the
way adaptation tipping points are described when multiple risk factors contribute to
overall flood impacts. It used scenario discovery – a cluster finding algorithm that
identifies future conditions whereby adaptation policies no longer manage flood risk
adequately – to provide a multi-dimensional description of physical adaptation tipping
points. Whilst this is limited to measurable impacts, it provides greater visibility on the
physical factors driving adaptation tipping points, which can be used as a basis for
technical signposts to monitor change. Combining the strengths of robust decision
making (RDM) and dynamic adaptive policy pathways (DAPP) to plan adaptation
pathways is a novel approach in coastal flood risk management. Transient scenarios
were valuable in assessing time-varying interactions amongst hazard, exposure and
vulnerability risk factors to provide improved information about policy use-by years.
Secondly, the novel combination and explanatory value of solicited lived and landscape
values can provide information to local government about what communities’ value in
their everyday coastal lives, where values are attributed to natural landscapes and manmade infrastructure, and for whom sea level rise and other climate change impacts is
likely to cause the greatest disruption. Values-based information has the potential to be
used in adaptation pathways planning to shape the selection of adaptation objectives
and risk tolerances, improve the design of options, support the evaluation of pathways,
and identify socially-oriented signpost indictors and triggers that are salient to the
everyday lived of residents. As outlined in Section 7.2, further work is needed to
126

operationalise non-material social values for use in a combined RDM and DAPP
approach to plan coastal adaptation pathways.
Thirdly, both geographic information system (GIS) software and open source
programming tools can be used in a combined RDM and DAPP approach to measure
and analyse coastal flood impacts. This improves the usability and relevance of a
combined RDM and DAPP approach for different location-specific needs. Such an
approach also provides a lower cost entry point for local government agencies to begin
planning coastal adaptation pathways. It does, however, require technical capabilities to
be able to develop programming code, analyse spatial data and perform flood modelling
activities.
These model-based and values-based advances combine to provide a framework that
improves the way adaptation pathways are planned. This was the outcome of the final
thesis objective. The findings elucidated from the case studies show how a combined
RDM and DAPP approach can account for spatial and temporal interactions between
hazard, exposure and vulnerability flood risk factors, which improves the way robustness
is measured for adaptation policy options. Values-based approaches support the
identification of non-measurable social impacts from coastal flooding, whilst enabling the
differentiation of trade-offs between lived values and adaptation pathways. Real-world
testing of the framework would enable a critical evaluation of the extent to which
communities can reach consensus on long-term adaptation strategies.
Whilst the potential for implementing a combined RDM, DAPP and values-based
framework in real-world adaptation pathways planning faces barriers relating to technical
resources, data availability and diverging stakeholder views, it is enhanced by
increasingly open access tools and ongoing community engagement throughout the
process. The combined contributions made in this thesis provide a framework that could
guide adaptation planning in local government towards outcomes that are salient to the
well-being of residents, whilst being informed by models about the robustness of policy
options to uncertain change. This has applications for coastal flood risk management
globally, which will become increasingly important throughout the coming century given
accelerating sea level and increased vulnerability.
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7.2 Future research directions
The recommended areas of future research to further the contributions presented in this
thesis are summarised below:


Testing the complete adaptation pathways framework in a real-world case
study and undertaking an ex post assessment: Whilst various concepts
presented in Figure 6.1 were illustrated ‘in principle’ throughout this thesis,
undertaking workshops and ongoing engagement activities were outside the
scope of this thesis. These forums are necessary to focus on: 1) definition of
adaptation objectives, metrics and a tolerable level of risk, 2) identification of
adaptation options, 3) discussion of trade-offs associated with a range of possible
adaptation pathways, 4) agreement on an adaptation pathway, and 5) definition
of a monitoring system. A more comprehensive understanding is needed about
the usefulness of the proposed framework in community decisions-making and
the extent to which residents can reach consensus at key stages of the process.
Following implementation of the complete framework in coastal adaptation
planning, an ex post evaluation on the efficacy of the framework in managing
coastal flood impacts could be done (e.g. after 10 years). Such a review could be
scheduled into ongoing local government risk management activities to assess
the usefulness of the adaptation pathways approach and identify improvements.



Application of a standard framework to prioritise adaptation investment:
Application of this framework at multiple locations at a municipal, state or national
level could help decision-makers understand what areas are most sensitive to
change (i.e. adaptation ‘hot-spots’) and support the prioritisation of adaptation
investment across jurisdictions. The median timing at which adaptation tipping
points (i.e. the ‘no policy’ use-by year) are projected to be reached or the timing
of early-warning signpost indicators could be a useful basis upon which actions
can be prioritised. Additionally, the feasibility of a coordinated state or national
body to provide consistent data sets for coastal adaptation and technical support
to undertake values-based and model-based analysis could be explored.



Developing flexibility in the framework for use as a first pass or detailed
approach to planning adaptation pathways: The resource constraints in local
government mean that implementation of sophisticated model-based approaches
may not always be feasible when planning adaptation pathways. The conceptual
128

interactions between physical and social values in adaptation pathways planning
could be considered as part of a simple first pass assessment to frame the
challenge being faced, before determining whether a detailed quantitative
analysis is needed by local government (incorporating model-based support or
structured community engagement). A decision tree could supplement the
framework with guidance on when different approaches should be considered.
Additionally, guidance could be provided about how to manage the implications
of long-term path dependencies associated with different adaptation options and
how this might be factored into the decision-making process.


An improved understanding of how climate change might affect lived and
landscape values: Further exploration is needed about what aspects of
vulnerable places (natural or manmade) residents value, and to what extent
climate change may affect the way individuals experience and assign value to
those places. A deeper understanding of where social interactions take place in
geographic space within coastal settlements is also needed to clarify what
elements cause residents to associate feelings of safety (or security) with the
places in which they live, and the extent to which these associations might
change with sea level rise or changing storm frequencies. More research is also
needed to determine how lived and landscape values might be translated into
adaptation objectives, signpost indicators and triggers as part of a combined
RDM and DAPP approach.



Comparing differences between where residents live and how they assign
economic and social value: Exploring patterns between where residents live
(spatially), their lived and landscape values, and willingness to pay for those
values might reveal insights about how valuations differ geographically in coastal
areas. Comparing qualitative (non-material) values made by residents with their
willingness to pay for experiencing (or preserving) those values might further
elucidate the relative importance of diverse social values. These insights could
be used to inform climate change risk assessments and help understand what
adaptation options are feasible based upon those important social values.



Utilising open source GIS software: Investigating the feasibility of using open
source GIS tools (e.g. QGIS) as a platform to undertake impact assessments
would make the combined RDM and DAPP process entirely open access. The
programming code could be added to existing platforms (e.g. the Exploratory
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Modelling and Analysis workbench) or developed collaboratively using platforms
such as GitHub. Alternatively, the programming code could also be developed
into an ArcGIS tool which takes the users input data (e.g. LiDAR, property
shapefiles) and specified parameters (e.g. sea level rise) to undertake impact
assessments for single scenarios. This might be useful to local governments to
rapidly assess the impacts of individual what-if scenarios using a consistent
methodology.


Application of the adaptation pathway framework to other natural hazards:
The adaptation pathways framework in this thesis focused on coastal flood
hazards. If the necessary resources exist (e.g. data and technical resource), then
the applicability of the framework to manage other long-term changes to natural
hazards – such as riverine flooding – could be investigated. This could provide a
standardised national approach towards long-term climate change adaptation
planning that is characterised by long timeframes, decisions that affect multiple
stakeholders and require model-based support to analyse impacts.



Using risk identification tools to explore causal risk factors: The
uncertainties that describe adaptation tipping points provide a useful basis from
which root cause analysis, systems thinking, or hazard chains could be applied
to map further causal risk factors. Understanding causal chains (or networks)
allows interventions to be considered at different stages in the chain in response
to more systemic risk.

7.3 Final remarks
Informed decision-making is vital in long-term coastal adaptation planning as choices
made today about coastal development and land use will shape the pattern of
urbanisation over the coming century, influencing what becomes exposed to future
flooding. The complexity of wicked problems like coastal adaptation planning is such that
adaptation priorities need to be reviewed regularly, incorporating the latest data,
knowledge, uncertainties and social values. A combined model-based and values-based
framework to support long-term adaptation pathways planning considers more broadly
the physical and non-material dimensions of coastal flood risk management. This can be
useful to support coastal adaptation planning by local government, who face increasing
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pressure to ensure the sustainability of their communities and minimise costly impacts
from increased coastal flooding.
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Appendix A Supplementary
for Chapter 2

material

A.1 List of documents used in the analysis
Table A.1.1 below summarises the coastal adaptation projects reviewed in Chapter 2.

Table A.1.1 List of selected coastal adaptation projects in Australia grouped by Australian
State. There were no reports used in this analysis from the Northern Territory. The Australian
Capital Territory was excluded, as this is not a coastal area.
State

Date

Project Title

Reference(s)

NSW

2010

Coastal inundation
at Narrabeen
Lagoon

AECOM & Department of Climate Change and Energy
Efficiency 2010, Coastal inundation at Narrabeen
Lagoon. Optimising adaptation investment, viewed
25 January 2016,
<https://www.environment.gov.au/system/files/resour
ces/52df63be-426d-4da4-979fde586e4c478c/files/narrabeen-lagoon.pdf>.

NSW

2011,
2012

Decision support for
coastal adaptation:
The handbook

Arnold, N, Fitzgibbons, A, Kinrade, P, Prickett, K &
Whiteoak, K 2011, Literature review and consultation
paper, viewed 20 June 2017,
<http://www.hccrems.com.au/wpcontent/uploads/2016/07/literature-reviewconsultation-paper.pdf>.
Kinrade, P, Arnold, N, Fitzgibbons, A, Kulkarni, K,
Prickett, K, Whiteoak, K & Wilson, S 2012a, Decision
support for coastal adaptation: The handbook, Hunter
and Central Coastal Regional Environmental
Management Strategy, Thornton, NSW.
Kinrade, P, Arnold, N, Davies, S, Whiteoak, K &
Fitzgibbons, A 2011, Discussion paper, viewed 20
June 2017, <http://www.hccrems.com.au/wpcontent/uploads/2016/07/background-discussionpaper.pdf>.

NSW

2012

ARUP 2012a, Demonstrating climate change adaptation
of interconnected water infrastructure. Synthesis
Report, viewed 25 January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/Synthesis%20Report%20Cover%20and%20
Executive%20summary.pdf>.
ARUP 2012b, Demonstrating climate change adaptation
of interconnected water infrastructure. Synthesis
Report. Part 1 - Overview, viewed 25 January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/Part%201%20Overview.pdf>.
ARUP 2012c, Demonstrating climate change adaptation
of interconnected water infrastructure. Synthesis
Report. Part 2 – User Guide, viewed 25 January
2016,
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State

Date

Project Title

Reference(s)
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/Part%202%20User%20Guide.pdf>.
ARUP 2012d, Demonstrating climate change adaptation
of interconnected water infrastructure. Synthesis
Report. Adaptation Resource Centre (interactive pdf),
viewed 25 January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/Part%203%20Adaptation%20Resource%20C
entre.pdf>.

NSW

2012,
2013

AdaptWater

Allen, G, Cini, E, Cox, D, Mallon, K, Quinn, N, Nelson, N,
& Sullivan, J 2013, AdaptWaterTM: incorporating
climate change adaptation into utility asset
management decision-making, fifth Leading-Edge
Strategic Asset Management conference,
International Water Association, Sydney, NSW.
Mallon, K, Cini, E, Sullivan, J, Kristevic, O, Brown, S,
Quinn, N & de Lacy, C 2012, AdaptWaterTM: climate
change adaptation quantification tool for the water
industry, Ozwater’13 Conference and Exhibition,
Perth, WA.

NSW

2013

Assessment and
decision frameworks
for seawall
structures

Coastal Environment Pty Ltd 2013a, Assessment and
decision frameworks for seawall structures. Part A –
Synthesis Report, viewed 25 January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/Seawalls%20Final%20report%20consolidated
%20290413%20Part%20A.pdf>.
Coastal Environment Pty Ltd 2013b, Assessment and
decision frameworks for seawall structures. Part B –
Appendix C – Economic Considerations, viewed 25
January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/appendix_c_economic_considerations.pdf>.

NSW

2013,
2014

A multi-criteria
analysis of coastal
adaptation options
for local government

Mangoyana, RB, Thomsen, DC, Smith, TF, Preston, BL,
Heinz, S, Maloney, M, Withycombe, G & Armstong, I
2013, Literature review of adaptation to climate
change in the coastal zone, viewed 25 January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/litreview.pdf>.
Preston, BL, Maloney, M, Thomsen, D, Smith, T,
Mangoyana & R, Conlon, B 2013, A multi-criteria
analysis of coastal adaptation options for local
government, viewed 25 January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/MCA_of_Coastal_Adaptation_Options_for_Lo
cal_Government.pdf>.
Thomsen, DC, Smith, TF, Jacobson, C, Mangoyana, RB,
Preston, BL, Maloney, M, Withycombe, G, Armstrong,
I & Norrie, E 2014, A guide to monitoring and
evaluating coastal adaptation. Second edition, viewed
25 January 2016,
<http://www.sydneycoastalcouncils.com.au/sites/defa
ult/files/A-Guide-to-Monitoring-and-EvaluatingCoastal-Adaptation.pdf>.

NSW

2014

Improving
adaptation of
coastal communities
through bottom-up
approaches: a case

Serrao-Neumann, S, Schuch, G, Koschade, O & Low
Choy, D 2014, Improving adaptation of coastal
communities through bottom-up approaches: a case
study of the Conjola District, Shoalhaven, NSW. 23rd
NSW Coastal Conference, Shoalhaven, NSW.
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State

Date

Project Title

Reference(s)

study of the Conjola
District, Shoalhaven
NSW

2015

A plan for Marks
Point and Belmont
South to adapt to
changing lake and
flood levels

Lake Macquarie City Council 2015, A plan for Marks
Point and Belmont South to adapt to changing lake
and flood levels. Volume 1: Summary, viewed 25
January 2016,
<http://www.lakemac.com.au/downloads/B2D11DC12
07DBE89ACDD4F7D3D83C7330561928D.PDF>.

QLD

2012

Pilot council and
insurance
partnership on
adaptation methods

Climate Risk Pty Ltd 2012a, Pilot Council and Insurance
Partnership on Adaptation Methods. Module 1
Report. Final Draft, Sunshine Coast Regional
Council, Sunshine Coast, Queensland.
Climate Risk Pty Ltd 2012b, Pilot Council and Insurance
Partnership on Adaptation Methods. Module 2
Report, Sunshine Coast Regional Council, Sunshine
Coast, Queensland.
Climate Risk Pty Ltd 2012c, Pilot Council and Insurance
Partnership on Adaptation Methods. Module 3
Report, Sunshine Coast Regional Council, Sunshine
Coast, Queensland.
Climate Risk Pty Ltd 2012d, Pilot Council and Insurance
Partnership on Adaptation Methods. Module 4
Report, Sunshine Coast Regional Council, Sunshine
Coast, Queensland.

QLD

2012

Coastal hazard
adaptation strategy
for Townsville City
Council

GHD 2012, Coastal hazard adaptation strategy for
Townsville City Council. Pilot Project, Townsville City
Council, Townsville, Queensland.

SA

2012

Climate change
decision support
framework and
software for coastal
councils

Balston, JM, Kellet, J, Wells, G, Li, S, Fray, A & Western,
M 2012, Climate change decision support framework
and software for coastal Councils, viewed 25 January
2016,
<http://www.lga.sa.gov.au/webdata/resources/files/FI
NAL%20CADSP%20Report%20Published%2013%2
0May%202013-1.pdf>.

SA

2014

Regional climate
change adaptation
plan for the Eyre
Peninsula

Siebentritt, M, Halsey, N & Stafford-Smith, M 2014,
Regional climate change adaptation plan for the Eyre
Peninsula, Eyre Peninsula Integrated Climate
Change Agreement, South Australia.

TAS

2012,
2014,
2015

Tasmanian coastal
adaptation pathways
project

Department of Premier and Cabinet 2016, Tasmanian
Coastal Adaptation Pathways project, viewed 13 May
2016,
<http://www.dpac.tas.gov.au/divisions/climatechange/
Climate_Change_Priorities/climate_risks_and_opport
unities/coastal>.
SGS Economics and Planning 2012a, Tasmanian
Coastal Adaptation Pathways Project. Kingston
Beach – Final Report, viewed 25 January 2016,
<http://www.kingborough.tas.gov.au/webdata/resourc
es/files/TCAP%20Kingston%20Beach%20Final%20R
eport-1.pdf>.
SGS Economics and Planning 2012b, Tasmanian
Coastal Adaptation Pathways Project. Port Sorell –
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Date

Project Title

Reference(s)
Report, viewed 25 January 2016,
<http://www.latrobe.tas.gov.au/webdata/resources/file
s/TCAP%20Port%20Sorell%20Report_final.pdf>.
SGS Economics and Planning 2012c, Tasmanian
Coastal Adaptation Pathways Project. Lauderdale
recommended actions, viewed 25 January 2016,
<http://www.ccc.tas.gov.au/webdata/resources/files/0
1Harkin%20J%20-%20TCAP%20Lauderdale%20Adap
tation%20Pathway%20Recommendations%2012071
2,%20Final%20-%2013July2012.pdf>.
SGS Economics and Planning 2012d, Tasmanian
Coastal Adaptation Pathways Project. Georges Bay,
viewed 25 January 2016,
<http://www.bodc.tas.gov.au/sites/all/files/breakoday/
documents/resources/final_tcap_georges_bay_report
.pdf>.
SGS Economics and Planning 2014a, Turners Beach –
Leith Coastal Adaptation Pathways. Final Report,
viewed 25 January 2016,
<http://www.dpac.tas.gov.au/__data/assets/pdf_file/0
017/238004/TCAP_2_SGS_Final_Report_Turners_B
each_Leith_-_27_June_2014.pdf>.
SGS Economics and Planning 2014b, Somerset Coastal
Adaptation Pathways. Final Report, viewed 25
January 2016,
<http://www.dpac.tas.gov.au/__data/assets/pdf_file/0
004/238009/TCAP_2_SGS_Final_Report__Somerset.pdf>.
SGS Economics and Planning 2014c, Kelso Coastal
Adaptation Pathways. Final Report, viewed 25
January 2016,
<http://www.dpac.tas.gov.au/__data/assets/pdf_file/0
018/238014/TCAP_2_SGS_Final_Report__Kelso.pdf>.
SGS Economics and Planning 2015, Nutgrove – Long
Beach Coastal Adaptation Pathways. Status Report,
City of Hobart and Tasmanian Climate Change
Office, Hobart, Tasmania.

VIC

2012

Adapting to
inundation in
urbanised areas:
supporting decision
makers in a
changing climate.
Port Phillip Bay
Coastal Adaptation
Pathways Project
Report

AECOM Australia 2012, Adapting to inundation in
urbanised areas: supporting decision makers in a
changing climate, Port Phillip Bay Coastal Adaptation
Pathways Project Report, viewed 20 June 2017,
<http://www.mornpen.vic.gov.au/files/3c362e99d23b-475f-8c86-a2f801016659/Attachment_4__Port_Phillip_Bay_Coastal_Adaptation_Pathways_Pr
oject_-_Final_Report_2012.pdf>.

VIC

2012

Deciding for the
coast: A guide for
decision-making on
cost effective
adaptation.

Kinrade, P, Arnold, N, Fitzgibbons, A, Kulkarni, K,
Prickett, K & Whiteoak, K 2012b, Deciding for the
coast: A guide for decision-making on cost effective
adaptation, viewed 25 January 2016,
<http://www.seccca.org.au/wpcontent/uploads/2015/09/deciding-for-the-coastguide.pdf>.
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Date
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Reference(s)

VIC

2012

Climate adaptation
in coastal caravan
parks.

Walker, C, Blackwell, B & Rolf, J 2012a, Climate
adaptation in coastal caravan parks. Economic value
and equity literature review. Report 1, viewed 25
January 2016,
<http://www.wcb.vic.gov.au/caravanparks/CCPs%20
Literature%20Review%20-%20high%20quality%20for
%20web.pdf>.
Walker, C, Blackwell, B & Rolf, J 2012b, Climate
adaptation in coastal caravan parks. Economic value
and equity research report. Report 2, viewed 25
January 2016,
<http://www.wcb.vic.gov.au/caravanparks/CCPs%20
Research%20Report%20Final%20-%20low%20qualit
y%20for%20web.pdf>.
Walker, C, Blackwell, B & Rolf, J 2012c, Climate
adaptation in coastal caravan parks. Economic value
and equity decision support framework. Report 3,
viewed 25 January 2016,
<http://www.wcb.vic.gov.au/caravanparks/CCPs%20
Decision%20Support%20Framework%20-%20high%
20quality%20for%20web.pdf>.

VIC

2014

Equitable local
outcomes in
adaptation to sealevel rise

Barnett, J, Fincher, BR, Hurlimann, A, Graham, S &
Colette, M 2014a, Incorporating community vales into
climate change planning: a guide for government,
viewed 20 June 2016, <https://minervaaccess.unimelb.edu.au/bitstream/handle/11343/3961
0/ARCL%20Guide%20for%20government%20-%20fi
nal.pdf?sequence=3>.
Barnett, J, Fincher, BR, Hurlimann, A, Graham, S &
Colette, M 2014b, Equitable local outcomes in
adaptation to sea-level rise. Final Project Report,
viewed 20 January 2016, <https://minervaaccess.unimelb.edu.au/bitstream/handle/11343/3960
9/ARCL%20Gippsland%20Final%20Report%20.pdf?
sequence=3>.

WA

2012

Developing flexible
adaptation pathways
for the PeronNaturaliste coastal
region of Western
Australia

ACIL Tasman 2012a, Climate change adaptation –
Executive Summary. Developing flexible adaptation
pathways for the Peron-Naturaliste Coastal Region of
Western Australia, viewed 25 January 2016,
<http://www.bunbury.wa.gov.au/pdf/Planning%20and
%20Building/PNPExecutiveSummary.pdf>.
ACIL Tasman 2012b, Climate change adaptation options
assessment. Developing flexible adaptation pathways
for the Peron-Naturaliste Coastal Region of Western
Australia, viewed 25 January 2016,
<http://www.bunbury.wa.gov.au/pdf/Planning%20and
%20Building/PNPAssessmentReport.pdf>.
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Uncertain change in factors characterised by projected trends and
variability.

Transient scenarios developed that include a range of events and
incorporate changing characteristics of uncertain factors over time
(e.g. trends).

Generation of
scenarios/cases

High flexibility (dynamic robustness) in keeping options open,
especially if options are reversible; does not specify single solution.

Generally follows an iterative risk management process.

Flexibility is maintained as long as possible by keeping pathway
options open; contingency plans are included in pathway (as
additional adaptation responses); the process is iterative over time.

To develop adaptation pathways that allow flexibility to meet longterm goals.

A framework that maps out multiple adaptation responses.

Dynamic Adaptive Policy Pathways (DAPP)

Uncertain factors

Degree of
flexibility in
resultant plan

Alignment to risk
management
processes
(ISO31000)

Robustness
principles

Robustness goal

Purpose

Characteristic

Latin Hypercube Sampling (LHS) used to randomly sample
input factors and generate different cases.

Uncertain change in factors characterised by specifying range
of future values (i.e. minimum and maximum value). Does not
rely on probabilistic information about factors.

Some flexibility, depending on strategy chosen. Traditionally
used for static adaptation responses.

Used in the ‘risk treatment’ stage of the risk management
process.

Analysis identifies a static adaptation plan, though flexibility
can be incorporated into the plan with monitoring and control
activities (i.e. potential to be an iterative process over time like
DAPP)

To develop adaptation responses that perform well (i.e. meet
goals) in the many future cases.

An evaluation method to identify robust adaptation responses.

Robust Decision Making (RDM)

Table B.1.1 Comparison of DAPP and RDM approaches and their use in assessing risk and evaluating adaptation responses (developed from Haasnoot
et al. 2013; Kwakkel et al. 2016a; Lempert et al. 2013; Walker et al. 2013; Watkiss and Hunt 2013)

A summary of key characteristics in the RDM and DAPP approaches is shown in Table B.1.1.

B.1 Comparison of RDM and DAPP

156

157

Dynamic Adaptive Policy Pathways (DAPP)

To identify the timing of adaptation tipping points and when
adaptation responses are to be implemented. Individual adaptation
responses can then be evaluated using traditional methods (e.g.
CBA) or a scorecard (multiple metrics).

Fast and simple meta-models to assess impacts based on causeeffect relationships (e.g. pressure-state-impact-response).

Ideally suited to applications where there is potential to learn and
make changes to the course of the adaptation strategy over time.

Main limitations include a reliance on clearly defined model(s) for
analysis; multiple variables and the ability to detect change to climatic
factors with natural variability can make it difficult to confirm when
thresholds (adaptation tipping points) have been reached.

Characteristic

Use of
scenarios/cases

Computational
support for
impact analysis

Main application

Main limitations

Main limitations are reliance on initial scoping and definition of
model(s) used in the analysis; limited guidance in plans as to
how adaptation responses might change over time; high
demand for quantitative information and technical resource in
analysis.

Ideally suited to near-term investments with a long-design life
and irreversible options.

Exploratory modelling and analysis used to explore impacts
and scenario discovery (data mining algorithm) used to
analyse data.

To evaluate the performance of the adaptation response
against the metrics and identify the limits of the adaptation
option (i.e. a process of ‘stress-testing’).

Robust Decision Making (RDM)

B.2 Generating rules of thumb
Three rules of thumb were determined for this study to incorporate the effect of uncertain
factors on the simulation model: 1) the change in floodwater elevation for each meter of
sea level rise; 2) the change in the floodwater elevation for each percentage increase in
the 9 hour critical rainfall intensity; 3) the horizontal beach recession for each meter of
sea level rise.
Inundation maps representing peak floodwater elevation were obtained from
Kingborough Council for 11 scenarios (Table B.2.1). These were developed using 2D
hydrodynamic modelling software (SWMM by XP Solutions) and converted into water
elevation raster grids for use in the analysis.

Table B.2.1 Scenarios modelled with 2D hydrodynamic software. The flood modelling does
not consider future development planning for the suburb which can change the permeability
of the upstream catchment area.
Scenario

Riverine
Flood

Sea level rise

Rainfall
intensity a.

Main use(s) of scenario

1

1% AEP

MHWS

No change

2

2% AEP

MHWS

No change

3

5% AEP

MHWS

No change

 Develop continuous
surfaces
 Rule of thumb for sea level
rise
 Understand baseline risk
(AAD and AAPE)

4

20% AEP

MHWS

No change

5

1% AEP

MHWS + 1m

No change

6

2% AEP

MHWS + 1m

No change

7

5% AEP

MHWS + 1m

No change

8

20% AEP

MHWS + 1m

No change

9

1% AEP

MHWS + 0.3m

+10%

10

1% AEP

MHWS + 1m

+30%

11

2% AEP

MHWS + 0.8m

+15%

 Develop rule of thumb for
sea level rise

 Cross-check that proxy
surface reasonably
approximates the 2D
hydrodynamic model

a. Increase to 9 hour rainfall intensity
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B.2.1 Baseline impacts
Scenarios 1 to 4 (Table B.2.1) allowed the baseline (current-day) flood risk to be
assessed. They also allowed a continuous proxy surface to be created for water
elevation using a spline interpolator. Generating a continuous surface was necessary to
replace all ‘NoData’ points in the raster with a reference water elevation level.
Incremental changes to the continuous water elevation surface could then be made to
all cells in the raster using the rules of thumb.

B.2.2 Impact of sea level rise on floodwater elevation
Scenarios 5 to 8 (Table B.2.1) allowed the relationship between sea level rise and
riverine floodwater elevation to be assessed. This subsequently revealed that a 1 m rise
in sea level only increases the peak floodwater elevation by 1 cm.

B.2.3 Impact of changing rainfall intensity on floodwater elevation
The relationship between rainfall intensity and floodwater elevation was based upon a
prior flood study done by Kingborough Council, which suggested that peak floodwater
elevation of Browns River changed by about 0.1 m per 10% increase in 9 hour rainfall
intensity (Kingborough Council 2017: p.40).

B.2.4 Impact of sea level rise on horizontal beach recession
The relationship between horizontal beach recession and sea level rise was underpinned
by the Bruun rule. A Bruun factor between 10-100 was used in the case study based on
factors from nearby locations in the Derwent Estuary.

B.2.5 Validating rules of thumb
Scenarios 9 to 11 (Table B.2.1) were used to validate whether the rules of thumb
produced reasonable approximations of peak floodwater elevation (i.e. comparing proxy
surfaces with 2D hydrodynamic model outputs). Generating proxy floodwater elevation
rasters for scenarios 9 to 11 using the rules of thumb (sea level rise and rainfall intensity)
produced an average variance from the 2D model rasters in the order of a few
centimetres. However the proxy water elevation surfaces tended to diverge from the 2D
model at discrete dwellings upstream in the study area, in the order of tens of centimetres.
Such differences were not considered to have a major effect on the analysis as the larger
differences were at isolated dwellings. The differences were likely to be caused by the
159

assumed linear change in peak floodwater elevation across all raster cells which results
from applying the first two rules of thumb.

B.3 GIS metadata, spatial data and geoprocessing worksheet
The metadata for the impact model is contained below in Table B.3.1. Details of the
spatial data layers used in the impact model are contained in
Table B.3.2 and a summary of the geoprocessing steps utilised in the python script for
the impact assessment are shown in Table B.3.3.

Table B.3.1 General metadata for the impact simulation model and scenario discovery
activities
Category

Summary

General details
Creation date:
Description:

Keywords:
Data types:

April 2017
The impact model estimates (1) the average annual number of
residents exposed to coastal inundation hazards (AAPE); (2) the
average annual monetary impacts to private dwellings (AAD) from
flooding; and (3) the average beach width (Kingston Main Beach)
for different sea level rise scenarios. Different cases reflect
combinations of uncertain factors. The inundation hazards
considered include (1) permanent sea level rise and (2) temporary
riverine flooding (Browns River). The script calls upon the ArcPy
model to apply geoprocessing tools for undertaking spatial analysis.
Open source GIS data from TheLIST are used, and the results are
exported in .csv file.
Flood, geoprocessing, hazard, impact, sea level rise, uncertainty
Vector (points, lines, polygons) and raster (grid)

Spatial details
Data coverage:
Extent
[coordinates]:

The suburb of Kingston Beach, Tasmania
[Xmin, Ymin, Xmax, Ymax]: [524950, 5239950, 527847, 5243050]

Spatial projection

GDA_1994 MGA Zone 55

Vertical datum(s)

Permanent sea level rise: Mean High Water Spring (MHWS)
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Category

Summary
Temporary riverine flood: Australian Height Datum (AHD)

ArcGIS details
ArcMap version:
ArcMap file name:
ArcGIS
Extensions:
Environment
Settings:

Version 10.4 (ESRI)
ConceptSLR.mxd
3D Analyst; Spatial Analyst
Workspace: Concept.gdb
Scratch: ScratchConcept.gdb

Toolbox Settings:
(Note that models
were used in the
first instance to
help develop the
Python code using
the ArcPy
package)

Toolbox: Concept.tbx
Model: ConceptModel, Description: Merges DEM LiDAR rasters
and defines suburb area
Model: BeachPrep, Description: Creates polygons of key coastal
areas (landscapes – e.g. beach, river)
Model: TestPython, Description: Main model used to develop
python code used in script (i.e. assess sea level rise impacts)
Model: AdaptOptions, Description: Model that adds in structural
adaptation options (e.g. levee/seawall) into DEM raster surface for
impact analysis
Model: Addresses, Description: Identifies houses (in mesh blocks)
and also houses in the 1:100 hazard zone.
Model: RiverHaz, Description: Sets up the 1%, 2%, 5% and 20%
AEP Riverine hazard extents (i.e. splines). Also checks for
differences between the modelled extent (2D hydrodynamic model)
and the spline approximation.

Python details
Python script file:
Version:
IDE:
Python packages:

CaseStudyOne.py
Python 2.7 (WinPython-32bit-2.7.10.2)
Spyder
ArcPy, Pandas, NumPy, Math, Time

R programming
details
R script file:
Version:

ArcGIS_Example.R
3.2.0
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Category
R
packages/libraries:

Summary
Lhs, sdtoolkit (note that the sdtoolkit package only works on PC
(windows) computers and will not work in the RStudio interface (i.e.
needs to run in the original Windows GUI))

Table B.3.2 Details of spatial layers use in the impact model
Risk dimension

Description

Data source

Sea level rise

Raster layer created based
upon vertical rise in sea level

N/A

Riverine flood layer
(incl. sea level rise)

2D model outputs for 1 %, 2 %,
5 % and 20 % AEP flood event
with and without sea level rise
were provided. Outputs were
raster files with peak flood
water elevations and the spatial
flooding extent.

Kingborough Council

LiDAR dataset (Mount
Wellington) with a 1 m x 1 m
ASCII grid.

TheLIST open data

Hazard

Exposure
Digital Elevation Model
(DEM)

DEM rasters resampled to 2 m
x2m raster cell sizing to speed
up processing in script.
Transect (beach width)

Polylines generated using
aerial imagery (i.e. at beach
access locations)

N/A

Buildings

Dwelling polygons were created
by digitising aerial imagery

N/A

Suburb boundary

Polygon on suburb

TheLIST open data

Dem4maslpoly

Polygon of all land below 4 m
aMSL

N/A

Land tenure

Polygons with land
classification extents

TheLIST open data
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Input layer

Geoprocessing Steps

Output layer

Comments

Ldrdem

ldrclip

1.1.3

1.1.4

Flood rasters

Location boundary
1.2.1 list_locality_
postcode_
kingborough

T5275242,
T5275241,
T5265242,
T5265241,
T5265240,
T5255242,
T5255241,
T5255240

1.1.2

Make Feature Layer

Resample

Clip

Mosaic to new raster

subkbeach

ldrclip2m

ldrclip

ldrdem

Data Management Tools > Layers and Table Views > Make Feature
Layer
Expression: NAME = ‘Kingston Beach’. Other setting default.

Data Management Tools > Raster > Raster Processing > Resample
Convert to 2mx2m raster grid cells; X = 2, Y = 2; Resampling technique =
Bilinear method.

Data Management Tools > Raster > Raster Processing > Clip
Input raster = ldrdem; Output Extent = taslga; Other details default
selection.

Data Management Tools > Raster > Raster Dataset > Mosaic to New
Raster
Spatial reference = GDA_1994_MGA_Zone_55; Pixel Type =
32_BIT_FLOAT; Other details default selection.

1. Data preparation (DEM data; land use; 1 %, 2 %, 5 %, 20 % AEP flood baseline; beach transects)
LiDAR data
1.1.1 <All LiDAR files>
Define Projection
<All LiDAR files>
Data Management Tools > Projections and Transformations >
(In ArcCatalog)
Raster > Define Projection

ID

Table B.3.3 Summary of geoprocessing steps undertaken to produce model outputs in the impact assessment. Blue text indicates the location of the
geoprocessing tool in ArcMap (i.e. for use in ModelBuilder), whilst green text shows the python code used for that step in the script.
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AEP1flood

1.3.5

Add points

New feature class
(In ArcCatalog)

Resample

1.3.8

Repeat step 1.3.7 for 2%,
5% and 20% flood rasters

Spline with Barriers
(interpolation)

-

1.3.4

AEP1flood

<All baseline flood
files>

1.3.3

Conversion to Raster

1.3.7

<All baseline flood
files>

1.3.2

Define Projection
(In ArcCatalog)

Repeat steps 1.3.4 and
1.3.5 for 2%, 5% and 20%
flood rasters

<All baseline flood
files>

1.3.1

Geoprocessing Steps

1.3.6

Input layer

ID

Spline_BL_1

-

AEP1flood

<All baseline flood
files>

<All baseline flood
files>

<All baseline flood
files>

Output layer

3D Analyst Tools > Raster Interpolation > Spline with Barriers
Z value field = Baseline; Input barrier features = dem4maslpoly; Output cell
size = 2. Other values default.

Editor toolbar. Add 100-130 randomly placed points to cover extent of flood
raster; Higher concentration of points near exposed houses to improve
accuracy of proxy raster; Add attribute (i.e. z value at point) for baseline,
baseline+1mSLR (and BL+2mSLR)

Type = point features; Geometry properties -> Coordinates include z
values. Used to store 3D data. XY coordinates = GDA 1994 MGA Zone 55;
Vertical coordinates = AHD (Tasmania); Tolerance = default (0.001m);
Other details all default selection; Add columns; Baseline; SLR_1m
(SLR_2m); Type = Float

Data Management Tools > Raster > Raster Processing > Resample
Cell size: X = 2m; Y = 2m; Resampling Technique = BILINEAR

Conversion Tools > To Raster > ASCII to Raster
Output = float

Data Management Tools > Projections and Transformations >
Raster > Define Projection
Coordinate system GDA 1994 MGA Zone 55)

Comments
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MWHS_ldrclip2m

MWHS_ldrclip2m,
slr_surface

slr_extent

2.3

2.4

2.5

Con

Less Than Equal

Calculate Cell Statistics

slr_extent_con

slr_extent

MWHS_ldrclip2m

slr_surface

Create Constant Raster

[Number] Vertical
sea level rise

Output layer

2.2

Geoprocessing Steps

MWHS_ldrclip2m

Input layer

2. [Average Beach Width] Permanent sea level rise
2.1
ldrclip2m
Minus

ID

Spatial Analyst Tools > Conditional > Con
If cell has a value of 1, then keep it, otherwise ‘no data’. Expression: Value
= 1; all other values default.
arcpy.gp.Con_sa(slr_extent, CONDITION_TRUE, slr_ext_con, "",
"Value =1")

Spatial Analyst Tools > Math > Logical> Less Than Equal
Evaluates if DEM less than water elevation. If so, value = 1.
arcpy.gp.LessThanEqual_sa(MWHS_ldrclip2m, slr_surface,
slr_extent)

Spatial Analyst Tools > Local > Cell Statistics
All settings default.
arcpy.CalculateStatistics_management(MWHS_ldrclip2m, "1", "1", "",
"OVERWRITE", Area_of_Interest)

Spatial Analyst Tools > Raster Creation > Constant Value
Creates a constant raster with values equal to the vertical sea level rise,
relative to MWHS data (0m elevation). Constant value = constant value;
Output data type = FLOAT; Output cell size = 2; Output extent = “524950
5239950 527847 5243050”
arcpy.gp.CreateConstantRaster_sa(slr_surface, CONSTANT_SLR,
"FLOAT", "2", "524950 5239950 527847 5243050")

3D Analyst Tools > Raster Math > Minus
Converts vertical DEM data (LiDAR) from AHD to MHWS by subtracting
0.62 from the ldrclip raster.
arcpy.gp.Minus_sa(ldrclip2m, MHWS_ADJUST, MWHS_ldrclip2m)

Comments
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Input layer

slr_ext_con

slrgroup

TD2DLanduse_Bu
ildings

private_houses

beachtrans1,
slr_poly

beachwid1

ID

2.6

2.7

2.8

2.9

2.10

2.11

Table to Numpy Array

Erase Analysis

Make Feature Layer

Select Analysis

Raster to Polygon

Region Group

Geoprocessing Steps

Transect1

beachwid1

houses

private_houses

slr_poly

slrgroup

Output layer

Converts table into a Numpy structured array, allowing the ‘length’ of the
transect line to be extracted
arcpy.da.TableToNumPyArray(arcpy.Erase_analysis(beachtrans1,slr_
bruun, beachwid1, ""),'SHAPE_Length')

Analysis Tools > Overlay > Erase
Subtract the overlapping sea level rise polygon from the horizontal transect
line
arcpy.Erase_analysis(beachtrans1,slr_poly, beachwid1, "")

Data Management Tools > Layers and Table Views > Make Feature
Layer
arcpy.MakeFeatureLayer_management(private_houses,"houses")

Analysis Tools > Extract > Select
TYPE = Residential
arcpy.Select_analysis(T2DLanduse_Buildings, private_houses, "TYPE
= 'Residential'")

Conversion Tools > From Raster > Raster to Polygon
Field = value. Simplify polygons checked.
arcpy.RasterToPolygon_conversion(slrgroup, slr_poly, "SIMPLIFY",
"Value")

Spatial Analyst Tools > Generalization > Group
Assigns a number to each connected group of cells. Number of neighbours
to use = EIGHT; Zone grouping method = WITHIN. Other fields default.
arcpy.gp.RegionGroup_sa(slr_ext_con, slrgroup, "EIGHT", "WITHIN",
"NO_LINK", "")

Comments
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Output layer

Define Projection

BL1surrogate

3.4

Run defined function:
‘RasterScenario’
[See Note 1]

NumpyArrary to Raster

BL1spline,
SLRscn,
Rainfallscn

3.3

3.2

BL1surrogate

BL1surrogate

3. [AAD private dwellings] Temporary coastal flooding
3.1
Spline1aep
Raster to NumpyArray
BL1spline

Average

[Length] The
length of all 5
transect lines

2.13

Geoprocessing Steps

Repeat steps 2.10 to 2.11
for transects 2 through to 5

Input layer

2.12

ID

arcpy.DefineProjection_management(BL1surrogate, spatialReference)

Converts the NumPy array back to a raster
descData=arcpy.Describe(rastext); cellSize=descData.meanCellHeight;
extent=descData.Extent; HATData=arcpy.Describe(MWHS_ldrclip2m);
spatialReference=HATData.spatialReference;
pnt=arcpy.Point(extent.XMin,extent.YMin)
BL1surrogate =
arcpy.NumPyArrayToRaster(newras,pnt,cellSize,cellSize)
BL1surrogate.save("C:\\Users\\tdramm\\Desktop\\GIS\\Concept.gdb\\B
L1surrogate")

Run function to generate proxy raster for 1% AEP flood with sea level rise
and rainfall intensity factors determined using rule of thumbs. Converts
baseline 1% AEP raster into NumPy array, before applying the rules of
thumb to create a new NumPy array.
RasterScenario(BL1spline, SLRscn, Rainfallscn)

Convert raster into Numpy array
arcpy.RasterToNumPyArray(spline1aep,nodata_to_value=0)

Take the average of the 5 transect lines
np.average([Transect_1_sum, Transect_2_sum, Transect_3_sum,
Transect_4_sum, Transect_5_sum])

Comments
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Input layer

ldrclip2m,
BL1surrogate

fld_extent,
BL1surrogate

fld_extent

fld_poly

fld_poly_sel

private_houses

ID

3.5

3.6

3.7

3.8

3.9

3.10

Make feature layer

Select analysis

Select analysis

Raster to Polygon

Con

Less than equal

Geoprocessing Steps

houses

max_fld_poly

fld_poly_sel

fld_poly

fld_ext_con

fld_extent

Output layer

Data Management Tools > Layers and Table Views > Make Feature
Layer
arcpy.MakeFeatureLayer_management(private_houses,"houses")

Analysis Tools > Extract > Select
Expression: Shape_Area=(SELECT MAX(Shape_Area) FROM
fld_poly_sel)
arcpy.Select_analysis(fld_poly_sel, max_fld_poly,
"Shape_Area=(SELECT MAX(Shape_Area) FROM fld_poly_sel)")

Analysis Tools > Extract > Select
Expression: Gridcode = 1
arcpy.Select_analysis(fld_poly, fld_poly_sel, "gridcode=1")

Conversion Tools > From Raster > Raster to Polygon
Field = value. Simplify polygons checked
arcpy.RasterToPolygon_conversion(fld_extent, fld_poly, "SIMPLIFY",
"Value")

Spatial Analyst Tools > Conditional > Con
If cell has a value of 1, then keep it, otherwise ‘no data’. Expression: Value
= 1; all other values default.
arcpy.gp.Con_sa(fld_extent, BL1surrogate, fld_ext_con, "", "Value
=1")

Spatial Analyst Tools > Math > Logical> Less Than Equal
Evaluates if DEM less than proxy flood raster. If so, value =1.
arcpy.gp.LessThanEqual_sa(ldrclip2m, BL1surrogate, fld_extent)

Comments
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Input layer

BL1surrogate,
ldrclip2m

difffld,
max_fld_poly

houses,
max_fld_poly

private_houses

flddepth,houses,
max_fld_poly

house_dam1

ID

3.11

3.12

3.12

3.14

3.15

3.16

Raster to NumpyArrary

Extract By Mask

Make Feature Layer

Select Layer By Location

Extract by mask

Minus

Geoprocessing Steps

flddamarray

house_dam1

houserisk1

<selection>

flddepth

difffld

Output layer

Raster data convert into an array
arcpy.RasterToNumPyArray(house_dam1,nodata_to_value=0)

Spatial Analyst > Extraction > Extract by Mask
Note the ‘Select Layer by Location’ is embedded into this code, to extract
flood depths at locations which overlap with houses.
arcpy.gp.ExtractByMask_sa(flddepth,
arcpy.SelectLayerByLocation_management("houses", "INTERSECT",
max_fld_poly, "", "NEW_SELECTION", "NOT_INVERT"), house_dam1)

Data Management Tools > Layers and Table Views > Make Feature
Layer
arcpy.MakeFeatureLayer_management(private_houses, houserisk1,
"", "", "OBJECTID VISIBLE NONE;Shape Shape VISIBLE NONE;Entity
Entity VISIBLE NONE;Shape_Length Shape_Length VISIBLE
NONE;Shape_Area Shape_Area VISIBLE NONE;Av_ppl_per_dwelling
Av_ppl_per_dwelling VISIBLE NONE")

Data Management Tools > Layers and Table Views > Select Layer By
Location
arcpy.SelectLayerByLocation_management("houses", "INTERSECT",
max_fld_poly, "", "NEW_SELECTION", "NOT_INVERT")

3D Analyst Tools > Raster Math > Minus
Subtracts the DEM from the flood water elevation raster
arcpy.Minus_3d(BL1surrogate, ldrclip2m, difffld)
Spatial Analyst > Extraction > Extract by Mask
Extracts the flood depth raster in the outline defined by the maximum
polygon for the flood – found in previous steps
arcpy.gp.ExtractByMask_sa(difffld, max_fld_poly, flddepth)

Comments
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rastvul [array]

fldoneimp,
fldonecont

3.20

3.21

Sum damages

Sum array values

Apply function: Raster
Damage (Contents)
[See Note 2]

NumPy trapezoidal rule

flddamarray,
MAX_CONTENTS
_DAMAGE, dften

3.19

Sum array values

3.23

rastvul [array]

3.18

Apply function: Raster
Damage (Structural)
[See Note 2]

Repeat steps 3.1 through
to 3.21 for 2%, 5% and
20% AEP flood events

flddamarray,
MAX_DAMAGE,
dften

3.17

Geoprocessing Steps

3.22

Input layer

ID

total_damage_one

fldonecont

rastvul [array]

fldoneimp

rastvul [array]

Output layer

Trapezoidal rule used to calculate the area under the curve (i.e. AAD).
np.trapz([Impact1%,Impact2%,Impact5%,Impact20%],x=[0.01,0.02,0
.05, 0.20])

The structural and contents damages are summed
total_damage_one = fldoneimp + fldonecont

All values in the array are summed
rastvul.sum()

Damage function applied to each value in the array
ContentDamage(flddamarray,MAX_CONTENTS_DAMAGE,dften)

All values in the array are summed
rastvul.sum()

Damage function applied to each value in the array
RasterDamage(flddamarray, MAX_DAMAGE, dften)

Comments
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Input layer

Geoprocessing Steps

Repeat steps 4.1 through
to 4.2 for 2%, 5% and
20% AEP flood events

NumPy trapezoidal rule

4.4

Trapezoidal rule used to calculate the area under the curve (i.e. AAPE).
np.trapz([Impact1%,Impact2%,Impact5%.
Impact20%],x=[0.01,0.02,0.05, 0.20])

Approximate number of people exposed is determined
AV_PPL_HOUSE * float(fldone_house)

Determine average
number of people

Data Management Tools > Layers and Table Views > Select Layer
By Location
arcpy.SelectLayerByLocation_management("houses",
"INTERSECT", max_fld_poly, "", "NEW_SELECTION",
"NOT_INVERT")

Comments

The number of houses inundated are counted
arcpy.GetCount_management(arcpy.SelectLayerByLocation_mana
gement("houses", "INTERSECT", max_fld_poly, "",
"NEW_SELECTION", "NOT_INVERT"))

Output layer

Get Count

4.3

4.2

4. [AAPE] Temporary coastal flooding
4.1
Select Layer by Location

ID
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to_csv

Geoprocessing Steps

Output layer

Comments

Output results in database to csv file
outfile = "C:\\Users\\tdramm\\Desktop\\GIS\\Results\\2017-0509_CaseStudyResults.csv"
RScenario.to_csv(outfile)
Note 1: RasterScenario – Adjusts the values of the raster cells (for peak flood water elevation) using the factor values of the case of
interest and the associated 1 %, 2 %, 5 % and 20 % AEP flood baseline. The function is run on a NumPy array.
Note 2: RasterDamage – Applied the vulnerability relationships (Appendix B.4) for structural and contents damage to the individual raster
cells in the NumPy array, based upon the inundation depth

ID
Input layer
5. Write results to files
5.1
[Case database]

B.4 Vulnerability curve approximations
The vulnerability curves used in the impact model are shown below for the dwelling
structure (Table B.4.1 and Figure B.4.1) and contents (Table B.4.2 and Figure B.4.2).
The data was taken from Geosciences Australia (2012) and based upon the model
developed for a one-storey, Victorian residential terrace house in South Sydney
(ACFS1a), which was considered in the illustration to be an adequate representation of
a typical dwelling in Kingston Beach.
Table B.4.1 Structure damage index for ACFS1a dwelling. The predicted damage index
using the relationship derived in Figure B.4.1 is also shown, along with the variance.
Inundation depth
(m)
-0.3
0
0.1
0.3
0.5
1
1.5
2.4
2.7
3.0

Fabric / Structure
Damage Index
(1)
0.03
0.05
0.26
0.31
0.31
0.34
0.38
0.47
0.48
0.54

Predicted
(2)

Variance
(1) – (2)

Not applied
Not applied
0.24
0.30
0.33
0.38
0.42
0.46
0.47
0.48

0.02
0.01
-0.02
-0.04
-0.04
0.01
0.01
0.06

Figure B.4.1 Mathematical approximations of structural damage index based upon
inundation depth for a 1-storey, Victorian residential terrace dwelling with no basement. The
correlation coefficient (R2) also shown for supporting equations.
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Table B.4.2 Contents damage index for FCM10 dwelling without goods saved and insured.
The predicted damage index using the relationship derived in Figure B.4.2 is also shown,
along with the variance. Assume contents damage from >0.1 m (approx. depth of slab on
ground).
Inundation depth

Contents
Damage Index

Predicted
(2)

Variance
(1) – (2)

Not applied
0.29
0.39
0.45
0.54
0.61
0.66
0.70
0.74

0.02
-0.04
-0.06
0.11
0.05
0.02
-0.02
-0.06

Note 1

(1)
0.05
0.25
0.1
0.25
0.3
0.25
0.5
0.25
1.0
0.28
1.5
0.29
2.0
0.42
2.5
0.46
3.0
0.68
Note 1: Goods not saved – insured

Figure B.4.2 Mathematical approximations of contents damage index based upon inundation
depth for a one-storey, dwelling with slab on ground and cavity masonry construction. The
correlation coefficient (R2) also shown for supporting equation.
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B.5 Detailed results for scenario discovery
Date of analysis:

29-May-17

R package:

Sdtoolkit

Script:

ArcGIS_Example.r

Results database:

2017-05-25CaseStudyResults.csv

Number of cases:

1,000

The following thresholds (adaptation tipping points) were defined (refer to Table 3.1 of
Chapter 3):


AAD = $650,000 / year



AAPE = 23.5 people / year



Beach Width = 5 m

B.5.1 General
A histogram of impacts from all cases against the three objectives are shown in Figure
B.5.1 and boxplots are shown in Figure B.5.2.
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Figure B.5.1 Histogram of the impacts of all cases against AAD (top panel), AAPE (middle
panel) and beach width (bottom panel). Adaptation tipping point thresholds are shown by the
blue dashed lines.

176

Figure B.5.2 Boxplot of impacts in each case for the three adaptation objectives.

B.5.2 Average annual damages (AAD)
The results database consists of the following:


Number of cases < AAD_thresh = 167



Number of cases >= AAD_thresh = 833

Based on the above figures and understanding that PRIM is better run on the smaller set
of data, cases of interest are those that are less than AAD_thresh.
A scatter plot of the individual factors in the case and the impacts to the AAD objective
are shown in Figure B.5.3.
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Figure B.5.3 Scatter plot showing input variables and their influence on the AAD adaptation
objective.

The correlation (linear) between factors and AAD are shown below:

The correlations suggest that rainfall has the greatest influence on the AAD, followed by
the maxstructure factor and then maxcontents.
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The sdtoolkit package (PRIM) is run with the following command:


sdprim(inputs, output, thresh=AAD_thresh,threshtype="<",peel_crit = 1)

The peeling trajectory (trade-off between coverage and density) is shown in Figure B.5.4,
along with the boxes of interest numbered and ‘dims’ contours shown (i.e.
coverage/density values achieved whilst holding the total number of restricted
dimensions constant). Peeling is a process where the input space is progressively
reduced along one dimension (peeled away). This produces increasingly smaller and
denser boxes which describe candidate scenarios (boxes). The resulting set of boxes is
called the peeling trajectory (Byrant & Lempert, 2010)

Figure B.5.4 Peeling trajectory from the PRIM analysis. Box of interest are numbered.
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A summary of the density, coverage, support and dimensions for each numbered
candidate boxes is shown below.

Boxes 14, 20 and 24 were selected as being of interest, with a preference of higher
density boxes. Box 25 was also considered with density of 100%
The general steps followed to assess the merits of each box (candidate scenario) of
interest were as follows:
1.

Select the candidate box;

2.

Observe the marginal contributions of factors constrained in the box;

3.

Check the reproducibility statistics (maintain those greater than 0.8);

4.

Check the qp-value (remove factor if qp<0.05).

Try ‘Box 20’. Results for the iterations as shown in Table B.5.1.

Table B.5.1 Results for the iterations.
Objective
AAD

Box 20
Measures of
scenario merit
Coverage
Density
Uncertain factor
Rainfall intensity
Max structure
Max contents

Box 20(1)*
value
75%
76%

value
61%
87%
p-value

p-value

<6.35
6.9e-25
<6.35
7.4e-25
<6144
5.9e-24
<6144
7.0e-24
<1995
2.7e-03
* The max contents factor was removed as it did not meet the reproducibility statistics
criteria.
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Contingency tables can provide further insight to decision-makers about the reliability of
the candidate scenarios in correctly identifying key factors and cases of interest. The
corresponding contingency table for the results of Box 20(1) are shown in Table B.5.2.

Table B.5.2 Contingency table for the candidate scenario.
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive (TP) =
125 125/167
interesting cases
captured

Unacceptable AAD
False positive (FP)
= 39

Totals
Total In scenario box =164
125/164 captured cases
interesting

False negative (FN) =
42

True negative (TN)
= 794

Total Out scenario box = 836

Total AAD pass = 167
cases of interest

Total AAD fail = 833

TOTAL = 1000

The candidate scenario has an accuracy of 91.9 % (i.e. (TP+TN)/(TP+FP+FN+TN)).
Try ‘Box 14’. Results for the iterations as shown in Table B.5.3.

Table B.5.3 Results for the iterations.
Objective
AAD

Box 14
Measures of
scenario merit
Coverage
Density
Uncertain factor
Rainfall intensity
Max structure

value
89%
66%
<6.35%
<6991

p-value
4.7e-27
1.5e-18

The corresponding contingency table for the results of Box 14 are shown in Table B.5.4.

181

Table B.5.4 Contingency table for the candidate scenario.
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive =
149 149/167
interesting cases
captured
False negative =
18

Unacceptable AAD
False positive = 75

Totals
Total In scenario box =224
149/224 captured cases
interesting

True negative = 758

Total Out scenario box = 776

Total AAD pass = 167
cases of interest

Total AAD fail = 833

TOTAL = 1000

The candidate scenario has an accuracy of 90.1 %.
Try ‘Box 24’. Results for the iterations as shown in Table B.5.5. Note covering occurred
across 2 iterations (with Box 28 selected in the second iteration).

Table B.5.5 Results for the iterations.
Objective
Measures of
AAD
scenario merit
Coverage
Density
Uncertain factor
Rainfall
intensity
Maxi structure
Max contents
SLR

Box 24
value
44%
98%

Box 28
value
26%
93%

p-value
<3.9%
<5956
<1792

1.1e-25
8.3e-24
8.0e-05

Box 28(2)*
value
26%
93%

p-value
< -3.7
<6851.5

2.4e-26
1.3e-13

<0.975

6.4e-1

Both
value
44%
98%

p-value
< -3.7
<6851.5

5.2e-27
4.8e-14

* The SLR factor was removed as it did not meet the criteria.

The corresponding contingency table for the results of the combined boxes are shown in
Table B.5.6.
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Table B.5.6 Contingency table for the candidate scenario.
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive = 118
118/167 interesting
cases captured
False negative = 49

Unacceptable AAD
False positive = 4

True negative = 829

Totals
Total In scenario box =122
118/122 captured cases
interesting
Total Out scenario box = 878

Total AAD pass = 167
cases of interest

Total AAD fail = 833

TOTAL = 1000

The candidate scenario has an accuracy of 94.7 %.
Try ‘Box 25’. Results for the iterations as shown in Table B.5.7.

Table B.5.7 Results for the iterations.
Objective
AAD

Box 25
Measures of
scenario merit
Coverage
Density
Uncertain factor
Rainfall intensity
Maxi structure
Max contents
SLR

value
40%
100%

Box 24
value
35%
86%

p-value
<3.9%
<5807
<1792

8.0e-25
4.4e-23
2.5e-05

Box 24(1)*
value
35%
86%

p-value
< -1.1
<6791

1.7e-28
4.3e-17

< 0.975

5.8e-1

Both
value
75%
93%

p-value
< -1.1
<6791

2.3e-29
1.8e-17

* The SLR factor was removed as it did not meet the criteria.

The corresponding contingency table for the results of the combined boxes are shown in
Table B.5.8.
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Table B.5.8 Contingency table for the candidate scenario.
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive = 126
126/167 interesting
cases captured
False negative = 41

Unacceptable AAD
False positive = 9

True negative = 824

Totals
Total In scenario box =135
125/135 captured cases
interesting
Total Out scenario box = 865

Total AAD pass = 167
cases of interest

Total AAD fail = 833

TOTAL = 1000

The candidate scenario has an accuracy of 95 %.
Conclusion: Choose Box 20 as the candidate scenario as it is easiest to interpret (2
constrained factors) and achieve a reasonable trade-off between coverage and density.

B.5.3 Average annual people exposed (AAPE)
The results database consists of the following:


Number of cases < AAPE_thresh = 194



Number of cases >= AAPE_thresh = 806

Based on the above figures and understanding that PRIM is better run on the smaller set
of data, cases of interest are those that are less than AAPE_thresh.
A scatter plot of the individual factors in the case and the impacts to the AAPE objective
are shown in Figure B.5.5.
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Figure B.5.5 Scatter plot showing input variables and their influence on the AAPE adaptation
objective.

The correlation (linear) between factors and AAPE are shown below:
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The correlations suggest that rainfall has the greatest influence on the AAPE, followed
by the av_ppl factor.
The sdtoolkit package (PRIM) is run with the following command:


sdprim(inputs, output, thresh=AAPE_thresh,threshtype="<",peel_crit = 1)

The peeling trajectory (trade-off between coverage and density) is shown in Figure B.5.6,
along with the boxes of interest numbered.

Figure B.5.6 Peeling trajectory from the PRIM analysis. Box of interest are numbered.
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A summary of the density, coverage, support and dimensions for each numbered
candidate boxes is shown below.

Boxes 14 and 16 were selected as being of interest, with a preference of higher density
boxes.
The general steps followed to assess the merits of each box (candidate scenario) of
interest were as follows:
1.

Select the candidate box;

2.

Observe the marginal contributions of factors constrained in the box;

3.

Check the reproducibility statistics (maintain those greater than 0.8);

4.

Check the qp-value (remove factor if qp<0.05).

Try ‘Box 14’. Results for the iterations as shown in Table B.5.9.
Table B.5.9 Results for the iterations.
Objective
AAPE

Box 14
Measures of
scenario merit
Coverage
Density
Uncertain factor
Rainfall intensity
Av_ppl

value
73%
88%
p-value
<4.8
<2.45

5.3e-41
1.8e-27

The corresponding contingency table for the results of Box 14 are shown in Table B.5.10.
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Table B.5.10 Contingency table for the candidate scenario.
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive = 142
142/194 interesting
cases captured
False negative = 52

Unacceptable AAD
False positive = 19

True negative = 787

Totals
Total In scenario box =161
142/161 captured
cases interesting
Total Out scenario box = 839

Total AAD pass = 194
cases of interest

Total AAD fail = 806

TOTAL = 1000

The candidate scenario has an accuracy of 92.9 %.
Try ‘Box 16’. Results for the iterations as shown in Table B.5.11.

Table B.5.11 Results for the iterations.
Objective
1: AAPE

Box 16
Measures of
scenario merit
Coverage
Density
Uncertain factor
Rainfall intensity
Av_ppl

Box 16

value
53%
97%

Both

88%
72%

35%
52%
p-value

<3.45
<2.35

2.0e-38
1.7e-27

< 4.55
< 2.65

2.5e-21
3.3e-9

The corresponding contingency table for the results of Box 16 are shown in Table B.5.12.

Table B.5.12 Contingency table for the candidate scenario
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive = 172
172/194 interesting
cases captured

Unacceptable AAD
False positive = 65

False negative = 22

True negative = 741

Total AAD pass = 194
cases of interest

Total AAD fail = 806

Totals
Total In scenario box
=237
172/237 captured
cases interesting
Total Out scenario box =
763
TOTAL = 1000
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The candidate scenario has an accuracy of 91.3%.
Conclusion: Choose Box 14 as the candidate scenario as it is easiest to interpret (2
constrained factors) and achieve a reasonable trade-off between coverage and density

B.5.4 Average beach width
The results database consists of the following:


Number of cases < Beach_thresh = 680



Number of cases >= Beach_thresh = 320

Based on the above figures and understanding that PRIM is better run on the smaller set
of data, cases of interest are those that are greater than Beach_thresh.
A scatter plot of the individual factors in the case and the impacts to the beach width
objective are shown in Figure B.5.7.
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Figure B.5.7 Scatter plot showing input variables and their influence on the beach width
adaptation objective.

The correlation (linear) between factors and beach width are shown below:

The correlations suggest that SLR has the greatest influence on the beach width,
followed by the bruun_factor factor. Note that the correlation is negative in this instance.
The sdtoolkit package (PRIM) is run with the following command:


sdprim(inputs, output, thresh=Beach_thresh,threshtype=">",peel_crit = 1)
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The peeling trajectory (trade-off between coverage and density) is shown in Figure B.5.8,
along with the boxes of interest numbered.

Figure B.5.8 Peeling trajectory from the PRIM analysis. Box of interest are numbered.

A summary of the density, coverage, support and dimensions for each numbered
candidate boxes is shown below.

Boxes 11 and 13 were selected as being of interest, with a preference of higher density
boxes. Also consider Box 15 with a density of 100 %.

191

The general steps followed to assess the merits of each box (candidate scenario) of
interest were as follows:
1.

Select the candidate box;

2.

Observe the marginal contributions of factors constrained in the box;

3.

Check the reproducibility statistics (maintain those greater than 0.8);

4.

Check the qp-value (remove factor if qp<0.05).

Try ‘Box 11’. Results for the iterations as shown in Table B.5.13.
Table B.5.13 Results for the iterations.
Objective
Beach
width

Box 11
Measures of scenario
merit
Coverage
Density
Uncertain factor
SLR
Bruun

value
81%
91%
<0.355cm
<91.5

p-value
4.4e-89
1.6e-02

The corresponding contingency table for the results of Box 11 are shown in Table B.5.14.

Table B.5.14 Contingency table for the candidate scenario.
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive = 261
261/320 interesting
cases captured
False negative = 59

Unacceptable AAD
False positive = 29

True negative = 651

Totals
Total In scenario box =290
261/290 captured
cases interesting
Total Out scenario box = 710

Total AAD pass = 320
cases of interest

Total AAD fail = 680

TOTAL = 1000

The candidate scenario has an accuracy of 91.2 %.
Try ‘Box 13’. Results for the iterations as shown in Table B.5.15.
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Table B.5.15 Results for the iterations.
Objective
Beach
width

Box 13
Measures of scenario
merit
Coverage
Density
Uncertain factor
SLR
Bruun

value
70%
97%
<0.315cm
<83.5

p-value
9.1e-92
6.0e-06

The corresponding contingency table for the results of Box 13 are shown in Table B.5.16.
Table B.5.16 Contingency table for the candidate scenario.
Cases in
candidate
scenario
Cases not in
candidate
scenario
Totals

Acceptable AAD
True positive = 226
226/320 interesting
cases captured
False negative = 94

Unacceptable AAD
False positive = 6

Total AAD pass = 320
cases of interest

Total AAD fail = 680

True negative = 674

Totals
Total In scenario box =232
226/232 captured
cases interesting
Total Out scenario box =
768
TOTAL = 1000

The candidate scenario has an accuracy of 90 %.
Conclusion: Choose Box 13 as the candidate scenario achieve a higher density.

B.5.5 Summary
The outputs from the scenario discovery analysis and selected candidate scenarios are
shown in Table B.5.17.
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Table B.5.17 Results of the scenario discovery process
Candidate scenario
Adaptation
Objective

Conditions (factors and values)

Cases of
interest

Coverage /
Density

1: AAPE

Rainfall intensity < 4.8%,
AND
Average people per dwelling < 2.4
Rainfall intensity < 6.3%
AND
Maximum structural damage < $1,536/m2
Sea level rise < 0.3m
AND
Bruun factor < 83

194 / 1000

73% / 88%

167 / 1000

75% / 76%

320 / 1000

70% / 97%

2: AAD

3: Beach
Width

This forms the basis of the results in Section 3.6 of Chapter 3.
The contingency table is repeated again in Table B.5.18 for the AAD objective.
Contingency tables can provide further insight to decision-makers about the reliability of
the candidate scenarios in correctly identifying key factors and cases of interest.

Table B.5.18 Two by two contingency table of the candidate scenario for the AAD objective.
This demonstrates the ability of the candidate scenario to correctly identify key factors and
cases of interest. Underlined values were input using data from the density and coverage
measures.
Acceptable AAD

Unacceptable AAD

Totals

Cases in
candidate
scenario

True positive (TP)
= 125

False positive (FP)
= 39

Total In scenario box
= 164

Cases not in
candidate
scenario

False negative (FN)
= 42

True negative (TN)
= 794

Total Out scenario box
= 836

Totals

Total AAD pass
= 167

Total AAD fail
= 833

TOTAL CASES
= 1000

The PRIM algorithm suggests that the candidate scenario captures 75 % of all cases of
interest (i.e. cases with acceptable AAD), with 25 % not captured as false negatives. The
density measure suggests 76 % of cases captured by the scenario are cases of interest.
The accuracy of the candidate scenario in correctly classifying cases is 92 % (i.e.
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(TP+TN)/(all cases)). The relatively low percentage of false positives in the candidate
scenarios suggest that although scenario discovery does not guarantee all cases of
interest are captured in the candidate scenarios (recall coverage and density trade-offs),
there is a reasonable degree of confidence in its ability to classify cases of interest.
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C.1 Place-based observations form
Date

Start time

End time

Observed by

_________________

_________________

_________________

_________________

Weather

Hobart
(Stn ID 094029)

Dennes
Point
(Stn ID 094255)

Temperature

______________

_____________

Wind Speed

______________

_____________

Wind Direction

______________

_____________

Weather (on site)
 Sunny
Overcast

Wind (on site)
Partly cloudy

Clam

Light winds

Moderate

Rainy

Fresh winds

Strong winds

Near gale

Gale

Approx swell/wave height _____________________

Location (as marked on map – attached)
 Esplanade
Kingston Beach

Dog Beach

Browns River

Boat Ramp

Boronia Beach

Other _____________________

[Note: Place the number of people observed in the sections below]
Kingston Beach Esplanade (behind sea wall)
Activity

Adults

Children

BBQ

__________

__________

Bike riding

__________

Café / Dining

Activity

Adults

Children

Picnic

__________

__________

__________

Sitting (car or bench)

__________

__________

__________

__________

Walking

__________

__________

Dog walking

__________

__________

_______________

__________

__________

Jogging

__________

__________

_______________

__________

__________

Notes: _______________________________________________________________
_____________________________________________________________________
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Kingston Beach (sand; excludes dog beach)
Activity

Adults

Children

BBQ

__________

__________

Beach volleyball

__________

Paddle / body board

Activity

Adults

Children

Playing (sand)

__________

__________

__________

Sitting

__________

__________

__________

__________

Surf lifesaving

__________

__________

Fishing

__________

__________

Swimming / Wading

__________

__________

Jogging

__________

__________

Walking

__________

__________

Kayaking / canoe

__________

__________

_______________

__________

__________

Picnic

__________

__________

_______________

__________

__________

Play equipment

__________

__________

_______________

__________

__________

Notes: _______________________________________________________________
_____________________________________________________________________

Dog Beach – Tyndall / Kingston Beach (sand; south of Browns River foot bridge)
Activity

Adults

Children

Dog walking

__________

__________

Fishing

__________

Jogging

Activity

Adults

Children

Playing (sand)

__________

__________

__________

Sitting

__________

__________

__________

__________

Swimming / Wading

__________

__________

Kayaking / canoe

__________

__________

Walking

__________

__________

Picnic

__________

__________

_______________

__________

__________

Notes: _______________________________________________________________
_____________________________________________________________________

Boat Ramp / Breakwater
Activity

Adults

Children

Boating

__________

__________

Café

__________

Fishing
Sailing

Activity

Adults

Children

Sitting

__________

__________

__________

Walking

__________

__________

__________

__________

_______________

__________

__________

__________

__________

_______________

__________

__________

Notes: _______________________________________________________________
_____________________________________________________________________
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Browns River (riverbank and flood plain)
Activity

Adults

Children

Activity

Adults

Children

BBQ

__________

__________

Kayaking / canoe

__________

__________

Bike riding

__________

__________

Picnic

__________

__________

Dog walking

__________

__________

Play equipment

__________

__________

Duck feeding

__________

__________

Sitting

__________

__________

Golf

__________

__________

Walking

__________

__________

Fitness equipment

__________

__________

_______________

__________

__________

Jogging

__________

__________

_______________

__________

__________

Notes: _______________________________________________________________
_____________________________________________________________________

Boronia Beach (and walking track)
Activity

Adults

Children

Dog walking

__________

__________

Jogging

__________

Sitting

__________

Activity

Adults

Children

Swimming / Wading

__________

__________

__________

Walking

__________

__________

__________

_______________

__________

__________

Notes: _______________________________________________________________
_____________________________________________________________________
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Map of Kingston Beach area – observations and sketches

200

C.2 Semi-structured interview questions
Introductory
1.

How long have you lived in Kingston Beach?
a.

[x years] Why did you choose to live here?

b.

[All my life/since childhood] How long was your family here for? What
brought them here originally?

c.

What makes you stay here?

d.

Do you intend to continue living here?

Everyday life (lived values)
The next two questions are designed to get an understanding of people’s everyday lives.
What they do, who they interact with and the places they spend time. With that in mind:
2.

Please describe the main activities you can recall undertaking yesterday/last Friday
(if interview is conducted Tuesday-Friday/Monday) including where each activity
occurred, with whom and the amount of time you spent performing each one. The
order in which you undertook these activities is not important.
a.

Contracted time: What paid work or study did you engage in?

b.

Committed time: What household tasks, shopping, food preparation or care
(children or others) did you engage in?

c.
3.

Leisure: What leisure and social activities did you engage in?

Weekends: Please describe the main activities you can recall undertaking last
Saturday including where each activity occurred, with whom and the amount of time
you spent performing each one. The order in which you undertook these activities is
not important.
a.

Contracted time: What paid work or study did you engage in?

b.

Committed time: What household tasks, shopping, food preparation or care
(children or others) did you engage in?

c.

Leisure: What leisure and social activities did you engage in?
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Place attachment (place-based values))
For the next set of questions, please think specifically about the Kingston Beach area.
4.

In addition to (any) places you mentioned previously, are there any other places that
you spend time in in Kingston Beach?

5.

Are any of the places you have mentioned in some way special to you?
a.

6.

For what reasons?

How would you compare Kingston Beach with other places you have lived
in/travelled through?
a. Health: Are there things that you need that you can’t get here?
b. Safety: Do you feel safe and secure?
c. Belongingness: Do you feel like you belong here?
d. Esteem: Do you feel like you are a respected member of the community?
e. Self-actualisation: Does living here make you feel good about yourself?

7.

Does anything frustrate you about living here? (or need improving)

8.

If you could wave a magic wand what changes would you like to make to Kingston
Beach?
a. What if money was no issue?

9.

Overall, what would you say you value most about living here?
a. What are the most important aspects to your daily life?

Values assigned to natural coastal areas
For the next set of questions, please think specifically about natural coastal areas:
10. [Show a map of coast/explain where map is] Please identify what natural coastal
areas you value on this map (for any reason)? (talk about these areas)
11. [Show list of values assigned to coastal resources] From the list of values, which
ones are most important to you or resonate with you about the coastal natural areas
mentioned? (up to 10 values)
a. What ones do you associate with the areas mentioned above?
12. [Show map to be used in survey] Are there any places shown on this map that are
essential to your decision to stay in Kingston Beach, without which you would
consider relocating?
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Changing natural hazards
For the next set of questions, consider a possible scenario of sea level rise and/or
increase flooding of Browns River:
13. Do you think that increased coastal flooding (more frequent) would affect your ability
to enjoy the places you spend time in?
a.

What would be your concerns (or disruptions) to your way of life?

14. Have you ever experienced flooding (coastal or riverine) in Kingston Beach?
a. [Yes] Were there any impacts to your way of life?
i.

If a similar event became more frequent, at what point would you
consider taking action to protect your home or other areas?

b. [No] Consider a scenario that floods parts of Beach Road and Osborne
Esplanade for 12 hours (show on map).
i.

What do you think the impacts might be to your lifestyle?

ii.

What frequency of this type of flood would prompt you consider taking
action to protect your home or other natural coastal areas?

15. Consider Kingston Beach and the Dog Beach. Please consider whether the following
scenarios might impact on your lifestyle:
a. More frequent erosion events on the beach (temporary loss of area)?
b. The beach only being accessible at low tide?
c. Complete loss of the beach?
d. [If important] At what point would you consider action to protect the beach?
16. Where do you get information about flood risk in the area?
17. Who do you think is responsible for managing flood risk in the area, to protect built
and natural areas from loss and damage?

Wrap up
18. For the purposes of making sure we have a broad representation of the community:
a. Are you a member of any social groups? [Prompts: religious, sporting, local
associations?]
b. How old are you?
c. What is the highest level of education that you have achieved?
d. How many people usually live in your household?
e. [Gender by observation]
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19. Would you prefer a questionnaire in hardcopy form or as a web-based survey?
20. Do you have any further comments?

Values list for natural coastal areas
Value
Access
Aesthetic
Biodiversity
Cultural
Economic
Future
Historic
Identify/
symbolic
Intrinsic
Learning
Life sustaining
Recreation

Definition
I value these places because they are common property, free from
access restrictions of exclusive ownership/control.
I value these places for the enjoyable scenery, sights, sounds and
smells.
I value these places for the variety and abundance of fish, birds,
wildlife and plant life.
I value these places for passing down wisdom, knowledge and
traditions.
I value these places for tourism, fisheries (commercial/recreational)
and other business.
I value these places because future generations can know and
experience healthy, productive, and sustainable ecosystems.
I value these places for the natural and human history that matter to
individuals, communities, societies and nations.
I value these places because they engender a sense of place,
community and belonging.
I value these places because they exist, no matter what others think
about them or how we use them.
I value these places for the educational value.
I value these places because they help produce, support and
preserve human and natural life.
I value these places because they provide outdoor recreation
activities.

Spiritual / novel
experience
Subsistence

I value these places as sacred, religious, unique, and/or profound
experiences where respect for nature is felt.
I value these places because they provide basic human needs.

Therapeutic

I value these places because they enhance feelings of well-being
(an escape, stress relief, comfort and calm).
I value these places because of minimal human impact and/or
intrusion on the natural environment.

Natural
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C.3 Memo: Summary of semi-structured interview results
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Memorandum

To:
From:
CC:
Subject:

Sonia Graham
Date:
06 October 2016
Tim Ramm
Chris White, Andrew Chan, Christopher Watson
Coastal Values in the Suburb of Kingston Beach – Summary of place-based observations
and semi-structured interviews

1. Purpose
Place-based observations and semi-structured interviews have been conducted as part of the Kingston
Beach case study to gain insights into the use of coastal areas in Kingston Beach and the lived values that
exist (i.e. judgements made by individuals about with is important in their lives and places they live 1).
Consideration has also been given to place attachment, which has been conceptualised by some authors2
as consisting of
a. Place identify – dimensions of self, such as emotional connection to a place; and
b. Place dependence – a functional or goal-driven connection to place
The purpose of the place-based observations and semi-structured interviews is to capture these values, as
voiced by residents or expressed in everyday activities, and to use this information to finalise the content of
questions in the mailed out survey as part of this case study.

2. Place-based observations
Place-based observations occurred between 12-Mar-16 and 29-Mar-16. Eight separate site visits were
carried out to observe activities occurring in the coastal area at Kingston Beach. These site visits varied
across the time of day (from 9.50am to 6.30pm) and across weather conditions (from 14°C to 25°C; different
wind speeds, wind direction, swell conditions and cloud cover). The locations at which activities were
recorded was defined as being built areas (i.e. esplanade, boat ramp) and natural areas (i.e. Kingston main
beach, the dog beach, Browns River, the river floodplain and Boronia beach) – see Figure 1. Not all
built/natural areas were visited in each site visit.

1

Barnett, J, Fincher, BR, Hurlimann, A, Graham, S & Mortreux, C 2014, Equitable local outcomes in adaptation to sea-level rise: final
project report, University of Melbourne
2
Brown, G, Raymond, CM & Corcoran, J 2015, 'Mapping and measuring place attachment', Applied Geography, vol. 57, pp. 42-53.
University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

Figure 1 The left image shows an aerial photo of Kingston Beach and the right image shows the
categorisation of built and natural coastal areas where activities were observed

2.1 Value expressed through “everyday activities”
The top five activities observed in coastal areas in terms of people participating included dog walking,
café/dining, walking, sitting (car/wooden benches) and picnics (i.e. using bench facilities for eating). Other
notable activities included the use of play equipment, people playing on the sand (beach), non-motorised
watersport (e.g. kayaking), bike-riding and jogging.

3. Semi-structured interviews
3.1 Sample of semi-structured interview participants
Ten semi-structured interviews were conducted in the suburb of Kingston Beach, representing a mix of
resident who are directly in the 1% AEP 3 floodplain of Browns River and those outside the direct riverine and
coastal floodplain (Figure 2). Those participants recruited were those who voluntarily nominated their
willingness to be interviewed via a sign-up sheet at a community natural hazards event hosted by the
Council in March 2016.
A summary of interview participants’ demographic characteristics is shown in Table 2. Participants ranged in
age from 25 to 84 years; length of residence from 4 months through to 79 years; household size of 1-2
people; and highest level of education from year 10 through to postgraduate university studies.

3

Annual Exceedance Probability (AEP), equivalent to a flood event with an average recurrence interval of 100 years
University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

Figure 2 Geographic location of participants involved in the semi-structured interview (n=10). The left image
shows the areas against an approximate 1m sea-level rise with mean high spring water tide (light blue
shading); the right shows the locations against a theoretical 1-in-100 flood event with mean high spring water
tide (transparent white; data sourced from Kingborough Council). The black outlined shapes are the ABS
mesh block boundaries in the suburb.

Table 1 Summary of semi-structured interview participant characteristics compared to ABS census
information (2011)4 5 6
Characteristic
Median Age
Female: Male ratio
Average people per household
Full-time employment
People
Number of private dwellings
Median weekly household income
Index of relative socio-economic
disadvantage (IRSD index)*

Australia

Kingston Beach
Population

Semi-structured
interview

37
51:49
2.6
58%
21.5mil
9.1mil
$1,234

45
51:49
2.3
55%
2,004
965
$1,097

69
40:60
1.7
20%
10
10
-

1,000

1,049

-

* IRSD is a summary index derived from census data and indicates “the average socio-economic characteristics of
the people, families, and households living in the area”6 against the standardised average score of 1000. A higher
index score indicates a lessor disadvantage.

4

ABS 2011, 2011 Census QuickStats – Kingston Beach, ABS, viewed 04 October 2016,
http://www.censusdata.abs.gov.au/census_services/getproduct/census/2011/quickstat/SSC60179?opendocument&navpos=220.

5

ABS 2011, 2011 Census QuickStats – Australia, ABS, viewed 04 October 2016,
http://www.censusdata.abs.gov.au/census_services/getproduct/census/2011/quickstat/0

6
ABS 2011, 2033.0.55.001 - Census of Population and Housing: Socio-Economic Indexes for Areas, ABS, viewed 05 October 2016,
http://www.abs.gov.au/AUSSTATS/abs@.nsf/DetailsPage/2033.0.55.0012011?OpenDocument
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Although the median age of the suburb is 45, removal of those residents aged less than 18 years from the
2011 census data causes the median age to increase to 52. Removing people younger than 18 years is
defensible on the basis that it is unlikely people aged below this will own or rent a house in the area.
Furthermore, this case study is focused on those adult residents who make a decision to live in the area.
Recruitment of participants was difficult for the young family demographic. An attempt was made to recruit
this demographic through approaching local schools and day care businesses, but this was unsuccessful.
Due to time constraints a decision was made to proceed onto the survey.
The following sections summarises the main interview findings. Each interview was recorded and responses
transcribed. Responses were tallied and grouped, guided by a typology of lived values 7. Those lived values,
important places and everyday activities that were most frequently mentioned (valued), and have the
potential to be threatened by changing coastal flooding regimes will be used in the survey questions.

3.2 Section 1: Introductory
There was a mix of interview participants who had lived in the area for most of their life, residents whom had
relocated from the mainland and residents who had relocated from other areas in Tasmania.

3.3 Sections 2 and 3 – Lived values voiced by residents and everyday activities
Lived values were obtained from the interview question responses. These questions were based around the
attachment people assign to places and the reasons why they choose to live in the suburb. A detailed
version of the results is attached (see Attachment 1).
There were at least 22 lived values identified from the interviews. The top 10 lived values were as follows,
with the number of interviewees (n) shown in brackets (maximum n = 10 interviews):
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Friendly people / community feeling (n=8)
Ambience / atmosphere (n=7)
Proximity to important places (city, shops) (n=6) – rename this to “easy to get to places”
Location (e.g. near to river and beach) (n=6)
Unique natural environment (n=5) – rename this to “natural environment”
Outlook / views (to river, sea, mountain) (n=5) – rename this to “the scenery / views”
The birdlife (n=5)
Peacefulness (n=4)
Access to beach (n=4)
Relaxed lifestyle (n=4)

All the above values have the tendency to be impacted by changing coastal flooding regimes. Recreational
opportunities were not included in the above list. This information was captured or inferred through the
everyday activities, of which the top activities were walking (n=6); shopping (n=4); dog walking (n=3);
cooking / food preparation (n=3); gardening (n=3); house improvements (n=3); family spending time together
(n=3) and caring for family members (n=3). The popularity of walking matched up to the place-based
observations (Section 2 of this memo).
It is proposed that 19 lived values are carried through into the survey as shown in Table 2. Additional values
to the 10 mentioned above have been added to ensure values are included across the categories of health,
safety, belongingness, esteem and self-actualisation 7 – these are shown in bold italics.

7

Barnett, J, Fincher, BR, Hurlimann, A, Graham, S & Mortreux, C 2014, Equitable local outcomes in adaptation to sea-level rise: final
project report, University of Melbourne
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Table 2 Selected lived values for inclusion in the survey. ‘A unique place for children to grow up’ was
selected as a lived value given the young family demographic was under represented in the interviews.
Category

Health

Safety

Belongingness

Simple Definition

Basic physical and social determinants for
human survival

Feeling safe and secure in all aspects of life

Sense of belonging, tradition, history and
heritage and feeling close and connected to
others

Lived Value






Natural environment
Relaxed lifestyle
Peacefulness
The birdlife
Flat landscape






Easy to get to places
A unique place for children to grow up
Safe place to live
Affordability of housing






Friendly people / community feeling
Being close to family
Being close to friends
Family history in the area
Location
The scenery / views
Easy access to beach
Ambience / atmosphere
Recreational opportunities

Esteem

Prestige and feeling of accomplishment





Self-actualisation

Achieving full potential




The top 5 places that interviewees spent time at were the Kingston main beach (n=5); cafes, restaurants,
pubs (n=5); the dog beach (n=4); esplanade (n=3); and the Kingston Golf Club (n=3). Although the golf club
has experienced riverine flooding in the past and could be impacted by long-term inundation from sea-level
rise, the sandy beaches could also be threatened. Two notable special places were mentioned by residents
as part of the interview; the first a strong memory of their mother and daughter on a park bench on the
esplanade; the second a tree across from their fathers house where their mothers ashes were sprinkled
(Figure 3).
A family connection or family history in the suburb was valued by a couple of participants, with one resident
saying "you tend to go back to the places that you remember" and another one saying "...there is something
about that that draws you…" when referring to a location with a family connection.
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Figure 3 A special tree valued by an interview participant on the banks of Browns River

Section 4 – Values assigned to natural coastal areas
The top coastal areas (Figure 4) valued by interviewees for any reason included Kingston main beach
(n=10); Browns river (n=7); Boronia Beach / reserve (n=4); Alum cliffs / reserve (n=4) and the dog beach
(n=2). The golf course (grassland) was mentioned by some participants as being a “sanctuary for birdlife”.
This area is not currently on the survey map as a natural coastal area, but could be added on the basis that it
provides a natural function.
The top 5 values that resonated with participants most when thinking about the coastal natural areas were
aesthetic (n=9); access (n=8); therapeutic (n=8); biodiversity (n=7) and recreation (n=6), with Kingston main
beach (n=7), Browns River (n=5) and the Derwent / Sea (n=5) being the main natural area considered
essential to their decision to stay in the suburb.
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Figure 4 Map of natural coastal areas in the suburb.

3.4 Section 5 – Changing Natural Hazards
3.4.1 Past Flooding Events
Some of the interviewees had experienced past flooding of Browns River with varying impacts ranging from
nuisance flooding of their backyard a couple times per year in king tides (i.e. inundated up to about 30cm
depth), periodic flooding every few years that reaches its peak after a few hours (e.g. Figure 5 – left), through
to two residents experiencing flooding inside parts of their house. One of these residents was displaced to a
hotel for 6 weeks during repairs to their house (which were covered by insurance). Generally insurance did
not appear to be a problem to date for residents who had been flooded historically, with no issues reported
and claims being successfully lodged.
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Figure 5 The left photo shows backyard flooding (Browns River) in 2015. This right photo was provided by a
resident to shown the essence of why they value living in the area.
The main flooding impact to interviewees living next to the river after small floods was cleaning the backyard
from silt and debris - however this did not seem to cause them much disruption. One participant had resided
in the area for 79 years, recalling the biggest flood they experienced in the 1960’s as not impacting the
house structure at all, being 40cm below his floor level. When asked about and concerns with future flooding,
that resident stated that
"...what I have seen has not been increasing in the last 80 years… so I cannot expect too much in the last few
years I have left".

They also said that
"…my own knowledge of flood is better than anything that council can give me – I’ve watched those floods for
60 years so I know what the floods will do."

An additional concern mentioned by one resident when thinking about flooding was access to evacuate the
areas via Beach Road, whilst another mentioned the concern of house value and being worried about "the
next flood". They expanded on this concern by saying:
"… How do you invest in another one [home]? Presumably if you are going to be practical and sensible… I
wouldn’t be able to sell, so I wouldn’t be able to buy something else… so I’d do it [sell] now. That’s the sensible
thing to do… but there are all these other reasons why you think, oh well… "

In terms of coastal inundation from the sea, no participants had experienced any major events. One
participant noted that they had seen water washing debris up the ramp and onto the esplanade/road in the
last 6 years. Other sources8 suggest historic storms in the mid 1900’s had damaged the beach, damaged
former jetties, washed water into the door of businesses located on the esplanade, covered the beach in
thick kelp, had waves breaking over the esplanade and boats dragged from their moorings (see Attachment
2). In 1962, a sea wall was developed behind Kingston main beach 8 which provides protection, however
constrains any (future) horizontal recession of the beach with sea level rise.

8

p65-66, Gardam J 1988, Browns River: A history of Kingston and Blackmans Bay, Rotary Club of Kingston, Tasmania.
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3.4.2 Current Flood Risk Management
There was no strong source of information consistently cited by residents about flood risk. The council’s
recent natural hazards report and community displays were most commonly mentioned, albeit with mix views
about the information. The council was generally perceived to be responsible for managing flood risk on
behalf of the community, though one resident realistically recognised it be reasonable to expect to make a
contribution (through rates) to preserve beach amenity. Those interview participants that lived adjacent the
river based their flood risk assessments from personal experience, knowledge and word-of-mouth with
neighbours. Various residents who lived next to the river did keep an active interest in the dynamics of the
river, for example on resident said:
"…as part of my management of my property each year, I print out the tides from the BOM website and highlight
anything over 1.45m… and so that sits in my diary so I know if we get a big rain event or forecast rain… there
are probably things in the backyard that Ill move to higher ground… the lawn mower in the garden shed and
those sorts of things goes into the garage "...

Another resident also noted that:
"When we do flood badly, I always write the details of what happened – how much rain has fallen – what the
river looked like beforehand, and those sorts of things, and rainfall…"

One participant whose house had been flooded more than once in the past 8 years actually took further risk
mitigation measures on their property following the most recent flood. There is also evidence along the river
bank of ad-hoc attempts to prevent erosion of private land from the river with tyres, rocks and other
armouring. Undercutting of the riverbank can also be seen on the golf course side of the river and
undercutting of private land was mentioned as a concern by a resident living on the river.

3.4.3 Changing Future Coastal Flooding Regimes
When reflecting on possible climate change and increased coastal flooding, participants generally
recognised the transient nature of floods… “it comes and then it goes” one resident said. They went on to
speculate that future flooding might be "...a bit like the floods we have now but a bit higher...".
Residents were asked about what flooding scenarios might prompt them to take additional action to mitigate
flood impacts. Although a difficult and subjective question to pose, some of the responses were as follows:
 The backyard was underwater from days on end;
 If the house was flooded several times per year;
 If the level of coastal inundation ever came up to the house [i.e. into the house]; or
 If there was permanent inundation of land (instead of temporary flooding)
A resident on the esplanade said that:
"if it [the inundation] were a combination of sea level rise, a king tide and heavy rainfall on the mountain that
caused Browns River to flood... and that happened say even every 2 years, that wouldn’t really concern me…
But if it happened several times a year then I’d say no that is too much"
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Some older participants were less concerned with climate change impacts and projections to the year 2050
and beyond. One resident said the following in reference to impacts of climate change:
"...given that statistically I only have another 10 years to go, it is not therefore likely, so for me it is a very low
priority consideration…"

One participant drew parallels of more frequent flooding with what Venice currently experiences, noting that
they manage their water with duckboards on the walkway or drop in timber panels to protect shop fronts from
water washing in. This resident suggested this could be a possible first response for Kingston Beach in terms
of protecting the esplanade and cafes.
When residents were asked to think about the sandy beach, there were mixed views about whether there
would be any lifestyle impacts from more frequent temporary erosion events, on the premise the sand
usually returns. However faced with a scenario whereby the beach would only be accessible at low tide, this
was generally perceived to diminish the participant’s enjoyment of the area, whilst for others it would be
tragic (also for other living creatures who rely on this area). One participant offered an interesting thought
about the availability of substitute dog beach amenity in nearby areas with sea level rise:
"...if Kingston Beach is facing this type of problem [inundation]… then other areas like Nutgrove that have a
similar dog beach would be probably be having the same problem... so it’s not like I could move from here to
there..."

Section 6 – Wrap-up and further comments
When asked about survey preferences, there was generally an even split between hardcopy and web-based
surveys. Consequently, both options will be available to participants.
Some participants offered some useful closing thoughts about future scenarios and impacts to resident
values in the area. One participant offered the following comment about the changing nature of values
across generations:
“[social values] are adaptable… and if you have never had it and haven’t realised it and don’t miss it, then you
wouldn’t even pick it… you wouldn’t even predict it…"

Another said:
“…economic evolutions are probably easy…but the social aspects when you come to evaluate social impacts…
that can be so subjective… and somewhat unfortunately a good argument poorly delivered will always suffer
behind a poor argument well delivered… and you only have to look at our political landscape to understand
what I mean about that… so to me it very important that the social evaluations are cogent and particularly well
delivered by somebody who has the credibility to do so…”

Finally, one participant requested that the survey draw attention the impact of over-development on natural
values, saying:
University of Tasmania, School of Engineering and ICT
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“…Can I make a suggestion as something for your survey? there are some people in the community that need
to be asked why they live there, and how development will affect the reason why live there – because I think
some of them are lost – they don’t realise how lucky they are – and if you can make it something they sit back
and go, no, actually this is why I’m here… to really make it [the survey] reflective… and see how they want it
[the suburb] to develop, but how it will affect what they value... Sometimes with the conversations I have with
people it can be almost be schizophrenic… ‘we have to do this’ [they say], but it’s kind of like if you do that, that
bit you really value is not going to be there… “

Although the above comment is not the focus of the survey, understanding information about natural values
would serve to help decision-makers get a better handle on the costs and benefits of development.

4. Next steps
The next step in the Kingston Beach case study include finalising the survey questions. A draft survey has
been tested on a handful of friends, family and collages to get a sense of the ease to complete, time taken
and level of interest. Additional testing is required and additional family, friends and colleagues will be
approached.
The main activities to undertake next include:
1. Finalisation of survey questions and final review
2. Creating an online version of the survey using SurveyMonkey
3. Obtaining final ethics approval of the survey
4. Producing flyers, contacting the council to place link on Facebook page and other local community
groups (to encourage residents to participate). Approach the Kingborough Chronicle newspaper and
Kingston Classifieds also for publicity.

Please let me know if you have and comments and require further information on the above.
Yours sincerely,
Tim Ramm
PhD Candidate | MIEAust | CPEng | PMP
Email: timothy.ramm@utas.edu.au
Phone: +61 3 6226 7232
Mobile: +61 403 808 840
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Attachment 1 – Detailed results
This attachments contains:
1. A summary of tallied results
2. Detailed responses for each interview questions

Refer to pdf attachments that were sent via email with this memo
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Attachment 2 – Selected historic photo of Kingston Beach
The majority of photographs below have been sourced from:
Gardam J 1988, Browns River: A history of Kingston and Blackmans Bay, Rotary Club of Kingston,
Tasmania.

Photo 1 The top photo is one of the earliest photos of the beach from about 1870 (source: Gardam, 1988),
whilst the bottom photo is Kingston Beach today. The sea wall can be seen in the bottom photo behind the
beach.
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Photo 2 The first jetty in the area, which was washed away by a storm in 1896 (source: Gardam, 1988: 35)

Photo 3 Photo of a jetty which was pulled down at the end of the Second World War. The jetty was also
used for freight and ferrying passengers (source: Gardam, 1988: 38)
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Photo 4 Kingston Beach around 1900 (source: Gardam, 1988: 60)

Photo 5 A boat washed up onto Kingston Beach following a storm in 1952 (source: Gardam, 1988: 65)
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Photo 6 Browns river at about 1920 (source: Gardam, 1988: 69)

Photo 7 The first regatta off Kingston Beach (source: Gardam, 1988: 71)
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Ambience / atmosphere
Peacefulness
Unique natural environment
Friendly people (community)
Proximity to city, shops and other valued places
Access to a great beach
Safe place to live
Relaxed lifestyle
Outlook / views (e.g. river, sea, mountain)
The Birdlife
Location (e.g. near river and beach)
Flat landscape
Affordable housing
Recreational opportunities
Ease of travel to work
Smaller house or land (downsizing)
Family connection / memories
Nearby to family
Good place to raise kids
The climate
Close to friends
History / Heritage of the place
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Q1a: Why do you choose to live here?
Q1c: What makes you stay here?
Q6: How does Kingston Beach compare to other places lived in or travelled through?
Q9: What would you value most about living here? (and most important aspects to daily life)

(A) LIVED VALUES
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Question No
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Esplanade
Kingston main beach
The Dog Beach
Boronia Beach (incl Reserve)
Browns River
The rocks
Alum Cliffs Reserve
The duck park / rotary fitness equipment
Cafes, restaurants and pubs
Shops on Beach Road
The local football oval
The Community Hall
The Kingston Golf Club
Local Church
Nearby shops / shopping centre
A park bench (Osborne Esplanade) - memory
General Suburb as a whole - Special
A special residential property
A special tree (across river from house)
1

1
1

Q4. Are there any other places that you spend time in Kingston Beach?
Q5. Are any places special to you?

(B) PLACES THAT YOU SPEND TIME IN / SPECIAL TO YOU
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Housework
Kingston Golf Club (socialise or play golf)
Local Gym
Walking
Dog walking (block/beach)
Shopping
Watched a movie
Social groups (catching up)
Cooking / food preparation
Gardening
House improvements
Family (coming together; caring for grandchildren)
Full-time work (in the city/CBD/outside Kingston Beach
suburb)
Part-time work
Work at home (after hours)
Look after dog
Caring for family members
Friends
Church (and related social events)
Volunteering (e.g. sponsoring refugees; accommodation
for disabled people)
Drive to city for daughters music
Kayaking (river/sea)
Coffee (Cafés)
Play on Beach
Bruny Island - have a rental
Coles Bay - visited for a few days
University study
Watch the dogs on beach
Jogging
Boating (motorised)
Swimming
Bike riding
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Q2./Q3.: Please describe the main activities you can recall undertaking yesterday (weekday/weekend)?

(C) EVERYDAY ACTIVITIES
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Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
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Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
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Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3
Q2, Q3

Q2, Q3
Q2, Q3
Q2, Q3

Question No

House does not have a view (down side)
Quiet for a single person (not much social life)
A family area, unless you like kayaking/beach/golf
Council recognised as doing a lot to improve area
Traffic on southern outlet
Remove telegraph poles - aesthetic
Consider alternative trees to gums on esplanade
Widening footpath and narrowing of road on esplanade with regard to road safety
Better river management (trees, logs and debris)
…in the past, the golf course raising fairway (acts a bit like
a levy which not good for adjacent houses)
Personal issue with council - naming of a plark at Snug
No footpath near bus stop on Beach Rd (on other side of
road)
Cautious about overdevelopment….
Proactive measures from council to address inundation risk
(given rezoning)
Noise from native hens of golf course
A rooster across the road! (noise)
Worry about not being able to build/extend house due to
climate change restriction from Council
River management (blocked river)
Green waste bin
A few more restaurants
Restrict traffic along the esplanade (more foot
traffic/walking)
Maintaining grass on Kingston Beach
A jetty at Kingston Beach (like the old days)

More recreational areas or parkland (for families and kids)
Nothing
Worry about next flood (and impact to house)
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Q6: How does Kingston Beach compare to other places lived in or travelled through?
Q7: Does anything frustrate you about living here (or need improving)?
Q8: If you could wave a magic wand what changes would you like to make to Kingston Beach?

IMPROVEMENTS, FRUSTRATIONS OR WORRIES

Sum Question
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Q7, Q8
Q7, Q8
Q6b
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Q7, Q8
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Q6
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Q7, Q8
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Q7, Q8
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Question No

C.4 Definition of social values used in landscape mapping
A definition of the typology of nine values used in the survey, based upon Cole et al.
(2015), are shown in Table C.4.1.
Table C.4.1 Typology of social values used for landscape mapping and their operational
definition.
Value

Operational definition

Access

Common property, free from access restrictions or exclusive ownership

Aesthetic

Enjoyable scenery, sights, sounds and smells

Biodiversity

Variety and abundance of fish, birds, animals and plant life

Future

Future generations can experience healthy, productive, and sustainable
ecosystems

Historic

Natural and human history that matters to individuals and communities

Identify/
symbolic

Sense of place, community and belonging

Recreation

Providing enjoyable outdoor recreation activities

Therapeutic

Enhanced feelings of well-being (e.g. stress relief, comfort and calm)

Natural

Minimal human impact or intrusion on the natural environment

Other landscape values from Cole et al. (2015) not included in the survey were:
1. Cultural – passing down wisdom, knowledge and traditions;
2. Economic – tourism, fisheries and other business;
3. Intrinsic – place just exists;
4. Learning – educational value;
5. Life sustaining – produce, support and preserve human and natural life;
6. Spiritual / novel experience – sacred, religious, unique and/or profound
experiences where respect for nature is felt;
7. Subsistence – provide basic human needs.
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C.5 Survey questions
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Project Title: Coastal values in the suburb of Kingston Beach
A survey of Kingston Beach residents
You are invited to take part in a survey being conducted by the University of Tasmania. This
academic research is being undertaken to aid in the fulfilment of a PhD. The aim of the survey is to
explore what people value about living near the coast and how they value natural coastal areas. The
information will help researchers investigate what values could be affected by hypothetical flooding
and sea-level rise scenarios. It will also be used to explore ways to improve long-term planning and
decision-making in coastal communities.
The survey takes about 20 minutes to complete and participants may enter the draw to win a $100
restaurant voucher at Beachfront 32. A summary of the results will be made available to both
Kingborough Council and interested participants.
Additional information about this survey and research is provided on the covering letter and project
information sheet. Please return your completed survey in the enclosed reply paid envelope before
21st November.

UTAS use only: [MB] _______________________________ [HA] _______________________________ [Seq] _______________________________

SURVEY
SECTION 1: Thinking about when you moved to Kingston Beach
1. How many years have you been living in the Kingston Beach suburb? ________ (years)
2. Have you lived in Kingston Beach all of your life? (Please tick one)
 Yes Æ go to question 5
 No
3. Did your family have any connection to the area before you moved to Kingston Beach? (Please tick
one)

 Yes
 No
4. Where did you live immediately before moving to Kingston Beach? (Please tick one)
 Another suburb in Hobart
 Another suburb/town in Tasmania (not in Hobart)
 Another suburb/town outside Tasmania

SECTION 2: Thinking about your decision to live in Kingston Beach
5. What is most important to you about living in Kingston Beach?

6. How important are the following aspects to your daily life in Kingston Beach? (Place a tick in the
appropriate box for each item listed)

Natural environment
Relaxed lifestyle
Peacefulness
The bird life
A flat landscape
Easy to get to places
A unique place for children to grow up
A safe place to live
Financially secure / affordability
Friendly people / community feel
Being close to family
Being close to friends
Location (close to the water)
The scenery (and views)
Easy access to the beach
Ambience / atmosphere
Recreational opportunities

Very
Important

Important

Not important























































7. Please describe anything else not mentioned in the previous question that is very important for
choosing to live in Kingston Beach?

8. Do any of the following things frustrate you about living in Kingston Beach? (Place a tick in the
appropriate box for each item listed)

Local council decision-making
Limited entertainment options
Limited activities for youth
Limited park areas
Limited number of footpaths
Limited number of shops
Poor quality of roads
Vehicle traffic along the esplanade
Flood management of Browns River
Limited public transport services
Peak hour congestion on the Southern Outlet
Other (please specify): ______________________________________

Yes

No



























SECTION 3: Thinking about how you spend your time
9. How often do you do each of the following activities in the suburb? (Place a tick in the appropriate box
for each item listed)

Go for a walk
Walk the dog
Visit the cafes / restaurants
Visit local shops
Access the beach
Use picnic areas and benches
Visit nearby parks / play equipment
Go kayaking / paddle boarding
Ride a bike
Go for a jog
Go swimming
Go to the gym
Play golf
Go fishing
Go boating
Go sailing
Do volunteer work
Other (please specify): ________________

Every
day

Every
week

Every
month

Rarely

Never
































































































SECTION 4: Thinking about how you value coastal areas
10. How important are the following values to you when thinking about the beach in the suburb? (Place a
tick in the appropriate box for each item listed)

Very
Important

Important

Not
Important

Access: Common property, free from access restrictions or
exclusive ownership







Aesthetic: Enjoyable scenery, sights, sounds and smells







Biodiversity: Variety and abundance of fish, birds, animals and
plant life
Future: Future generations can experience healthy, productive,
and sustainable ecosystems
Historic: Natural and human history that matters to individuals
and communities
Identify/ symbolic: Sense of place, community and belonging

























Recreation: Providing enjoyable outdoor recreation activities







Therapeutic: Enhanced feelings of wellbeing (e.g. stress relief,
comfort and calm)
Natural: Minimal human impact or intrusion on the natural
environment













Value / Definition

11. Please list any other values not shown in the question above that are important to you when thinking
about the beach.

The page has been intentionally left blank

The map below shows coastal areas in Kingston Beach, identified with letters A through to H. Please use
this map for questions 12 and 13.

12. For each ‘value’ shown in the table below, please choose up to 3 coastal areas that are important to
you because of that value. The coastal areas should be numbered in order of importance (i.e. 1 =
most important, 2 = second, 3 = third). If the value is not important to you, leave that row empty.

If you value the Sea most of all for ‘access’, then Kingston main Beach, then Browns River, you
would do the following:

(For each row in the table, number up to 3 coastal areas in order of importance)

Coastal Area (refer to map)

(A)

(B)

(C)

Saltmarsh

Saline
grassland /
golf course

Browns
River

(F)

(G)

(H)

Sea
(Derwent
River)

Rocky
Shore

Boronia
Beach

Access: Common property, free from
access restrictions or exclusive ownership





  







Aesthetic: Enjoyable scenery, sights,
sounds and smells





  







Biodiversity: Variety and abundance of
fish, birds, animals and plant life





  











  











  







Identify/ symbolic: Sense of place,
community and belonging





  







Recreation: Providing enjoyable outdoor
recreation activities





  







Therapeutic: Enhanced feelings of
wellbeing (e.g. stress relief, comfort and
calm)





  







Natural: Minimal human impact or
intrusion on the natural environment





  







Value

Future: Future generations can
experience healthy, productive, and
sustainable ecosystems
Historic: Natural and human history that
matters to individuals and communities

(D)

(E)

Dog Kingston
Beach
main
Beach

13. Referring again to the map, how often do you use the following areas for recreational activities?
(Place a tick in the appropriate box for each item listed)

Letter

Coastal Area

A
B
C
D
E
F
G
H

Every day

Every
week

Every
month

Rarely

Never














































Saltmarsh
Saline grassland (incl. golf course)
Browns River
Dog Beach
Kingston Main Beach
Sea (Derwent River)
Rocky shore
Boronia Beach

SECTION 5: Thinking about flooding events
14. Where do you get information about flooding risk in Kingston Beach? (Please tick as many that apply)
 Council reports and displays
 Printed media (newspaper, magazine)
 Radio
 Word of mouth / experience in the area
 Online (social media, internet)
 I don’t know
 Scientific journals or magazines
 Other: ___________________________
 Television
15. Who do you think is responsible for minimising flood risk in Kingston Beach? (Please tick as many that
apply)

 Local government (Council)
 State government
 Federal government (Commonwealth)

 Individual residents
 I don’t know
 Other: _______________________

16. Have you ever experienced a major flooding event which has caused parts of your property to be
under water? (Please tick one)
 Yes
 No
17. To what extent do you think that increased flooding risk could affect the following things in Kingston
Beach? (Place a tick in the appropriate box for each item listed)

My everyday lifestyle
The beach
The value of my house
Feeling safe in my house
Getting insurance for my house
My annual rate and insurance premium costs
Emergency access via Beach Road
The natural environment

Definite
Impact

Possible
Impact

No
Impact

Don’t
know





































18. Consider a hypothetical scenario where the beach was lost to sea level rise. Would you consider
moving to another suburb? (Please tick one)
 Yes
 No
 I don’t know
19. What are your council rates each year (estimated)? If you rent, please estimate this amount.
______________ (dollars per year)

20. Council rates are spent on important services such as waste management and infrastructure. If the
risk of flooding from Browns River to your house or public infrastructure increased, would you like to
see money spent on activities to reduce flood risk? Currently about 3% of rates is currently spent on
natural resource management across the municipality. (Please tick as many that apply)
 Yes – using a separate rate / extra rent
 Yes – using a larger proportion of my existing rate Æ (go to question 23)
 No Æ (go to question 25)

21. If the risk of flooding from Browns River increased, what extra rate on top of your existing rate would
you consider paying to manage flood risk? If you rent, please state an additional rental amount.
______________________ (dollars per year)

22. If the beach was hypothetically lost to sea level rise, would you change your answer to the above
question (i.e. the amount you would pay to reduce flood risk)?
 No
 Yes (please specify the new amount): ________________________ (dollars per year)
If you would not want to use a larger proportion of your existing rate to manage flood risk (in addition
to a separate rate), go to question 25.

23. If the risk of flooding from Browns River increased, what percentage of your annual rates would you
like to see allocated to managing flood risk? Remember that this amount will no longer be available for
other services which would have to be cut.
______________________ (% of annual rates)

24. If the beach was hypothetically lost to sea level rise, would you change your answer to the above
question (i.e. the allocation of rates to manage flood risk)?
 No
 Yes (please specify the new amount): ________________________ (% of annual rates)

SECTION 6: Thinking about your personal connections
25. How often do you spend time with the following people? (Place a tick in the appropriate box for each item
listed)

Immediate family
Friends
Neighbours (not counted as friends above)
Work colleagues outside work
Members of groups or organisations that you belong to
Other members of the community

Every
day

Every
week

Every
month

Rarely

Never




































26. Close friends are people you feel at ease with, can talk to about private matters or call on for help.
How many of your close friends live in Kingston Beach? (Please tick one)
 None
 One
 A few
 A lot
27. Are you involved in any of the following organisations in your suburb? (Place a tick in the appropriate box
for each item listed)

Service organisation (e.g. Rotary, Emergency Services)
Religious or church organisations
Education organisations
Arts, music or cultural organisations
Youth organisations (e.g. Scouts)
Local community action groups
Conservation or environmental groups
Sports or recreation groups (e.g. sailing, dog walking)
Other (please specify): _______________________________

Yes

No



















SECTION 7: Thinking about you and your household
28. Are you male or female? (Please tick one)
 Female
 Male
 Other
29. Does anyone in your household identify as being Aboriginal or Torres Strait Islander? (Please tick one)
 Yes
 No

30. What age group do you fall into? (Please tick one)
 18-24
 55-64
 25-34
 65-74
 35-44
 75-84
 45-54
 85 and older
31. How many people usually live in your house including you? _________ (people)
32. Is anyone in your house dependent on the care of someone else? (Please tick one)
 Yes
 No
33. Which of the following best describes your household? (Please tick one)
 Single person household
 Extended family
 Single with child/children  Share house
 Couple
 Other
 Couple with child/children
34. Do you own at least one dog? (Please tick one)
 Yes
 No
35. What is your gross (before tax) weekly household income? (Please tick one)
 Nil
 $1 – $399 per week ($1 - $20,749 annually)
 $400 – $999 per week ($20,800- $51,949 annually)
 $1,000 – $1,999 per week ($52,000 - $103,950 annually)
 $2,000 or more per week ($104,000 or more annually)
 Rather not say
 Don’t know
36. Is your home in Kingston Beach your main residence or second home (i.e. holiday house)? (Please tick
one)

 Main residence
 Second home or holiday house
37. Which of the following best describes you? (Please tick one)
 Renting my house
 Own my house without a mortgage Æ (go to question 39)
 Own my house with a mortgage
38. Do you have greater than 30% of your gross weekly household income going to mortgage
repayments or rent for your main residence? (Please tick one)
 Yes
 No
 Rather not say
 I don’t know

39. What type of insurance cover do you have for your main residence? (Please tick one)
 Home and contents
 Contents only
 None Æ (go to question 41)
 Rather not say
 I don’t know
40. Does the insurance policy for your main residence cover flooding from Browns River? (Please tick one)
 Yes
 No
 Rather not say
 I don’t know
41. What is the highest level of education that you have completed? (Please tick one)
 University degree or higher
 Year 11, or equivalent
 TAFE or other vocational certificate  Year 10 or below
 Year 12, TCE or equivalent
 Did not go to school
42. Which would best describe your situation with regard to work, study or caring responsibilities?
(Please tick as many that apply)








Working full-time
Working part-time
Looking for work
Studying full-time
Studying part-time
Caring for children








Caring for others
Retired
Semi-retired
Not working and not looking for work
Not working due to an injury/illness/disability
Other

43. Do you own your own business? (Please tick one)
 Yes
 No

Thank you for taking the time to complete this survey. Please place your survey in the reply-paid envelope
provided and post it by Monday 21st November 2016. If you have misplaced this envelope, simply use a
new envelope and address it to ‘Tim Ramm, Reply Paid 83585, Hobart, TAS, 7000’.
If you would like to receive a summary of the survey results, or enter the draw to win a $100 dinner
voucher at Beachfront 32, please complete the ‘Results and Competition’ form included with this survey.

C.6 Participant feedback report: Summary of survey results
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01 March 2017

Coastal values in the suburb of Kingston Beach
Summary of survey results
Project Team: Tim Ramm | PhD Candidate, School of Engineering and ICT, University of Tasmania
Dr Sonia Graham | School of Social Sciences, University of New South Wales
Dr Chris White | School of Engineering and ICT, University of Tasmania

1. Thank you for helping with the Kingston Beach Coastal
Values Survey
In November 2016, you completed the
Kingston Beach coastal values survey. The
survey aimed to explore what residents in the
suburb value about living by the coast and
what values could be affected by changing
coastal flooding regimes. The survey was
undertaken as part of PhD research on
coastal adaptation pathways at the University
of Tasmania.
Prior to the distribution of the survey, placebased observations occurred in March 2016
to observe how coastal land was being used.
In September 2016, there were 10 semistructured interviews conducted with
Kingston Beach residents to gain insights into
their values and how they use coastal areas
in the suburb. The place-based observations

and semi-structured interviews helped shape
the survey questions.
The survey questions were designed to
collect information about socio-economic
characteristics, connection to the area, lived
values, day-to-day activities, risk perceptions
and social relationships.
This summary provides an overview of the
results of the survey that was conducted
between 31st October 2016 and 30th
November 2016. The data from the survey is
currently being analysed, and the conclusions
will be published at a later date in a scientific
paper.
Below: Looking north along Kingston Beach

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

2. The community response

322

survey responses were
received with 1 in 3 houses
participating

55-64

was the median age group
of respondents

248

participants said that the
scenery (and views) were
very important to their daily
lives in Kingston Beach

45

Distinct values were identified
from the survey

73%

of respondents used Kingston
Beach at least weekly for
recreational purposes

61%

of respondents thought that
increased flood risk could affect
the natural environment in the
suburb

Below: Aerial photo of Kingston Beach showing the geographic distribution and number of survey responses

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

What were the respondent characteristics?
To gauge the representativeness of respondents to the entire suburb population, socio-economic
characteristics were compared with the Australian Bureau of Statistics census data (ABS, 2012).
Table 1 summarises key characteristics.
Table 1. Summary of socio-economic characteristics
Characteristic

Australia
(2011)
9.1 million
37
51:49
2.6
44.6%
2.5%

Kingston Beach
Suburb (2011)
965
45 (Note 1)
51:49
2.3
36.7%
2.5%

Interviews
(Sep 2016)
10
69
40:60
1.7
-

Survey
(Nov 2016)
322
55-64 (Note 1)
59:41
2.3
23%
4%

Private dwellings
Median Age
Female: Male Ratio
Average people/house
Couple with children
Household member identifies as
Aboriginal or Torres Strait Islander
University or higher
14.3%
17.7%
30%
58%
Full time employment
58%
55%
30%
25%
Median weekly household income
$1,234
$1,097
$1,000-$1,999
(Note 1) People aged less than 35 years were underrepresented and people aged over 55 were
overrepresented

The representativeness of the survey respondents to the suburb (Table 1) needs to be taken into
account when interpreting the results presented in this summary.

Below: The esplanade at Kingston Beach

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

What do people value about Kingston Beach?
“Lived values are defined as valuations that individuals make, in isolation
or as part of a group, about what is important in their lives and the places
they live” (Graham et al., 2014: 42)
There were 45 lived values identified from
respondents as being important to their lives
in Kingston Beach. The top 5 lived values
most commonly mentioned were the beach,
the ease in getting to places (i.e. important
places and services), the scenery, natural
environment and the relaxed lifestyle (Table
2). These lived values were obtained from
open-ended survey questions.

Respondents were also asked to rate the
importance of 17 predefined lived values that
had been developed from interviews with
residents. The top 5 lived values, ranked
according to importance in the daily lives of
respondents, were the scenery/views, safety,
relaxed lifestyle, peacefulness and natural
environment (Fig. 1).

Table 2. Social values identified in open ended survey questions. Social values with an asterisk (*)
were mentioned in the semi-structured interviews, and values in italics correspond with those in Fig 1.
Social Value
The Beach (includes easy access
and proximity) *
Easy to get to places *
The Scenery (and views) *
Natural Environment *
Relaxed lifestyle (Beach lifestyle) *
Friendly people / community feel *
Location (close to the water) *
Ambience / atmosphere *
Peacefulness (and quiet) *
Recreation opportunities *
A flat landscape *
House / land attributes
Being close to family *
Pet friendly community / dog
exercise areas
A safe place to live *
Low density housing / not congested
Public transport
Close to the bush
Close to work
Convenience
Clean environment and air
Good cafes / restaurants
Financially secure / affordability *

Number of
respondents
118

Social Value

112
83
46
45
37
33
32
31
30
18
17
14
13

Individual heritage / family history
A unique place for kids to grow up *
The sounds (sea)
Sense of space
Local church community
Wildlife
Away from the city
Good parking options
Good cycle options
Employment opportunities
Being close to friends *
Local golf club
Smaller house or land (downsizing) *

6
5
4
4
3
3
3
2
2
2
2
2
1

12
11
10
10
9
9
8
7
7

Privacy
Medical facilities
Green places
Close to the mountain
Friend visits
Beachfront streetscape
Pride
Quality of life

1
1
1
1
1
1
1
1

Weather/Climate

Number of
respondents
6

(Total number of lived valued = 45)

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

Fig 1. Importance of lived values. Bars refer to the number of respondents who ranked each lived value
as ‘very important’, ‘important’ or ‘not important’. Where bars for lived values add to less than 322, this
is because the remaining individuals stated that the lived value was not applicable or that they did not
believe it exists in the community.

Comparing Table 2 and Fig. 1 shows that the scenery, relaxed lifestyle and natural environment
rated in the top five in both. Although the beach was not included specifically in Fig 1, its value was
demonstrated through other survey questions (see pages 7-9)

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

What are current frustrations with Kingston Beach?
Of the frustrations listed in the survey, peak hour congestion on the Southern Outlet (66% of
respondents), local government decision-making (54%), limited public transport services (34%)
and poor quality of roads (34%) were respondents’ top four frustrations.
Respondents were provided with the opportunity to describe additional frustrations to those listed
in the survey that they have with respect to living in Kingston Beach. These included behaviour of
animal owners (e.g. noise, mess), traffic management (e.g. traffic numbers and speed),
infrastructure quality and safety (e.g. footpaths, cycling), environmental management (e.g.
vegetation, weeds, Browns River pollution) and facility improvements (e.g. shops, public toilets,
green waste, swimming pool, cinema).
Some things valued by some respondents were frustrations for others, for example public transport
options, parking and dogs areas. Similarly, different views were apparent on particular local issues,
for example, some respondents wanted more parking and others desired more vehicle free areas.

Below: Looking east along Browns River towards the footbridge and Derwent River

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

What do people do in Kingston Beach?
Lived values are not only expressed by what
people say they like about living in a place,
but also what they do. Place-based
observations were undertaken in March 2016
to see how coastal areas in Kingston Beach
were being used. These observations
occurred across a range of weather
conditions and revealed a diverse range of
activities. The top 3 activities in terms of
number of people participating were dog
walking, café / dining and walking.

activities undertaken most frequently included
walking, accessing the beach, dog walking,
visiting the local shops and visiting the
cafes/restaurants (Fig 2).
Some of these activities were noted by
respondents to be seasonal, such as
swimming, which was more frequently
undertaken in warmer months.

As part of the survey, respondents were
asked about their daily, weekly and monthly
activities using a list derived from prior
observations and resident interviews. The

Fig 2. Frequency with which survey respondents participated in a range of activities
University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

How do residents value natural low-lying coastal areas?
Respondents were asked how they valued natural low-lying areas using a list of values derived
from prior research (Cole et al., 2015; Box 1). Kingston Main Beach was the most valued
landscape overall, followed by the Sea and
Browns River. Differences in the top values
Saline grassland
(incl. golf course)
residents assign to landscapes can be seen in
Table 3. Kingston Main Beach and the Dog
Browns
Saltmarsh
Beach were both highly valued for access and
River
recreation. Valuations reflecting the natural
environment (natural, biodiversity) and
emotional values (therapeutic, aesthetic,
future) were seen in the saltmarsh, saline
Dog Beach
grassland, rocky shore and Boronia Beach
(incl. Tyndall
landscapes.
Beach)
Table 3. Top 3 values for each low-lying area.
See Box 1 for value definitions.
Coastal area
Saltmarsh

Saline grassland
(incl. golf course)
Browns River

Dog Beach

Kingston Main
Beach
Sea / Derwent

Rocky Shore

Boronia Beach

Kingston
Main Beach

Top 3 values
1. Natural
2. Biodiversity
3. Future
1.
2.
3.
1.
2.
3.
1.
2.
3.
1.
2.
3.
1.
2.
3.
1.
2.
3.
1.
2.
3.

Biodiversity
Recreation
Historic
Biodiversity
Historic
Future
Access
Recreation
Identity
Access
Recreation
Identity
Future
Aesthetic
Therapeutic
Natural
Aesthetic
Biodiversity
Natural
Therapeutic
Biodiversity

Sea
(Derwent
River)
Rocky
shore

Boronia
Beach

Above: Aerial image of Kingston Beach with
natural low-lying coastal areas shown

Box 1 List of values selected and definitions (Cole et al., 2015).
Value
Access
Aesthetic
Biodiversity
Future
Historic
Identity / symbolic
Recreation
Therapeutic
Natural

Definition
Common property, free from access restrictions or exclusive ownership
Enjoyable scenery, sights, sounds and smells
Variety and abundance of fish, birds, animals and plant life
Future generations can experience healthy, productive, and sustainable ecosystems
Natural and human history that matters to individuals and communities
Sense of place, community and belonging
Providing enjoyable outdoor recreation activities
University
of Tasmania,
School of Engineering and ICT
Enhanced feelings of wellbeing (e.g. stress relief,
comfort
and calm)
Private Bag 65, Hobart, Tasmania, 7001 Australia
Minimal human impact or intrusion on the natural environment

Participants were asked how frequently they use low-lying coastal areas for recreational purposes
(Fig 3). Kingston main beach and the dog beach were most frequently used by respondents.

Fig 3. Frequency with which survey respondents use low-lying coastal areas for recreational purposes
in Kingston Beach.

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

What social relationships exist in Kingston Beach?
Although being close to family and friends did not rank highly in terms of importance to
respondents’ daily lives (Fig 1), the importance of these relationships is reflected in the frequency
with which respondents indicated they spend time with these people (Fig 4). After family and
friends, respondents were more likely to spend time with other members of the community.
Respondents were the least likely to spend time with work colleagues outside work – an
observation which could be attributed to many respondents being retired.

Fig 4. Frequency with which survey respondents spend time with family, friends and other social
contacts.

Many respondents indicated that they were members of at least one group or organisation. Sports
and recreational groups were the most popular (Fig 5), followed by educational organisations and
religious or church groups.

Fig 5. Percentage of survey respondents who belong to groups and organisations
University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

How are impacts from increased flooding risk perceived in Kingston
Beach?
Respondents were asked where they
currently get their information about flooding.
The most common sources were word of
mouth/experience in the area (42%), council
reports and displays (40%) and printed media
(e.g. newspapers; 34%).
About 85% of respondents felt that local
government should be responsible for
minimising flood risk in Kingston Beach, with

State government (64%) also frequently
identified.
Respondents were also asked about their
perceptions of impacts from hypothetical
increased flooding risk in the suburb. The
natural environment was perceived by
respondents to be of highest vulnerability
under hypothetical increase to flooding risk
(Fig 6).

Fig 6. Perceptions of increased flooding risk in the suburb.

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia

The natural environment in Kingston Beach is important
The results presented in this summary suggest that there are many attributes that people value
about living in Kingston Beach. The highest level of agreement exists around features of the
natural environment and the lifestyle it affords, for example the beach. There is also a range of
values that appear to be specific to particular groups or people within the community. This
summary provides a snapshot of what is important to people’s lives in Kingston Beach, which
needs to be considered when identifying changing coastal risks and developing adaptation
responses to changing coastal flood regimes.

3. Next steps
A detailed analysis of the survey data is underway
Researchers are now analysing the survey
data in detail to see how lived values are
distributed across the community. Following
this analysis, a peer-review scientific paper
will be published capturing major findings.

will be in summary form. All survey data is
being stored safely and will be destroyed
after 5 years in accordance with the ethics
process approved by the Tasmanian Social
Sciences Human Research Ethics
Committee.

Individual participants will not be identifiable
in any publications and any data published

Below Looking south across the Derwent River towards Iron Pot and Storm Bay

University of Tasmania, School of Engineering and ICT
Private Bag 65, Hobart, Tasmania, 7001 Australia
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C.7 Lived values identified in open ended questions
Detailed information about the open-ended survey questions are provided in Table C.7.1.
The values have been categorised by health, safety, belongingness, esteem and selfactualisation to be consistent with Graham et al. (2013; based on Maslow’s Hierarchy of
needs) and are ranked in each category from highest to lowest.

Table C.7.1 Lived values identified by survey respondents in the suburb of Kingston Beach
in response to open-ended questions (Q5 and Q7) focussing on what they value most about
where they live. Numbers in bold are the top five lived values mentioned and values marked
with an asterisk (*) were shortlisted in the closed survey question (Q6). Values identified in
the semi-structured interview and also in the Lakes Entrance case study (Graham et al.,
2015)7 are shown.
Lived Value
Category
Health

Lived values

Easy to get to places
(proximity to city, shops and
other valued places) *
A flat landscape *

Semistructured
interview

Lakes
Entrance
(Australia)

Kingston
Beach
(suburb)

9

9

112 (34.8%)

9

18 (5.6%)

Public transport

10 (3.1%)
9

9 (2.8%)

Convenience

9

9 (2.8%)

Clean environment and air

9

8 (2.5%)

Close to work

9

Good cafes / restaurants
Weather / climate

Safety

7 (2.2%)
9

9

6 (1.9%)

Good parking options

2 (0.6%)

Good cycle options

2 (0.6%)

Smaller house or land
(downsizing) *
Peacefulness (and quiet) *

9
9

9

31 (9.6)

A safe place to live (feeling
of) *
Financially secure /
affordability *
Employment opportunities

9

9

12 (3.7%)

9

9

7 (2.2%)

9

2 (0.6%)

Privacy

9

1 (0.3%)

Medical facilities / services

9

1 (0.4%)

1 (0.3%)

Graham, S, Barnett, J, Fincher, R, Mortreux, C & Hurlimann, A 2015, ‘Towards fair local
outcomes in adaptation to sea-level rise’, Climatic Change, vol. 130, no. 3, pp. 411-424.
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Lived Value
Category
Belongingness

Lived values

Semistructured
interview

Lakes
Entrance
(Australia)

Kingston
Beach
(suburb)

The beach (and proximity) /
Easy access to the beach *
The scenery (and views)
(outlook) *
Natural environment *

9

9

118 (36.6%)

9

9

83 (25.8%)

9

9

46 (14.3%)

Friendly people / community
feel *
Location (close to water) *

9

9

37 (11.5%)

9

9

33 (10.2%)

Being close to family *

9

9

14 (4.3%)

Pet friendly community / dog
exercise areas
Close to the bush
Individual heritage / family
history
The sounds (sea)

13 (4.0%)
10 (3.1%)
9

9

6 (1.9%)

9

4 (1.2%)

Local church community

3 (0.9%)

The wildlife
Being close to friends *

9

9

3 (0.9%)

9

2 (0.6%)

Local golf club (Kingston
Beach Golf Club)
Green places (open spaces)

2 (0.6%)
1 (0.3%)

Close to mountain (Mt
Wellington)
Friend visits
Esteem

Selfactualisation

9

1 (0.3%)

9

1 (0.3%)

House / land attributes

17 (5.3%)

Sense of space

4 (1.2%)

Beachfront streetscape

1 (0.3%)

Pride

1 (0.3%)

Relaxed lifestyle (beach
lifestyle) *

9

9

45 (14.0%)

Ambience / atmosphere
(character) *
Recreation opportunities *

9

9

32 (9.9%)

9

9

30 (9.3%)

9

11 (3.4%)

9

5 (1.6%)

9

3 (0.9%)

9

1 (0.3%)

Low housing density / not
congested or developed
A unique place for children to
grow up (great place to raise
a family) *
Away from the city
Quality of life

9

Total

45
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C.8 Mapping landscape values to landscape units
The value profiles for each landscape unit show the number of times each shortlisted
value was ranked as being ‘most important’ (Figure C.8.1).

Figure C.8.1 Association of the nine shortlisted values with coastal landscape units, showing
the percentage of times that a landscape unit was ranked as most important (i.e. rank = 1).
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D.1 Purpose
The purpose of the appendices in this supplementary material are summarised below:
Appendix A: To provide detailed information about the data format and model setup
used in the manuscript case study.
Appendix B: To summarise the top lived values in Lakes Entrance from prior
studies.
Appendix C: To provide extra details on the options used in the manuscript case
study.
Appendix D: To provide detailed documentation of the programming code used in
the manuscript case study.
Appendix E: To document repetitious calculations used in the manuscript case
study to determine conditions leading to adaptation tipping points and
use-by years.
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D.2 Detailed methodology
D.2.1 Data structure, basis and model setup
D.2.1.1

Set up property stock spreadsheet

A database of addresses for Lakes Entrance was created for land elevations less than 3
m relative to the Australian Height Datum (AHD). Addresses were grouped by the
relevant Statistical Area 1 (SA1) and Mesh Block (MB) areas obtained from the
Australian Bureau of Statistics (ABS 2016). The general work breakdown structure (WBS)
used in the property stock spreadsheet was as follows:
Level 1: 1. SA1 Level
Level 2: 1.1 MB Level
Level 3:
1.1.1 Property details
 Planning zone
 Building use (residential / commercial)
 ArcMap building ID
 Land parcel PFI (underlying building)
 Address (street number / suffix / unit; street; street type)
 Below 3 m AHD
 Business name (identifier)
 Storeys
 Vulnerability model
 DEM level (m AHD)
 Number of stair risers
 Slab thickness
 Estimated floor level
 Building footprint area
 Structural value
 Contents value (residential only) (NEXIS database; Dunford et al.
2014)
 Average people per dwelling (NEXIS database; Dunford et al. 2014)
 Estimated replacement value 1 (NEXIS database; Dunford et al. 2014)
 Estimated replacement value 2 (Rawlinsons 2007)
 Capital improved values (provided by the council)

The data inputs used to complete the spreadsheet included cadastral parcels (shapefile),
ABS SA1 and MB shapefiles, Google Maps, Google Street View, LiDAR DEM Data,
building replacement valuations, contents valuations and capital improved value details.
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D.2.1.2

Digitise property from aerial photo into polygons

Approximately 1,864 residential and commercial properties located below 3 m AHD were
digitised into building footprint polygons using aerial imagery provided by the council.
The polygon ID in ArcMap was recorded in the property stock spreadsheet for each
address, along with the cadastral land parcel over which the digitised property was
located. Residential sheds were omitted. Verandas and car port areas were excluded
from the building footprint when these could be identified. The general procedure to
digitise properties in ArcMap was as follows:
a. Systematically digitise polygons in each mesh block area;
b. Cross-check the correct address of the property with Google Maps;
c. Cross-check the correct property and defining features using Google Street
View. This included spot checking letter box numbers, numbers painted on
kerbs and also business names (i.e. confirming business address via a
Google search);
d. Estimating the area of the properties based upon the digitised buildings.
The data inputs used included aerial photo, cadastral parcels, Google Maps and Google
Street View. The rate at which the above activities (steps a-d) were undertaken was
about 40-50 properties (addresses) per hour.
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D.2.1.3

Assign vulnerability models and floor levels to properties

Each digitised property added into the property stock spreadsheet was assigned a
vulnerability model. This was based on visual features of the property using Google
Street View. The property floor level was estimated at the same time as vulnerability
models were being assigned, using LiDAR digital elevation model (DEM) data and
Google Street View. The general procedure was as follows:
a.

Property details, such as the number of storeys were recorded using
Google Street View. Vulnerability models (Geosciences Australia 2017)
were assigned to all properties based upon key building characteristics
(Figure D.2.1 and Table D.2.1). These models provide a relationship
between depth of flooding and damage, expressed as a percentage of the
building structure replacement cost. A consideration when assigning
models was to determine the main characteristics of the building and what
would get wet from flooding and require repair. Typical vulnerability model
allocations included:
i.

1-storey brick house with (without) garage: FCM7 (FCM8)8;

ii.

1-storey weatherboard house: FCM1;

iii.

2-storey brick house: ACFS2a (however assumed FCM4 if the
lower floor was brick and mainly garage space);

iv.

2-storey brick house, brick on bottom floor and weatherboard on
top floor: FCM3 or FCM4;

b.

v.

Caravan cabins: FCM1a;

vi.

Esplanade shops (1-storey): CB1;

vii.

Motels (1-storey): CB3.

Google Street View was used to estimate the number of stair risers from
the ground to the floor level. Riser heights were assumed to be 180 mm
based upon Clause 11.4.3 in AS4226-2008 (Guidelines for safe housing
design). The floor slab thickness was assumed to be 100 mm based upon
Clause 3.1.1 in AS2870-2011 (Residential slabs and footings). These
riser and slab heights were then added to the LiDAR land elevation to
approximate the property flood level.

Refer Geosciences Australia (2017) for more details about the vulnerability model codes
referred to.
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8

The data inputs used included Google Street View, Google Maps, LiDAR data, an aerial
photo and building polygons. The rate at which the above activities (steps a-b) were
undertaken was about 20-50 properties per hour.

Figure D.2.1 Using Google Street View to assign representative vulnerability models to
properties. Each representative model has a unique damage index vs flood depth curve.

D.2.1.4

Combine attributes into GIS shapefile

Key attributes of the property stock spreadsheet were converted into a csv file and
merged with the attributes table of the building footprint polygon shapefile in ArcGIS to
consolidate the data.

D.2.1.5

Other details in the spreadsheet

Grouping properties by the ABS SA1 areas allowed ‘people per dwelling’ to be assigned
to residential properties based upon the Geosciences Australia NEXIS database
(Dunford et al. 2014). The NEXIS database also had estimates for structural replacement
values for residential and commercial properties, along with residential contents values.
Contents damage was considered for residential properties only, not commercial
properties as no data was available.
A second estimate of structural replacement values was obtained using the Australian
Construction Handbook (Rawlinsons 2017). This estimate was used in the impact
assessment for property damage.
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 Relatively few internal walls (which
are more likely to be masonry than
plasterboard)
 Mostly masonry exterior walls
 Minimal wet areas (e.g. bathrooms
and kitchens)

 Lots of masonry internal walls
 Many bathrooms
 Minimal kitchen facilities

Shop on
esplanade

Motel (1storey)

Property characteristics

 External walls metal stud lined
 Minimal internal walls

Example photo from Lakes
Entrance

Caravan
cabin

Type

CB3

CB2

FCM1

Assigned vulnerability
model

Example of the model type
assigned (Geosciences
Australia, 2017)

Table D.2.1 Key assumptions made in assigning the Geosciences Australia (2017) vulnerability models in Lakes Entrance.
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2-storey
brick
house
without
garage

 Currently no model for a 2-storey
brick building.

2-storey
brick
house with
garage

Property characteristics

 Multi-storey residential
 Masonry inter-apartment walls
 Possibly plasterboard clad study
internal walls
 A bathroom per room and kitchen

Example photo from Lakes
Entrance

Motel (2storey)

Type

(as it has more rooms
downstairs than
ACFS2a)

FCM3

(unlikely floods will
exceed first floor level so
modelled loss ok)

FCM4

(closest model given
options available)

ACSF2a

Assigned vulnerability
model

Example of the model type
assigned (Geosciences
Australia, 2017)
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 Note: If weatherboard clad house
has a slab on ground, FCM1 model
can be assigned but this might
overestimate damages.

 Different ground floor use to upper
floors.
 Losses to ground floor building
services in a flood (elevator pit,
motor room, sprinkler pump, main
distribution board, commercial
kitchen, substation) likely to outweigh
other costs.
 Brick houses that are older may not
have slab on ground floors and
therefore a different vulnerability
model would be needed

Weatherbo
ard house

Resort
(more than
2 storeys)

Standard
1-storey
brick (no
garage)

Property characteristics

 If difference in plan between top and
bottom level is small, use 2-storey
model.

Example photo from Lakes
Entrance

Partial
second
floor

Type

Example of the model type
assigned (Geosciences
Australia, 2017)

FCM8

For multi-storey properties such as this resort, choose the
most vulnerable commercial model (LIB4 or LIB6) and
multiply the damage index by the replacement cost for the
ground floor (note basements can be expensive services if
flooded).

FCM1

FCM7 selected and
calculate loss from DI
multiplied by ground
level only

Assigned vulnerability
model
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ACFS6

CB2

Precast

Assigned vulnerability
model

Shopping
centre

Property characteristics

FCM7

Example photo from Lakes
Entrance

Standard
1-storey
brick
(garage)

Type

Example of the model type
assigned (Geosciences
Australia, 2017)

D.2.2 Projecting future sea level rise and influence on lake flood water
levels
Globally, acceleration in sea level has been detected across the 20th century (Church
and White 2011; Dangendorf et al. 2017). Acceleration is also emerging in the global
satellite record which is slightly over two decades in length (Watson et al. 2015).
Projections of mean seal level rise across the 21st century under the RCP8.5 (increasing
greenhouse emissions) and RCP2.6 (declining greenhouse gas emissions) show that
acceleration is likely to continue at similar or higher rates (Church et al. 2013: p.1181).
Additionally, new research suggests there may be further contributions to global mean
sea level rise from instability of major Antarctic ice sheets (DeConto & Pollard 2016).
Whilst the likelihood of this instability is still under scientific debate, various papers
investigating future sea level scenarios include some treatment of this contribution (e.g.
Lempert et al. 2012; Oddo et al. 2017).
Locally, two regional mean sea level reconstructions using historical tidal gauge and
satellite altimetry data for the nearest grid node to Lakes Entrance suggest a +0.98 mm
yr-1 rate of sea level rise (reference year being 1960), with an acceleration of +0.04mm
yr-2 (this being twice the value of the quadratic coefficient, which is 0.02 mm yr-2) (Church
& White 2011, data from 1950-2012). The second product (data from 1900-2013) yields
a +1.87 mm yr-1 rate of sea level rise, with an acceleration of +0.006 mm yr-2 (this being
twice the value of the quadratic coefficient) (Hamlington et al. 2011, Note: values to be
confirmed with author). These values are generally consistent with global observations.
Recent local tide gauge observations managed by the Bureau of Meteorology (Bureau
of Meteorology, 2018) for Lakes Entrance channel and Bullock Island are only available
back to 2006. Tide gauge data from Stony Point (250 km to the west along the coast) is
available back to 1981 and yields a rate of sea level rise of 3.1 mm yr-1. This is consistent
with increased global rates of mean sea level rise over a similar period (i.e. 1993-2010)
of 3.2 mm yr-1 (Church et al. 2013). These local sea level observations and regional sea
level reconstructions appear consistent with global averages – they are plotted with the
global sea level projections (RCP8.5 and RCP2.6) in Figure D.2.2.
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Figure D.2.2 Historical mean sea level observations, 20th century mean sea level
reconstructions and 21st century mean sea level projections under the RCP8.5 (red shading)
and RCP2.6 (light blue shading) scenarios from reference year 2010. A further contribution
from instability in the Antarctic ice sheet is also shown (orange shading).

Mean sea level rise will exacerbate extreme flood water levels in the Gippsland Lakes at
Lakes Entrance. The equation for projecting future change to the mean sea level in this
study is based upon the method applied in Lempert et al (2012) and Oddo et al (2017),
where they approximate the mean annual sea level rise, zt (mm) at time t (year) with the
second order polynomial shown in Eq. D.1. The term a is the mean sea level anomaly at
time zero (mm), b is the constant rate of sea level rise (mm yr-1), c is an acceleration
term (mm yr-2), c* is an increase to the rate of sea level rise (mm yr-1) bought on by
potentially abrupt changes in ice flow dynamics (e.g. instability of major Antarctic ice
sheets, e.g. DeConto and Pollard, 2016) and t* is the timing at which the abrupt sea level
rise begins.
ݖ௧ǡா ൌ ܽ  ܾ  ݐ כ ܿ  ݐ כଶ  ݉ܽݔሺͲǡ ܿ  כሺ ݐെ  כ ݐሻሻ

(Eq. D.1)

For a given sea level rise projection, the effect of mean sea level rise on the extreme
lake floodwater levels at Lakes Entrance is determined by Eq. 2., where Rsea is the sea
level response factor (Water Technology 2014: p.33) and zt,AEP is the lake flood level for
an AEP event (see Figure D.2.3). For a given sea level rise projection, the new lake
floodwater levels for different AEP events can be approximated by adjusting the baseline
lake floodwater levels by Eq. D.2. This was an important ‘rule of thumb’ in the study.
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ݕ௧ǡா ൌ ݖ௧ǡா ܴ כ௦

(Eq. D.2)

The extreme flood levels for Lakes Entrance were sourced from Grayson et al (2004:
p.25) and are summarised in Figure D.2.3.

Figure D.2.3 Baseline flood water levels in the Gippsland Lakes and corresponding levels
(mAHD).

The maximum hourly sea level anomaly (i.e. extreme events such as surge) is not
investigated in this study on the basis that high frequency ocean level fluctuations are
strongly attenuated by the entrance to the Gippsland Lakes (McInnes et al., 2006).
The terms t* and c* in Eq. D.1. are the most controversial, however allow for useful
explorations of future scenarios as performed by Lempert et al (2012) and Oddo et al
(2017). A summary of the coefficient ranges to be used in the mean sea level rise
simulations are shown in Table D.2.2. Note that the coefficients b and c are uncorrelated,
which means some scenarios might have high/low rates and corresponding high/low
acceleration terms.
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Table D.2.2 Summary of coefficients and the range they might take for use in Eq. D.1.
Coefficient

Range
[Min/Max]

Comments

b (mm yr-1)

+0.9 to +5.3

Min = Church & White (2011) reconstruction
Max = RCP2.6 upper curve (RCP8.5 upper curve
rate is 3.8)

c (mm yr-2)

-0.006 to +0.07

Min = RCP2.6 lower curve
Max = RCP8.5 upper curve

t* (year)

2050 to 2100

Min = 2050 (major onset of ice retreat under
RCP8.5 (DeConto & Pollard 2016)
Max = 2100

c* (mm yr-1)

0 to +20

Min = No collapse prior to 2100 (RCP2.6)
Max = Assumed linear rate to get 1m rise by 2100
if abrupt change occurred in 2050

D.2.3 Impact analysis
Impacts for different cases were assessed by looping through each case in the database.
Inundation was represented as a ‘bathtub’ model on the basis that flood waters rise
slowly in Lakes Entrance. A spot check of the modelled extent against photographic
records of a flood event in 2007 indicate that the bathtub model was a reasonable
approximation (Figure D.2.4).
The average annual damage (AAD) to properties (see Box 1) was determined by
assessing impacts for the projected 0.1 %, 0.2 %, 0.5 %, 1 %, 2 %, 5 %, 10 %, 20 %,
40 %, 60 % and 90 % AEP flood events and using the trapezoidal rule. Impacts to
properties were determined using vulnerability curves (Geosciences Australia 2017),
which represent an empirical relationship between depth of flooding and damage,
expressed as a percentage of the building structure replacement cost (estimated from
Rawlinsons 2017).
The annual average people exposed (AAPE) to flooding (see Box 1) was calculated for
the project the projected 0.1 %, 0.2 %, 0.5 %, 1 %, 2 %, 5 %, 10 %, 20 %, 40 %, 60 %
and 90 % AEP flood events by counting the number of people per dwelling (based upon
Dunford et al., 2014) for each property when flood waters reached the property footprint.
The trapezoidal rule was then applied to determine the AAPE.
270

BOX 1: Calculating AAD and AAPE


The average annual damages (AAD) represents the average damage per year
that would occur from flooding over a long period of time. It is determined by
applying the trapezoidal rule (Eq. D.3.) where n is the number of exceedance
probability intervals, i is the exceedance probability interval, D is the damage
($) and P is the exceedance probability (i.e. 0.01 for 1% AEP).
 ܦܣܣൌ σୀଵ ቂ



ሺ ାశభ ሻൈሺశభ ି ሻ
ଶ

ቃ

(Eq. D.3.)

The calculation for AAPE is similar, but uses the number of people exposed
instead of damage. A person was considered to be exposed if the flood water
levels reached the base of the property footprint.

Projected impacts assessed using transient scenarios were done using time-series from
2010 to 2100 (with 5-year time steps). As shown in Box 2, the overall risk (i.e. impacts
to AAD and AAPE) varies over time and is influenced by changes in hazard, exposure
and vulnerability factors. Policies are shown by the blue lines. The tolerable risk threshold
is shown by the red line.

271

BOX 2: Changing risk over time


Impacts to AAD and AAPE change over time. In this illustration tolerable risk
is shown by a red dashed line and defined what impacts are acceptable (e.g.
AAD to property in $/year). Definition of tolerable risk helps to calculate policy
use-by dates. The blue lines demonstrate how the exposure and vulnerability
can be influenced by policies to mitigate overall risk.
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Figure D.2.4 Comparison of photos from the 2007 flood event at Lakes Entrance (declared a 5 % AEP flood with a flood level of 1.3 m AHD; SES 2014)
with the modelled inundation extent shown from a bathtub approach. Visually, the modelled flood extent appears to be reasonable in capturing the flood
extent photographed, however the timing of the photos is not known nor is the tidal cycle. The modelled damage to property in Lakes Entrance for a 5 %
AEP flood event (in this study) was approximated to be $5.5 million with 230 people exposed. Damage from the 2007 flood to Victoria’s south-east
Gippsland region reportedly exceeded $30 million (http://www.abc.net.au/am/content/2007/s1967159.htm).
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D.2.4 Limitations and assumptions
D.2.4.1


Floor level estimates

Floor level estimates had to be assumed in the following instances:
o

No coverage of property on Google Street View;

o

Low resolution data from Google Street View, which was commonly
encountered for lower trafficked streets which had older images);

o

Not being able to establish a visual line of sight to the property risers
and/or door locations from which floor levels were estimated.
Obstructions were caused by fences, shrubs, other properties or quality
of the street view image (i.e. not legible).



A single riser (180 mm) and slab thickness (100 mm) was assumed;



The floor level derivations relied upon the DEM elevation data (1 x 1 m grid) and
the use of Google Street View and aerial images to approximate the location at
which the risers were;



Floor levels were rounded to the nearest 10 cm increment.

D.2.4.2


Determining property characteristics and assigning vulnerability models

Similar limitations to those listed above for floor level were applicable when
determining property characteristics;



Vulnerability models were only indicative and assumptions had to be made to
assigning the closest fitting model to properties;



For properties greater than 2-storeys in height (e.g. resorts), a model was
assigned based upon the characteristics of the first level and the replacement
cost was estimated for the ground floor only;



For properties that were 2-storeys high with a small second storey, these was
counted as 1-storey properties;



Practical cues were used to help assign property characteristics, such as:
o

Property shadows from aerial photos to assess number of storeys;

o

Spot checking business names and finding higher resolution images
using the Google search engine;

o

For businesses with large street front windows, the internal floor level
could sometimes be seen to cross-check estimated floor levels;

o

Assuming that multiple units had the same floor level and building
characteristics.
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D.2.4.3

Vulnerability models

The Geosciences Australia vulnerability models were used (Geosciences Australia
2017). However to allow a damage index to be estimated for each 10 cm increment of
flooding, linear interpolation had to be used between the tabulated Geosciences
Australia values (which did not cover all increments). For floods greater than the highest
level recorded for a given vulnerability model, it was assumed that the damage index
plateaued off at the value of the last recorded damage index.

D.2.4.4

Rule of thumb

The rule of thumb, which was based upon the sea level response factor in Water
Technology (2014) was assumed to be the same for different magnitude flood events
(i.e. from 0.1 % AEP to 90 % AEP). The rule of thumb assumes no changes to the basin
geometry of the entrance connecting the Gippsland Lakes to the Bass Strait.
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D.3 Summary of lived values data
Prior research has been undertaken by Graham et al. (2014) on lived values at Lakes
Entrance. They identified the lived values most important to residents, of which the top
ten are shown in Table D.3.1.

Table D.3.1 Top 10 lived values in considered most important by residents. Asterisk indicates
values in both lists. Refer to Graham et al. (2014) for more details.
Rank

Lived value (openended)

Number of
respondents

Lived value
(predetermined list of
articulated values)

Number of
respondents

1

(Natural) environment *

45

The scenery*

143

2

Lifestyle*

43

Relaxed lifestyle*

139

3

Weather/climate

36

Feeling safe

137

4

Close to the water
(lakes and ocean)*

30

The natural
environment*

135

5

Close to family

29

Access to medical
services

6

Quiet/peaceful/relaxed*

26

Peacefulness*

7

The (friendly) people

20

Being close to water*

8

Beautiful area
(scenery)*

18

Easy to get around

9

The fishing

17

Safe place for children

10

Community feel

14

To escape the city
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D.4 Adaptation policy options considered
There were four long-term adaptation options selected for evaluation in this study, in
addition to the no policy option (N1). They were:
1. Option 1 (P1): Barrier protection;
2. Option 2 (A1): Changed building requirements;
3. Option 3 (A2): Land use change;
4. Option 4 (R1): Planned retreat.
Four zones were identified (Figure D.4.1) and used to develop the options selected in
this study. Whilst these options were only evaluated up to year 2100, the implication of
longer-term path dependencies should be taken into consideration.

Figure D.4.1 The four zones identified based upon the elevation of land (m AHD). Red is
land between 0-1.8 m AHD, orange between 1.8-2.3 m AHD, green between 2.3-3 m AHD
and grey is greater than 3 m.

D.4.1 Option 1: Barrier protection
A diagram of this option is shown in Figure D.4.2. The option includes protecting
properties in zones 1, 2 and 3 against flooding to 2.5 m AHD (70 cm above the current
1% AEP flood level) and changing land use in zone 4 to commercial only, retreating
residential properties. The option reduces the vulnerability of properties to flood hazards,
but not necessarily their exposure in the long-term (i.e. it does not avoid long-term sea
level rise, but delays the issue). Barrier protection could be achieved through levees or
raising main roads.
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Figure D.4.2 The barrier protection option. Colours resemble land elevation. Red is land
between 0-1.8 m AHD, orange between 1.8-2.3 m AHD, green between 2.3-3 m AHD and
grey is greater than 3 m.

Implementation of this option assumes the following:


Retreat of residential properties in zone 4 (n = 90) has been modelled to begin
20 years before the median use-by date of the no policy option (i.e. 2030) at a
rate of 5-10 properties per year;



Barriers could be constructed to adequately manage subsurface seepage and
rising groundwater tables (e.g. sheet piles and pumps used for levees, backflow
mechanisms installed on stormwater pipelines). Further information is required
about the site to confirm the feasibility of this option and the impacts of asset and
property foundations.

The option could be enhanced by:


Progressively changing building requirement behind the barrier (e.g. infilling land,
raising floor levels);



Allowing space behind barrier for increasing the crest level.

GIS layers relevant to this option: “protect_dem1m”, “bld_area_mer” and
“build_z4_commt” GIS layers used in the AAPE lookup script to calculate the AAPE
metric (refer Appendix D.5). The assessment of people exposed also assumes hydraulic
connectivity in this option.
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D.4.2 Option 2: Changed building requirements
A diagram of this option is shown in Figure D.4.3. The option includes infilling land to 2.3
m AHD (50 cm above the current 1% AEP flood level), raising minimum residential floor
levels to 2.6 m AHD and changing residential property foundation requirements (e.g.
piled foundations) which permit future raising floor levels or relocation of properties. This
option would require coordination with land infilling activities and further investigation is
needed on implication of overhead power lines, existing building code height controls,
oversight of raised properties on neighbours and any drainage issues created.
Complexities are also likely with interdependent infrastructure and would require further
consideration, for example an elevated road would affect driveway access, services
access and change drainage paths.

Figure D.4.3 The changed building requirements option. Colours resemble land elevation.
Red is land between 0-1.8 m AHD, orange between 1.8-2.3 m AHD, green between 2.3-3 m
AHD and grey is greater than 3 m.

Implementation of this option assumes the following:


Property redevelopment (infilling land, raising floor levels) in zones 1, 2, 3 and 4
has been modelled to begin 20 years before the median use-by date of the no
policy option (i.e. 2030) at a rate of 5-10 properties per year;



Redeveloped residential properties are changes to building type FCM1
(Geosciences Australia 2017);



The infilling land is coordinated and not implemented in an ad hoc way.
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The option could be enhanced by:


Progressive raising of the road with maintenance cycles;



Temporary flood proofing (e.g. wet proofing, dry proofing, temporary / permanent
flood barriers) of eligible properties until they are re-developed. For example dry
proofing is suited for FCM7, FCM8 or CB2 properties (see Maqsood et al. 2017
for more details);



Caveats on future development (e.g. option to acquire land in the future or apply
stricter building rules);



Regulating property types (e.g. design allows for raised floor / future provision to
build 2nd level if flood frequency increases).

GIS layers relevant to this option: “dem1m_infill” and “bld_area_mer” GIS layers used
in the AAPE lookup script to calculate the AAPE metric (refer Appendix D.5).

D.4.3 Option 3: Land use change
A diagram of this option is shown in Figure D.4.4. The option includes changing land use
in zones 1, 2, 3 and 4 to commercial only, retreating residential properties. Changed land
use would also mean that owners cannot rebuild residential properties in commercial
areas after a flood event. Retreat might be achieved through voluntary land swap,
voluntary acquisition and physical relocation of existing houses. Future opportunities for
commercial land in low-lying areas might include a fishing/marina precinct (maritime
attraction), tourist accommodation (caravan parks), water park, recreational parkland or
natural wetlands for biodiversity conservation. To maintain road access via the Princes
Highway with rising groundwater tables, options to consider might include placing a
surcharge on the subbase fill and then compressing the material under own weight, or a
raft / piled foundation, or floating pontoon bridge (Underwood 1995: p.292).
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Figure D.4.4 The changed building requirements option. Colours resemble land elevation.
Red is land between 0-1.8 m AHD, orange between 1.8-2.3 m AHD, green between 2.3-3 m
AHD and grey is greater than 3 m.

Implementation of this option assumes the following:


Retreat of residential properties in zones 1, 2, 3 and 4 (n = 382) has been
modelled to begin 20 years before the median use-by date of the no policy option
(i.e. 2030) at a rate of 5-19 properties per year;



Suitable financing and institutional/governance arrangements for retreating are
available.

The option could be enhanced by:


Progressive raising of the road with maintenance cycles;



Temporary flood proofing (e.g. wet proofing, dry proofing, temporary / permanent
flood barriers) of eligible properties until they are retreated. For example dry
proofing suited for FCM7, FCM8 or CB2 properties (see Maqsood et al. 2017 for
more details);



Provision for future land use changes (e.g. full retreat or reinstating residential
zones);



Caveats on development (e.g. future option to acquire land or apply stricter
building rules);



Regulating commercial property types (e.g. design allows for raised floor / future
provision to build 2nd level if flood frequency increases).
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GIS layers relevant to this option: “build_z1234_c” GIS layer used in the AAPE lookup
script to calculate the AAPE metric (refer Appendix D.5).

D.4.4 Option 4: Planned retreat
A diagram of this option is shown in Figure D.4.5. The option includes retreating all
properties in zones 1, 2, 3 and 4 and realigning / raising the Princes Highway. Retreat
might be achieved through a variety of measures such as voluntary land swap, voluntary
acquisition and physical relocation of existing houses over a nominated period of time.
This would require a new business precinct to be created in the town (e.g. shopping
centre, Business Park, tourist accommodation) with the opportunity to improve amenities
for residents. There may also be opportunities to develop low-lying areas that have been
retreated into a fishing or marina precinct (maritime attraction), tourist accommodation
(caravan parks), recreational parkland, natural wetlands for biodiversity conservation or
improved walking and cycle paths.

Figure D.4.5 The changed building requirements option. Colours resemble land elevation.
Red is land between 0-1.8 m AHD, orange between 1.8-2.3 m AHD, green between 2.3-3 m
AHD and grey is greater than 3 m.
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Implementation of this option assumes the following:


Retreat of properties in zones 1, 2, 3 and 4 (n = 935) has been modelled to begin
20 years before the median use-by date of the no policy option (i.e. 2030) at a
rate of 5-19 properties per year;



Suitable financing and institutional/governance arrangements for retreating are
available.

The option could be enhanced by:


Progressive raising of the road with maintenance cycles;



Temporary flood proofing (e.g. wet proofing, dry proofing, temporary / permanent
flood barriers) of eligible properties until they are retreated. For example dry
proofing suited for FCM7, FCM8 or CB2 properties (see Maqsood et al., 2017 for
more details);



Provision for future land-use changes (e.g. full retreat or reinstating residential
zones).

GIS layers relevant to this option: “build_z1234_r” GIS layer used in the AAPE lookup
script to calculate the AAPE metric (refer Appendix D.5).

D.5 Programming, spatial data and geoprocessing details
D.5.1 Programming details
An overview of the code produced to support the model-based simulations, scenario
discovery and transient scenarios for this study are shown in Figure D.5.1. A schematic
diagram of the general workflow followed to assess impacts for use in scenario discovery,
and use-by years in the DAPP script is shown in Figure D.5.2.
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Figure D.5.1 Overview of the script developed using R and Python programming and the
interfaces.

Latin Hypercube Sampling was implemented in R programming language due to the
author’s familiarity with the package. AAPE lookup tables were also developed for the
AAPE calculations for the following reasons:


Due to the linearity of the AAPE calculations (i.e. AAPE = number of dwellings *
change in average people per house). The distributive law in mathematics means
that the ‘number of dwellings’ could be obtained from the lookup table based upon
the ArcGIS analysis and the value adjusted for uncertainty relating to the change
in average people per house9;



To improve computational processing time and reduce the number of times the
arcpy package was called upon (which generally take longer to run). For example,
transient scenarios were run over a 100 year time horizon which meant that 198
simulations per case were needed (18 time-steps x 11 AEP floods). In each of
these cases, impacts were assessed against 1,864 properties which meant that

The calculations for AAD were not linear due to different property types, floor levels and damage
index values. This meant that lookup tables could not be used for the property AAD impact
assessment.
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for 1,000 cases, a total of 198,000 simulations were necessary (Figure D.5.2). If
annual time-steps were used instead of 5-yearly time-steps, the amount of
simulations would expand to 990,000.
The AAPE lookup table was based upon geoprocessing commands that could be run
with the arcpy package. Prior data preparation was needed using ArcGIS of the DEM
layer (e.g. inclusion of a levee) and building layout (e.g. removing those properties which
would be retreated), and ModelBuilder was used in ArcGIS to identify the necessary
geoprocessing steps needed in the analysis. Additionally for the ‘no policy’ and ‘option 1’
policies, details of the corresponding property ID’s for each incremental flood level in the
AAPE lookup table were logged. This supported the analysis in the transient scenarios
(Table D.5.1).

Figure D.5.2 Schematic of the main workflow followed to assess impacts for scenario
discovery activities and using transient scenarios to assess use-by dates.
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Documentation of the key changes to the no policy script for each of the four options
assessed is shown in Table D.5.1. In summary:


Option 1 (barrier) has two elements to change. The first is a step-change
reduction in AAD and AAPE from 2030 due to barrier being built. The second is
the graduate retreat of residential properties in zone 4 (similar process to options
3 and 4);



Option 2 (changes building regulations) maintains changed details to properties
in the prop_impact list from 2030 (i.e. property database), such as minimum floor
level the building type for residential properties;



Option 3 (land-use change) and option 4 (retreat) are similar in the coding as
properties are progressively removed from the prop_impact list over time beyond
2030. The main difference is that option 3 just retreats residential properties only,
whereas option 4 retreats all properties.

Table D.5.1 Summary of changes to policy options script compared to the no policy script
Category

Summary

Option 1

Barrier protection

RDM script

 Copy the no-policy script.
 Change AAPE_lookup references, outfile names and any outfile figure
names.
 Lines 288-289: Create a new column in prop_impact called ‘sample’.
 Lines 295-317: Create a subset of the prop_impact data frame to flag
RESIDENTIAL properties in zone 4; Remove these properties from the
prop_impact data frame (i.e. 1774 properties remain with zone 4
RESIDENTIAL removed, from 1864).
 Impact assessment as per the original no policy RDM script using the
subset of properties that excludes RESIDENTIAL properties from zone 4.
 Also looks up OPTION 1 in AAPE Lookup Table.

DAPP script

 Copy the no policy DAPP script.
 Change AAPE_lookup references, outfile names and any outfile figure
names.
 Line 62: Set the year of implementing the option to 2030 (i.e. fastest rate
assumes full implementation in ~10 years).
 Line 384-385: Create a new column in prop_impact called ‘sample’.
 Lines 409-458: For each year, create a subset of the prop_impact data
frame to flag RESIDENTIAL properties in zone 4; Remove these
properties from the prop_impact data frame.
 Impact assessment as per the original no policy RDM script using the
subset of properties that excludes RESIDENTIAL properties from zone 4,
but also makes consideration of if year > 2030.
 Lines 934-1055: Looks up OPTION 1 in AAPE Lookup Table if year
greater than 2030, otherwise takes the baseline. If the year is greater
than 2030, the number of people in zone 4 no longer exposed is
accounted for by comparing the properties exposed in the ‘option 1’ case
(from the AAPE lookup logs which returns the ID of properties that would
be exposed in the absence of retreat but with a barrier) with those
remaining in the reduced prop_impact list.
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Category

Summary

Option 2

Changed building requirements

RDM script

 Copy the option 3 RDM script.
 Change AAPE_lookup references, outfile names and any outfile figure
names.
 Lines 288-289: Create a new column in prop_impact called ‘sample’.
 Lines 295-328: Create a subset of the prop_impact data frame to flag
properties in zones 1,2,3,4; Change details of properties in this subset as
follows (a) make 2.6m the minimum flood level of properties, (b) for all
RESIDENTIAL properties, change the vulnerability model to FCM1
(assumes changes building type).
 Impact assessment as per the original no policy RDM script, but uses
new property stock details (i.e. prop_impact file).

DAPP script

 Line 62: Set the year of implementing the option to 2030 (i.e. fastest rate
assumes full implementation in ~20 years).
 Line 384-385: Create a new column in prop_impact called ‘sample’.
 Lines 409-468: For each year, create a subset of the prop_impact data
frame to flag properties in zones 1,2,3,4 so that changes can be made to
property details in this subset as follows (a) make 2.6m the minimum
flood level of properties, (b) for all RESIDENTIAL properties, change the
vulnerability model to FCM1 (assumes changes building type). Also flag
which properties have been ‘renovated’.
 Impact assessment as per the original no policy RDM script, but uses the
updated property stock details in the prop_impact file (i.e. new floor
levels, vulnerability models).
 Lines 901-987: The sum of the people in the selected properties is
recorded. This is done by deducting the sum of people in the
‘prop_im_retro’ list from the people exposed in the ‘no impacts’ case
(from the AAPE lookup logs).

Option 3

Land use change

RDM script

 Copy the option 1 RDM script (included retreat code for zone 4).
 Change AAPE_lookup references, outfile names and any outfile figure
names.
 Lines 288-289: Create a new column in prop_impact called ‘sample’.
 Lines 293-313: Create a subset of the prop_impact data frame to flag
‘RESIDENTIAL’ properties in zones 1,2,3,4; Remove these properties
from the prop_impact data frame (i.e. 1482 properties selected that
remain, from 1864).
 Impact assessment as per the original no policy RDM script using the
subset of properties that excludes ‘RESIDENTIAL’ properties in zones 1,
2, 3, 4.
 Also looks up OPTION 3 in AAPE Lookup Table.

DAPP script

 Copy the option 1 DAPP script.
 Change AAPE_lookup references, outfile names and any outfile figure
names.
 Line 62: Set the year of implementing the option to 2030 (i.e. fastest rate
assumes full implementation in ~20 years).
 Line 381-383: Create a new column in prop_impact called ‘sample’.
 Lines 406-442: For each year, a small set of ‘RESIDENTIAL’ properties
(from zones 1, 2, 3 or 4) is randomly selected to be removed from the
prop_impact data frame based upon the rate of residential to commercial
change per year (properties per year).
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Category

Summary
 Impact assessment as per the original no policy RDM script using the
subset of properties that excludes ‘RESENTIAL’ properties in zones 1, 2,
3, 4.
 Lines 878-953: The sum of the people in the selected properties is
recorded. This is done for comparing the properties exposed in the ‘no
impacts’ case (from the AAPE lookup logs) to those remaining in the
reduced prop_impact list (i.e. with retreated RESIDENTIAL properties).

Option 4
RDM script

DAPP script

Planned retreat
 Copy the no policy RDM script.
 Change AAPE_lookup references, outfile names and any outfile figure
names.
 Lines 288-289: Create a new column in prop_impact called ‘sample’.
 Lines 296-310: Create a subset of the prop_impact data frame to flag
properties in zones 1,2,3,4; Remove these properties from the
prop_impact data frame (i.e. 929 properties selected that remain, from
1864).
 Impact assessment as per the original no policy RDM script using the
subset of properties that excludes zones 1, 2, 3, 4.
 Also looks up OPTION 4 in AAPE Lookup Table.
 Copy the no policy DAPP script.
 Change AAPE_lookup references, outfile names and any outfile figure
names.
 Line 62: Set the year of implementing the option to 2030 (i.e. fastest rate
assumes full implementation in ~50 years).
 Line 381-383: Create a new column in prop_impact called ‘sample’.
 Lines 404-439: For each year, a small set of properties (from zones 1, 2,
3 or 4) is randomly selected to be removed from the prop_impact data
frame based upon the rate of retreat (properties per year).
 Impact assessment as per the original no policy RDM script using the
subset of properties that excludes zones 1, 2, 3, 4.
 Lines 880-955: The sum of the people in the selected properties is
recorded. This is done for comparing the properties exposed in the ‘no
impacts’ case (from the AAPE lookup logs) to those remaining in the
reduced prop_impact list (i.e. with retreated properties).

288

D.5.2 GIS metadata, spatial data and geoprocessing worksheet
General metadata for the impact modelling and analysis is contained below in Table
D.5.2. Details of the spatial data layers used in the impact model are contained in Table
D.5.3 and a summary of the geoprocessing steps utilised in the python script for the
impact assessment are shown in Table D.5.4.
Table D.5.2 General metadata for ArcGIS, R programming and Python scripts.
Category Summary
General details
Keywords:
Data types:

Flood, geoprocessing, hazard, impact, sea level rise,
uncertainty
Vector (points, lines, polygons) and raster (grid)

Spatial details
Data coverage:
Extent [coordinates]:

Lakes Entrance, Victoria
[Xmin, Ymin, Xmax, Ymax]: [584953 5805832 590779 5808569]

Spatial projection

GDA_1994 MGA Zone 55

Vertical datum(s)

Lake flood water levels: Australian Height Datum (AHD)

R details
R script file: LE_RDM_Analysis.R
Version:
R packages / libraries:

3.2.0
lhs

ArcGIS details
ArcMap file name:

LakesEntrance.mxd

ArcMap version:

Version 10.4 (ESRI)

ArcGIS Extensions:

3D Analyst; Spatial Analyst

Environment Settings:

Workspace: CaseTwo.gdb
Scratch: ScratchCaseTwo.gdb

Toolbox Settings Note 1 :

Toolbox: CaseTwo.tbx
Model: RoadFlood; Description: Testing the geoprocessing
steps needed to evaluate the assess the adaptation
objectives (AAPE)

Python details
Python script files:

Version:

CaseTwo_AAPE_Lookup.py; CaseTwo_PRIM.py;
CaseStudyTwo_RDM.py; CaseStudyTwo_DAPP.py;
O1_PROTECT_RDM.py; O1_PROTECT_DAPP.py;
O2_BLDREG_RDM.py; O2_BLDREG_DAPP.py;
O3_LANDUSE_RDM.py; O3_LANDUSE_DAPP.py;
O4_RETREAT_RDM.py; O4_RETREAT_DAPP.py.
Python 2.7 (WinPython-32bit-2.7.10.2) – this version was
needed to implement the ArcPy package
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Category Summary
IDE: Spyder (2.7)
Python packages:

arcpy, pandas, numpy, math, time, prim, matplotlib, datetime,
seaborn

Note 1: ModelBuilder was used in the first instance to help develop the Python code
using the arcpy package.

Table D.5.3 Spatial data layer details used in the impact model.
Risk dimension

Description

Data source

Create constant raster, by
adjusting the base baseline levels
by the sea level response factor

N/A

Digital elevation
model (DEM) NOTE 1

LiDAR dataset (1mx1m ASCII
grid)

Provided by the Victorian
Department of
Environment, Land, Water
and Planning (DELWP)

Building polygons

Digitised polygons created using
high resolution aerial image

Aerial image provided by
the East Gippsland Shire
Council

Land tenure

Polygons with land classification

DELWP

Mesh Blocks (MB)
and Statistical Area 1
(SA1)

Polygons defining the boundary
for MB and SA1 zones

Australian Bureau of
Statistics

Suburb boundary

Polygon

DELWP

Roads

Road polylines

DELWP

Hazard
Extreme flood level

Exposure

NOTE 2

Note 1: The DEM was adjusted in ArcGIS for option 1 to reflect a barrier and in option
2 to reflect land infill associated with changed building regulations.
Note 2: The building polygons were adjusted in ArcGIS for some of the options to
reflect the ultimate configuration depending on land use changes or retreat.
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Lidar5m

LE_suburb
MB_2016_VIC

1.2.3

1.3 Aerial image
1.3.1 Lakes_Entrance_1_
7000_231216

Selected feature
(SA1_2016_AUST)

1.2.2

1.2 ABS MB and SA1 data
1.2.1 LE_suburb
SA1_2016_AUST

1.1.2

ID
Input layer
1. Data preparation
1.1 LiDAR data
1.1.1 Lidar5m

Define projection
Define projection in
ArcCatalog

Make feature layer
Coverts selected attributes
into a feature class

Select layer by location
Select Statistical Area 1
(SA1) blocks in the Lakes
Entrance boundary
Make feature layer
Coverts selected attributes
into a feature class

Lakes_Entrance_1
_7000_231216

MB_suburb

SA1_suburb

Selected feature

LiDAR5m

Lidar5m

Define Projection
(In ArcCatalog)

ASCII to Raster

Output layer

Geoprocessing Steps

IN ARCCATALOG: 'Data Management Tools > Projections and
Transformations > Define Projection (GDA 1994 MGA Zone 55)

Data Management Tools > Layers and Table Views > Make Feature Layer
Relationship = intersect
Selecting feature = LE_suburb
Right click > Data > Export Data (as shapefile)
- Save into original folder (Derivatives folder)
- Import back into the geodatabase and add to ArcMap

Data Management Tools > Layers and Table Views > Select layer by
location
Relationship = intersect
Selecting feature = LE_suburb
Data Management Tools > Layers and Table Views > Make Feature Layer
Relationship = intersect
Selecting feature = LE_suburb
Right click > Data > Export Data (as shapefile)
- Save into original folder (Derivatives folder)
- Import back into the geodatabase and add to ArcMap

Data Management Tools > Projections and Transformations > Raster >
Define Projection
GDA 1994 MGA Zone 55
Conversion Tools > To Raster > ASCII to Raster
- ASCII raster file = .asc file
- Output data type = FLOAT

Comments

Table D.5.4 Summary of geoprocessing steps undertaken to produce model outputs in the impact assessment. Blue text indicates the location of the
geoprocessing tool in ArcMap (i.e. for use in ModelBuilder), whilst green text shows the python code used for that step in the script.
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slr_surface
AOI_dem1m

slr_extent

slr_ext_con

2.1.3

2.1.4

2.1.5

2.2 No Policy
2.2.1 bld_area_mer

AOI_dem1m

2.1.2

2. AAPE Lookup
2.1 General
2.1.1 slr
(flood level)

ID
Input layer
1.4 Projections
1.4.1 MB_suburb
LE_suburb
Australia
SA1_suburb
Victoria

Make feature layer

Raster to polygon

Con

Less than equal

Calculate statistics

‘property’

slr_poly

slr_ext_con

slr_extent

AOI_dem1m

slr_surface

MB_suburb_proj
LE_suburb_proj
Australia_proj
SA_suburb_proj
Victoria_proj

PROJECT various layers to
GDA1994 MGA Zone 55

Create constant raster

Output layer

Geoprocessing Steps

Data Management Tools > Layers and Table Views > Make Feature Layer
arcpy.MakeFeatureLayer_management(bld_area_mer,"property")

Conversion Tools > From Raster > Raster to Polygon
Field = value. Simplify polygons checked
arcpy.RasterToPolygon_conversion(slr_ext_con, slr_poly, "SIMPLIFY",
"Value")

Spatial Analyst Tools > Conditional > Con
If cell has a value of 1, then keep it, otherwise ‘no data’. Expression: Value = 1;
all other values default.
arcpy.gp.Con_sa(slr_extent, CONDITION_TRUE, slr_ext_con, "", "Value
=1")

Spatial Analyst Tools > Math > Logical> Less Than Equal
Evaluates if DEM less than water elevation. If so, value = 1.
arcpy.gp.LessThanEqual_sa(AOI_dem1m, slr_surface, slr_extent)

Spatial Analyst Tools > Local > Cell Statistics
arcpy.CalculateStatistics_management(AOI_dem1m, "1", "1", "",
"OVERWRITE", inpath + "AOI_box")

Spatial Analyst Tools > Raster Creation>Create Constant Raster
arcpy.gp.CreateConstantRaster_sa(slr_surface, slr, "FLOAT", "1",
"584953 5805832 590779 5808569")

IN ARCCATALOG: 'Data Management Tools > Projections and
Transformations > Define Projection (GDA 1994 MGA Zone 55)

Comments
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‘Select_prop’

‘Select_prop’

[array]

2.2.3

2.2.4

2.2.5

Sum

Table to NumPy array

Get count

Geoprocessing Steps
Select layer by location

[array]

‘PROP_count’

Output layer
‘Select_prop’

Sum_ppl["AV_PPL_DWL"].sum()

Converts table into a Numpy structured array
arcpy.da.TableToNumPyArray(Select_prop,'AV_PPL_DWL')

The number of properties reached by flood water are counted
PROP_count = arcpy.GetCount_management(Select_prop)
fld_prop_count = int(PROP_count.getOutput(0))

Comments
Data Management Tools > Layers and Table Views > Select Layer By
Location
Select_prop =
arcpy.SelectLayerByLocation_management("property","INTERSECT",slr_
poly,"", "NEW_SELECTION", "NOT_INVERT")

A similar process to steps 2.2.1 to 2.2.5 is repeated for options 1 to 4. Some differences were made in the options about which data layers were used,
whether they had to account for hydraulic connectivity, or whether an output file was necessary.

Input layer
‘property’
slr_poly

ID
2.2.2

D.6 Detailed evaluation outputs for adaptation policy options
The following thresholds (adaptation tipping points) were defined (refer to Table 5.1 of
Chapter 5):


AAD = $3.7 mil / year



AAPE = 94 people / year

The results of scenario discovery and the use-by years are summarised in the following
section.

D.6.1 No policy: Scenario discovery
Date of analysis:

07-Mar-18

Python package:

PRIM

Script:

CaseTwo_PRIM.py

Results database:

2018-03-07_Case_Results_RDM.csv

Number of cases:

5,000

It took 12 hours to assess impacts to the adaptation objectives across 5,000 scenarios.
A histogram of impacts from all cases against the two objectives are shown in Figure
D.6.1.
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Figure D.6.1 Histogram of the impacts of all cases against AAD (top panel) and AAPE
(bottom panel). Adaptation tipping point thresholds are shown by the blue dashed lines.

The impacts to the AAD and AAPE adaptation objectives are shown in Figure D.6.2,
suggesting that impacts increase to both objectives in 87 % of the scenarios analysed.
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Figure D.6.2 Risk to AAPE and AAD across 5,000 scenarios with tolerable risk for the
objectives are shown by red lines.

D.6.1.1

Average annual damages

A scatter plot of the individual factors in the case and the impacts to the AAD objective
are shown in Figure D.6.3.
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Figure D.6.3 Scatter plot showing input variables and their influence on the AAD adaptation
objective.

The correlation (linear) between factors and AAD are shown below:

The correlations suggest that sea level rise (slr) has the greatest influence on the AAD,
followed by the damage index (d_i).
The PRIM package is run and the peeling trajectory (trade-off between coverage and
density) is shown in Figure D.6.4.
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Figure D.6.4 Peeling trajectory from the PRIM analysis with the box of interest numbered.

Box 42 was selected as being of interest, with a preference towards a higher density box.
Other boxes were also explored. The general steps followed to assess the merits of each
box (candidate scenario) of interest were as follows:
1. Select the candidate box;
2. Observe the marginal contributions of factors constrained in the box;
3. Check the qp-value (remove factor if p<0.05).
Results for the iterations as shown in Table D.6.1 and details summarised in Figure D.6.5.
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Table D.6.1 Results for the iterations.
Objective
AAD

Box 42
Measures of scenario merit

value

Coverage

74%

Density

94%

Uncertain factor

p-value

Sea level rise

<0.335

1.51e-215

Damage index uncertainty

<-0.015

2.61e-78

Figure D.6.5 Detailed summary of box 42.

D.6.1.2

Average annual people exposed

A scatter plot of the individual factors in the case and the impacts to the AAPE objective
are shown in Figure D.6.6.
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Figure D.6.6 Scatter plot showing input variables and their influence on the AAPE adaptation
objective.

The correlation (linear) between factors and AAPE are shown below:

The correlations suggest that sea level rise (slr) has the greatest influence on the AAD,
followed by the average number of people per dwelling (a_ppl).
The peeling trajectory (trade-off between coverage and density) is shown in Figure D.6.7.
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Figure D.6.7 Peeling trajectory from the PRIM analysis with the box of interest numbered.

Box 42 was selected as being of interest. Results for the iterations as shown in Table
D.6.2 and details summarised in Figure D.6.8.

Table D.6.2 Results for the iterations.
Objective
AAD

Box 42
Measures of scenario merit

value

Coverage

72%

Density

88%

Uncertain factor

p-value

Sea level rise

<0.175

2.56e-264

Average people/prop

<0.325

5.72e-04
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Figure D.6.8 Detailed summary of box 42.

D.6.2 No policy: Transient scenarios
Date of analysis:

09-Mar-18

Results database:

2018-03-09_Case_Results_DAPP.csv

Number of cases:

1,000

It took 34 hours to assess impacts to the adaptation objectives across 1,000 scenarios.
A 5-year time step was used in each scenario between 2010 and 2100. A summary of
the transient scenarios and the associated use-by dates for the no policy option are
shown in Figure D.6.9.
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Figure D.6.9 Changing risk to the adaptation objectives over time from uncertain mean sea
level rise (top panel). The timing at which the AAD and AAPE risk thresholds were exceeded
in the transient scenarios are shown in the boxplot (bottom panel).
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D.6.3 Option 1: Barrier protection
D.6.3.1

Scenario discovery

Date of analysis:

11-Mar-18

Python package:

PRIM

Script:

CaseTwo_PRIM.py

Results database:

2018-03-11_Case_Results_RDM_OPTION1_BARRIER.csv

Number of cases:

5,000

It took 10.1 hours to assess impacts to the adaptation objectives across 5,000 scenarios.
The peeling trajectory (trade-off between coverage and density) is shown in Figure
D.6.10.

Figure D.6.10 Peeling trajectory from the PRIM analysis (AAPE on the left, AAD on the right)
with the box of interest numbered.

Box 13 was selected as being of interest for AAPE and Box 23 for AAD. Results for the
iterations as shown in Table D.6.3.
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Table D.6.3 Results for the iterations.

Objective
AAPE

Box 13
Measures of scenario merit

value

Coverage

92%

Density

96%

Uncertain factor
Sea level rise

p-value
0

<0.965
Box 23

AAD

Measures of scenario merit

value

Coverage

79%

Density

91%

Uncertain factor

D.6.3.2

p-value

Sea level rise

<0.645

0

Damage index uncertainty

<0.055

2.34e-19

Transient scenarios

Date of analysis:

05-Apr-18

Results database:

2018-04-05_Case_Results_DAPP_OPTION1.csv

Number of cases:

500

It took 11.5 hours to assess impacts to the adaptation objectives across 500 scenarios.
A summary of the transient scenarios and the associated use-by dates for the option are
shown in Figure D.6.11.
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Figure D.6.11 Changing risk to the adaptation objectives over time from uncertain mean sea
level rise (top panel). The timing at which the AAD and AAPE risk thresholds were exceeded
in the transient scenarios are shown in the boxplot (bottom panel).
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D.6.4 Option 2: Changed building regulations
D.6.4.1

Scenario discovery

Date of analysis:

16-Mar-18

Python Package:

PRIM

Script:

CaseTwo_PRIM.py

Results database:

2018-03-16_Case_Results_RDM_OPTION2_BLDREG.csv

Number of cases:

5,000

It took 12.8 hours to assess impacts to the adaptation objectives across 5,000 scenarios.
The peeling trajectory (trade-off between coverage and density) is shown in Figure
D.6.12.

Figure D.6.12 Peeling trajectory from the PRIM analysis (AAPE on the left, AAD on the right)
with the box of interest numbered.

Box 15 was selected as being of interest for AAPE and Box 16 for AAD. Results for the
iterations as shown in Table D.6.4.
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Table D.6.4 Results for the iterations.

Objective
AAPE

Box 15
Measures of scenario merit

value

Coverage

89%

Density

98%

Uncertain factor

p-value

Sea level rise <0.865

0

Box 16
AAD

Measures of scenario merit

value

Coverage

88%

Density

90%

Uncertain factor
Sea level rise <0.815

D.6.4.2

p-value
0

Transient scenarios

Date of analysis:

03-Apr-18

Results database:

2018-04-03_Case_Results_DAPP_OPTION2.csv

Number of cases:

500

It took 14.3 hours to assess impacts to the adaptation objectives across 500 scenarios.
A summary of the transient scenarios and the associated use-by dates for the option are
shown in Figure D.6.13.
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Figure D.6.13 Changing risk to the adaptation objectives over time from uncertain mean sea
level rise (top panel). The timing at which the AAD and AAPE risk thresholds were exceeded
in the transient scenarios are shown in the boxplot (bottom panel).
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D.6.5 Option 3: Land use change
D.6.5.1

Scenario discovery

Date of analysis:

13-Mar-18

Python package:

PRIM

Script:

CaseTwo_PRIM.py

Results database:

2018-03-13_Case_Results_RDM_OPTION3_LAND.csv

Number of cases:

5,000

It took 11 hours to assess impacts to the adaptation objectives across 5,000 scenarios.
The peeling trajectory (trade-off between coverage and density) is shown in Figure
D.6.14.

Figure D.6.14 Peeling trajectory from the PRIM analysis (AAPE on the left, AAD on the right)
with the box of interest numbered.

Box 17 was selected as being of interest for AAPE and Box 38 for AAD. Results for the
iterations as shown in Table D.6.5.
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Table D.6.5 Results for the iterations.

Objective
AAPE

Box 17
Measures of scenario merit

value

Coverage

91%

Density

97%

Uncertain factor
Sea level rise

p-value
0

<0.76
Box 38

AAD

Measures of scenario merit

value

Coverage

72%

Density

93%

Uncertain factor

D.6.5.2

p-value

Sea level rise

<0.405

4.52e-252

Damage index uncertainty

<-0.005

1.85e-73

Transient scenarios

Date of analysis:

03-Apr-18

Results database:

2018-04-03_Case_Results_DAPP_OPTION3.csv

Number of cases:

500

It took 13.2 hours to assess impacts to the adaptation objectives across 500 scenarios.
A summary of the transient scenarios and the associated use-by dates for the option are
shown in Figure D.6.15.
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Figure D.6.15 Changing risk to the adaptation objectives over time from uncertain mean sea
level rise (top panel). The timing at which the AAD and AAPE risk thresholds were exceeded
in the transient scenarios are shown in the boxplot (bottom panel).
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D.6.6 Option 4: Planned retreat
D.6.6.1

Scenario discovery

Date of analysis:

15-Mar-18

Python package:

PRIM

Script:

CaseTwo_PRIM.py

Results database:

2018-03-15_Case_Results_RDM_OPTION4_RETREAT.csv

Number of cases:

5,000

It took 6.2 hours to assess impacts to the adaptation objectives across 5,000 scenarios.
The peeling trajectory (trade-off between coverage and density) is shown in Figure
D.6.16.

Figure D.6.16 Peeling trajectory from the PRIM analysis (AAPE on the left, AAD on the right)
with the box of interest numbered.

Box 17 was selected as being of interest for AAPE and Box 15 for AAD. Results for the
iterations as shown in Table D.6.6.
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Table D.6.6 Results for the iterations.

Objective
AAPE

Box 17
Measures of scenario merit

value

Coverage

91 %

Density

97 %

Uncertain factor
Sea level rise

p-value
0

<0.765
Box 15

AAD

Measures of scenario merit

value

Coverage

87 %

Density

94 %

Uncertain factor
Sea level rise

D.6.6.2

p-value
<0.865

0

Transient scenarios

Date of analysis:

04-Apr-18

Results database:

2018-04-04_Case_Results_DAPP_OPTION4.csv

Number of cases:

500

It took 12.3 hours to assess impacts to the adaptation objectives across 500 scenarios.
A summary of the transient scenarios and the associated use-by dates for the option are
shown in Figure D.6.17.
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Figure D.6.17 Changing risk to the adaptation objectives over time from uncertain mean sea
level rise (top panel). The timing at which the AAD and AAPE risk thresholds were exceeded
in the transient scenarios are shown in the boxplot (bottom panel).
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D.6.7 Summary of results
A summary of the consolidated results from scenario discovery and transient scenarios
is shown in Table D.6.7.

Table D.6.7 Results from scenario discovery and transient scenarios.
Option

No
policy

Adaptation
objective

AAPE

Conditions describing
adaptation tipping point Note 1

Mean sea level > 0.17 m

Coverage
/ Density

Cases of
interest /
total cases

Median
timing for
use-by year

72% / 88%

449 / 5000

2050
(2045-2060)

74% / 94%

436 / 5000

2050
(2045-2060)

92% / 96%

2503 / 5000

2100+

AND

(N1)

Note 2

Average people per dwelling >
32 %
AAD

Mean sea level > 0.33 m
AND
Damage index uncertainty > 0.015

1

AAPE

Mean sea level > 0.96 m

(P1)

(2100+)
AAD

Mean sea level > 0.64 m

79% / 91%

1445 / 5000

2095
(20802100+)

89% / 98%

2388 / 5000

2060

AND
Damage index uncertainty >
0.05
2

AAPE

Mean sea level > 0.86 m

(A1)

3

(2050-2075)
AAD

Mean sea level > 0.81 m

88% / 91%

2100 / 5000

2065
(2055-2080)

AAPE

Mean sea level > 0.76 m

91% / 97%

2052 / 5000

2100+

(A2)

(20902100+)
AAD

Mean sea level > 0.40 m

72% / 93%

609 / 5000

2065
(2055-2075)

91% / 97%

2052 / 5000

2090

AND
Damage index uncertainty > 0.005
4

AAPE

Mean sea level > 0.76 m

(R1)

(20602100+)
AAD

Mean sea level > 0.86 m

87% / 94%

2320 / 5000

2100+
(20552100+)

Note 1: This is the average difference between the damage index from analytical
stage damage curves and the actual surveyed curve.
Note 2: The 25th and 75th percentiles are shown with italics in parentheses.
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2017
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Year

Citation

2015
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cost benefit analysis: a generalised framework for natural hazard adaptation
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Hobart.
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2016

White, CJ, Ramm, TD & Irvine, C 2016, ‘Floodplain Risk Assessment
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2018
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2018
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2017

Ramm, TD, White C.J., Watson, CS & Graham, S 2017, Pathways into the
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and Water Exchange Research Initiative, <http://ozewex.org/pathways-intothe-unknown-can-your-community-cope-with-rising-tides/>.

2017

Ramm, TD, White C.J., Watson, CS & Graham, S 2017, Steering local
government in Australia towards better informed long-term coastal
adaptation decisions, weADAPT, <https://www.weadapt.org/knowledgebase/adaptation-decision-making/long-term-coastal-adaptation-in-australia>.
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E.5 Oral presentations
Year

Event

2015

10 December. 36th Hydrology and Water Resources Symposium (Hobart).
‘Accounting for uncertainty in cost-benefit analysis’.

2016

21 March. Confirmation of candidature (Hobart). ‘Climate change adaptation
in coastal communities’.

2016

05 July. NCCARF Climate Adaptation Conference (Adelaide). ‘Decision
analysis for long-term coastal adaptation in Australia’.

2016

19 October. BNHCRC. ‘Making fairer coastal adaptation decisions in an
uncertain world’ (3-minute thesis presentation)

2018

09 May. Climate Adaptation 2018 (Melbourne). ‘Managing coastal flood risk:
vulnerability assessment and long-term adaptation planning’.

E.6 Poster presentations
Year

Event

2015

Ramm, TD, White, CJ & Chan, AC, 2015, ‘A climate change adaptation
frameworks for implementation of coastal protection measures’, University of
Tasmania Graduate Research Conference, 3-4 September, Hobart,
Tasmania.

2015

Ramm, TD, White, CJ, Chan, AC. % Franks, SW, 2015, ‘A climate change
adaptation frameworks for implementation of coastal protection measures’,
Greenhouse 2015, 27-30 October, Hobart, Tasmania.

2016

Ramm, TD, White, CJ & Chan, AC, 2016, ‘Making better long-term coastal
adaptation decisions under conditions of uncertainty’, BNHCRC Research
Advisory Forum, 11-12 May, Hobart, Tasmania.

2016

Ramm, TD, White, CJ & Chan, AC, 2016, ‘Making better long-term coastal
adaptation decisions under conditions of uncertainty’, Climate Adaptation
2016, 5-7 July, Adelaide, South Australia.

2017

Ramm, TD, White, CJ, Watson, CS & Chan, AC, 2017, ‘Identifying risk
thresholds in coastal communities to inform adaptation planning’, AFAC17,
4-7 September, Sydney, New South Wales.

2017

Ramm, TD, Watson, CS & White, CJ, 2017, ‘Uncovering risk thresholds in
coastal communities for use in adaptation pathways planning’,
MODSIM2017, 4-8 December, Hobart, Tasmania.
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Year

Event

2018

Ramm, TD, White, CJ, Watson, CS & Chan, AC, 2018, ‘Planning strategic
adaptation pathways to manage future coastal flood risk’, AFAC18, 5-8
September, Perth, Western Australia.

E.7 Research video
Year

Citation

2016

BNHCRC, 2016, ‘Making better long-term coastal adaptation decisions’,
BNHCRC, <http://bnhcrc.com.au/resources/presentation-audio-video/3183>.

E.8 Conference attendance
Year

Event

2015

3-4 September. University of Tasmania Graduate Research Conference
(Hobart).

2015

27-30 October. Greenhouse 2015 (Hobart).

2015

7-10 December. 36th Hydrology and Water Resources Symposium (Hobart).

2016

11-12 May. BNHCRC Research Advisory Forum (Hobart).

2016

5-7 July. NCCARF Climate Adaptation Conference (Adelaide).

2016

18-19 October. BHNCRC Research Advisory Forum (Canberra).

2017

5-6 April. BNHCRC Research Advisory Forum (Perth).

2017

3-8 December, MODSIM2017 Conference (Hobart).

2018

8-10 May, Climate Adaptation 2018 Conference (Melbourne).
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E.9 Short courses, workshops and professional development
Year

Event

2015

26 August, Tasmanian State Natural Disaster Risk Assessment workshop;
Flood (Hobart).

2016

27-28 April. Coastal Hazard Management Short Course 2016 - Griffith
University (Brisbane).

2016

10 May. Student Development Day, BNHCRC RAF (Hobart).

2016

6 September. NCCARF Coast Adapt Workshop (Hobart).

2016

17 October. Student Development Workshop, BNHCRC RAF (Canberra).

2016

4 July. Early Career Workshop. NCCARF Climate Adaptation 2016
(Adelaide).

2017

4 April. Student Development Day, BNHCRC RAF (Perth).

2017

15 May. NCCARF Coast Adapt Training (Hobart).
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2016

Kingston Classifieds, 2016, ‘Your coast – your views’, published 03-Nov-16
(No 958, page 1), The Classifieds, Cygnet, Tasmania.

2017

Holper, P, 2017, ‘Using Scenarios in their hundreds and thousands to
improve long-term adaptation decisions’, National Climate Change
Adaptation Research Facility,
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